
Using TextMap

• Navigating TextMap
• Getting Started
• Working with Cases
• Creating Case Issues
• Importing Data
• Working with Transcripts
• Using the TextMap App for iPad
• Sorting Data
• Filtering Data
• Searching Data
• Annotating Transcripts
• Working with Exhibits
• Working with Video
• Editing Data
• Creating and Printing Reports
• Exporting Data
• Keyboard Shortcuts

User Guide
TextMap®, Version 9.1



No part of this work may be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying, recording, or by any information storage or retrieval system, without permission.

While the information contained herein is believed to be accurate, this work is provided "as is," without warranty of any
kind. The information contained in this work does not constitute, and is not intended as, legal advice.

LexisNexis and the Knowledge Burst are registered trademarks of Reed Elsevier Properties Inc., used under license.
TextMap is a registered trademark of LexisNexis, a division of RELX Inc. Other products or services may be trademarks or
registered trademarks of their respective companies. 

© 2017 LexisNexis. All rights reserved.

CaseMap®
CaseMap® Server
TextMap®
TimeMap®
NoteMap®
DepPrep®
Sanction®
Concordance®

Version: TextMap® 9.1
Release Date: February 28, 2017

TextMap User Guide



3Contents

3

© 2017 LexisNexis. All rights reserved.

Table of Contents

Chapter 1 About TextMap 8

Chapter 2 What's New in TextMap 10

Chapter 3 Using TextMap 13

................................................................................................................................... 131 Navigating TextMap

.......................................................................................................................................................... 13Navigating TextMap 

.......................................................................................................................................................... 15About the Navigation pane 

.......................................................................................................................................................... 20About the Search pane 

.......................................................................................................................................................... 23Modifying Navigation pane display 

.......................................................................................................................................................... 27About the title and status bars 

.......................................................................................................................................................... 28About TextMap toolbar buttons 

.......................................................................................................................................................... 32Changing toolbar buttons and settings 

.......................................................................................................................................................... 35About TextMap menus 

................................................................................................................................... 412 Getting Started

.......................................................................................................................................................... 41About the Getting Started pane 

.......................................................................................................................................................... 42Practicing with sample data 

.......................................................................................................................................................... 43Using the Quick Start Tutorial 

.......................................................................................................................................................... 48Opening cases 

.......................................................................................................................................................... 51Setting/changing passwords 

................................................................................................................................... 523 Working with Cases

.......................................................................................................................................................... 52About cases 

.......................................................................................................................................................... 53Creating cases 

.......................................................................................................................................................... 56Entering case properties 

.......................................................................................................................................................... 57Copying cases 

.......................................................................................................................................................... 58Moving cases and files 

.......................................................................................................................................................... 59Deleting cases 

.......................................................................................................................................................... 59Adding users to cases 

.......................................................................................................................................................... 61Deleting users 

................................................................................................................................... 614 Creating Case Issues

.......................................................................................................................................................... 61About case issues 

.......................................................................................................................................................... 62Creating case issues 

.......................................................................................................................................................... 65Importing case issues 

.......................................................................................................................................................... 66Linking issues to annotations 

.......................................................................................................................................................... 68Deleting case issues 

................................................................................................................................... 705 Importing Data

.......................................................................................................................................................... 70About importing data 

.......................................................................................................................................................... 71Importing transcripts 

.......................................................................................................................................................... 77Importing annotations 

.......................................................................................................................................................... 82Importing data from an iPad 

.......................................................................................................................................................... 86Importing exhibit packages 

.......................................................................................................................................................... 88Importing binders 

.......................................................................................................................................................... 90Importing files from a Clipboard 

.......................................................................................................................................................... 93Updating or appending transcripts 

.......................................................................................................................................................... 97Batch importing cases 



TextMap4

© 2017 LexisNexis. All rights reserved.

.......................................................................................................................................................... 99Using CaseViewNet Realtime 
......................................................................................................................................................... 99About CaseView Net

......................................................................................................................................................... 101Sending a transcript to TextMap

................................................................................................................................... 1016 Working with Transcripts

.......................................................................................................................................................... 101About transcripts 

.......................................................................................................................................................... 103Resizing the Transcripts pane 

.......................................................................................................................................................... 105Changing transcripts fonts 

.......................................................................................................................................................... 106Changing transcript page numbers 

.......................................................................................................................................................... 108Sorting transcripts 

.......................................................................................................................................................... 110Filtering transcripts 

.......................................................................................................................................................... 112Updating or appending transcripts 

.......................................................................................................................................................... 116Creating transcript groups 

.......................................................................................................................................................... 119Linking exhibits to transcripts 

.......................................................................................................................................................... 126Editing transcript properties 

.......................................................................................................................................................... 127Renaming transcripts 

.......................................................................................................................................................... 127Deleting transcripts 

.......................................................................................................................................................... 128Sending transcripts to Sanction 

................................................................................................................................... 07 Using the TextMap App for iPad

................................................................................................................................... 1318 Sorting Data

.......................................................................................................................................................... 131About sorting 

.......................................................................................................................................................... 132Sorting transcripts 

.......................................................................................................................................................... 134Sorting annotations 

................................................................................................................................... 1359 Filtering Data

.......................................................................................................................................................... 135About filtering 

.......................................................................................................................................................... 135Filtering transcripts 

.......................................................................................................................................................... 137Filtering annotations 

................................................................................................................................... 14010 Searching Data

.......................................................................................................................................................... 140About searching 

.......................................................................................................................................................... 142Running basic word searches 

.......................................................................................................................................................... 144Full-text Searching 
......................................................................................................................................................... 144About full-text searching

......................................................................................................................................................... 145Running full-text searches

......................................................................................................................................................... 153Running form-based searches

......................................................................................................................................................... 155View ing/navigating search results

......................................................................................................................................................... 158Using search operators

.......................................................................................................................................................... 163Viewing search history 

.......................................................................................................................................................... 164Saving searches 

.......................................................................................................................................................... 167Canceling searches 

.......................................................................................................................................................... 168Adding terms to the case thesaurus 

.......................................................................................................................................................... 171About the Search report 

................................................................................................................................... 17111 Annotating Transcripts

.......................................................................................................................................................... 171About annotations 

.......................................................................................................................................................... 175Creating annotations 

.......................................................................................................................................................... 179Viewing annotations 

.......................................................................................................................................................... 183Sorting annotations 

.......................................................................................................................................................... 183Filtering annotations 

.......................................................................................................................................................... 186Editing annotations 

.......................................................................................................................................................... 188Changing annotation owners 

.......................................................................................................................................................... 192Importing annotations 

.......................................................................................................................................................... 198Printing annotation reports 

.......................................................................................................................................................... 199Moving annotations 

.......................................................................................................................................................... 200Deleting annotations 



5Contents

5

© 2017 LexisNexis. All rights reserved.

.......................................................................................................................................................... 201Sending facts to CaseMap 
......................................................................................................................................................... 201Sending facts to CaseMap

......................................................................................................................................................... 207Updating existing facts in CaseMap

.......................................................................................................................................................... 208Exporting annotations 

.......................................................................................................................................................... 212Exporting a Sanction clip list 

.......................................................................................................................................................... 214Sending annotations as Sanction media clips 

................................................................................................................................... 21812 Working with Exhibits

.......................................................................................................................................................... 218About exhibits 

.......................................................................................................................................................... 219Using TextMap Exhibit Linker 
......................................................................................................................................................... 219Using TextMap Exhibit Linker

......................................................................................................................................................... 220Importing exhibit packages

.......................................................................................................................................................... 222Creating exhibit autolink aliases 

.......................................................................................................................................................... 224Linking exhibits to transcripts 

.......................................................................................................................................................... 230Creating single hyperlinks in transcripts 

.......................................................................................................................................................... 235Viewing exhibits 

.......................................................................................................................................................... 237Editing exhibits 

.......................................................................................................................................................... 240Verifying linked exhibits 

.......................................................................................................................................................... 240Changing exhibit file paths 

.......................................................................................................................................................... 242Changing the case exhibits path 

................................................................................................................................... 24313 Working with Video

.......................................................................................................................................................... 243About videos 

.......................................................................................................................................................... 245Importing video files 

.......................................................................................................................................................... 247Playing videos 

.......................................................................................................................................................... 249Annotating videos 

.......................................................................................................................................................... 249Editing videos 

.......................................................................................................................................................... 250Exporting videos 

.......................................................................................................................................................... 252Exporting video clips 

.......................................................................................................................................................... 260Changing search options for videos 

.......................................................................................................................................................... 261Changing video file paths 

................................................................................................................................... 26314 Editing Data

.......................................................................................................................................................... 263About editing data 

.......................................................................................................................................................... 264Using spelling tools 

.......................................................................................................................................................... 269Finding words in transcripts 

.......................................................................................................................................................... 270Copying data 

.......................................................................................................................................................... 271Using the Go To feature 

................................................................................................................................... 27215 Redacting Transcripts

.......................................................................................................................................................... 272About redactions 

.......................................................................................................................................................... 273Managing redaction reasons 

.......................................................................................................................................................... 275Redacting transcript text 

.......................................................................................................................................................... 276Editing redactions 

.......................................................................................................................................................... 278Overlapping existing redactions 

................................................................................................................................... 27916 Creating and Printing Reports

.......................................................................................................................................................... 279About reports 

.......................................................................................................................................................... 281Changing page setup options 

.......................................................................................................................................................... 284Adding/editing title pages 

.......................................................................................................................................................... 287Selecting print output options 

.......................................................................................................................................................... 291Printing Transcript Reports 
......................................................................................................................................................... 291Understanding layout options

......................................................................................................................................................... 300Printing single transcripts

......................................................................................................................................................... 304Printing multiple transcripts

......................................................................................................................................................... 309Printing Annotation Digests

......................................................................................................................................................... 324Modifying ReportBook title pages



TextMap6

© 2017 LexisNexis. All rights reserved.

......................................................................................................................................................... 329Printing to Microsoft Word

.......................................................................................................................................................... 336Printing a Search report 

.......................................................................................................................................................... 339Printing the Transcript Listing 

.......................................................................................................................................................... 340Printing the case index 

................................................................................................................................... 34417 Exporting Data

.......................................................................................................................................................... 344About exporting 

.......................................................................................................................................................... 345Exporting transcripts 

.......................................................................................................................................................... 347Exporting annotations 

.......................................................................................................................................................... 351Exporting data to an iPad 

.......................................................................................................................................................... 357Exporting videos 

.......................................................................................................................................................... 358Sending facts to CaseMap 

.......................................................................................................................................................... 364Exporting a Sanction clip list 

.......................................................................................................................................................... 366Sending transcripts to Sanction 

.......................................................................................................................................................... 368Sending annotations as Sanction media clips 

................................................................................................................................... 37218 Keyboard Shortcuts

.......................................................................................................................................................... 372Using keyboard shortcuts 

.......................................................................................................................................................... 378Creating or editing keyboard shortcuts 

Index 383



Chapter

1

About TextMap

Using TextMap
User Guide



TextMap8

© 2017 LexisNexis. All rights reserved.

About TextMap

TextMap transcript management software helps you easily manage your transcripts in an
electronic format. Each electronic transcript you import — case deposition, examination or other
proceeding — to TextMap is created as a database so you can efficiently search, annotate, add
notes, create summary reports or cull key transcript passages.

Share care access to ensure efficiency

TextMap cases can be used by multiple case staff — at the same time. The case created
should be stored in a shared location on your network to ensure that all users can access it.
In this manner, all case users are able to work together to reviewing, searching and
annotating transcripts.

Get started using TextMap

To get started using TextMap, we offer a variety of resources for you to familiarize yourself
with the software:

You can safely experiment with TextMap's features using our example case, Hawkins vs
Anstar.

You can print the TextMap Quick Reference Card.

You can follow the steps in the Quick Start Tutorial to create your own practice case or
start a new one for a client.

You can also sign up for TextMap On Demand training and learn how to use TextMap's
primary features in a guided web-based training course that you can take at your own
pace. Visit the LexisNexis University to register online today.

Learn what's new in TextMap

TextMap continues to bring new and exciting features that make it work smarter and harder.
Take time to review recent release updates and familiarize yourself with the new tools and
features that give you an advantage in transcription management.

For more information, see What's New in TextMap.

Related Topics

What's New in TextMap

About the Getting Started pane

Practicing with sample data

Using the Quick Start Tutorial

http://help.lexisnexis.com/litigation/ac/xm_docs/xm8.0/TextMap_Quick_Reference_Card.pdf
http://www.lexisnexis.com/university/Catalogue.aspx?product=CaseMap&ctype=OnDemand%20Training
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What's New in TextMap

The following enhancements are included in the TextMap version 9 release.  

TextMap 9.0

Include source when copying transcript text

TextMap now provides a new clipboard option to include the citation source when copying
transcript text. 

See Copying data for additional information.

Enhanced video clip export to PowerPoint

TextMap has added new video output options for users to export video clips to multiple
formats and positions. 

See Exporting video clips for additional information. 

Bulk link exhibits to selected transcript

TextMap now provides a way to bulk link new or existing exhibits to the transcript. 

See Linking exhibits to transcripts for additional information. 

Redact sensitive information from transcript text

TextMap now provides a redaction tool to redact confidential and sensitive information.

See About redactions for additional information. 

Create annotation from partial transcript text

TextMap now provides a way to annotate partial lines of a transcript. See Creating
annotations for additional information. 

Export video clips to MP4 format

TextMap now provides a way to export video clips to MP4 format. See Exporting video clips
for additional information. 

Import PDF transcripts

TextMap has added an option to import pdf transcripts. See About importing data and
Importing transcripts for additional information. 

View annotation linked issue color bars in transcript viewer

TextMap now provides a way to easily identify issues coded for annotation within the
transcript text. See About annotations and Creating annotations for additional information.



What's New in TextMap 11

© 2017 LexisNexis. All rights reserved.

For more release information, see the Release Notes. 

Related Topics

About TextMap

Release Notes
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Using TextMap

Navigating TextMap

Navigating TextMap

TextMap's user interface is designed so your transcript data displays in the primary workspace
pane (2) for maximum viewing. This workspace pane (2) is where you will search transcripts,
enter and track annotations, issues, notes, linked exhibits and documents, and review video
depositions in individual transcripts. To move quickly between each transcript, you will use the
Navigation pane (1) on the left side of the application. The Navigation pane (1) has three
interchangeable panes: Transcripts, Exhibits and Video, and Annotation Detail. Each pane is
then divided into task panes containing different tools for working with transcripts.

When you are working in a case, use the Transcripts pane to access transcripts. In the Exhibits
and Video pane, you can view video depositions, link exhibits, and view linked exhibits and
other documents. Use the Annotation pane to review an annotation's properties, notes, and
linked issues, as well as send facts to CaseMap, review linked CaseMap fact details, and open
linked CaseMap facts in CaseMap.

Use the Search pane to run basic keyword searches and full-text searches. The Full Text Search
tab allows you to narrow your search by categories and limit your search to selected transcripts
and/or case issues.

The tools you need to search, sort, edit, and analyze data as well as create reports are
primarily performed by clicking on the ribbons or clicking on commands in the TextMap drop-
down menus. All administrative tasks are located on TextMap menus.

You can print a hard copy of the TextMap user interface and number key by printing the 
TextMap Quick Reference Card.

To view the number key

1. Navigation Pane

The Navigation pane runs vertically along the left side of TextMap and provides access to
three different panes: Transcripts, Exhibits and Video, and Annotation Detail. Click on the
buttons at the bottom of the Navigation pane to access each set of tools.

http://help.lexisnexis.com/litigation/ac/xm_docs/xm8.0/TextMap_Quick_Reference_Card.pdf
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A. Task Pane Name

Displays the name of the pane that is currently open in the Navigation pane.

B. Transcripts Pane

Contains the names of the transcripts imported into the TextMap case. Displays at
the top of each pane. Transcripts can be sorted by name, transcript date, or import
date, and can be sorted in ascending or descending order.

C. Task Pane

Displays task panes for performing tasks specific to the selected pane. For example,
the Exhibits and Video pane contains the Exhibit Tasks and Exhibits task panes.

D. Minimize

Allows you to minimize the Navigation pane to expand the Transcript window for
better viewing.

E. Navigation Buttons

Opens the task panes available within the Navigation pane.

2. Workspace

Displays the case transcripts, annotations, and the Search pane.

F. Transcript Name

Contains the name of the transcript currently selected in the Transcripts pane.

G. Annotation Pane

Lists the annotations within the transcript currently selected in the Transcripts pane.

H. Transcript Window

Displays the transcript currently selected in the Transcripts pane.

I. Search Pane

Allows you to run keyword searches and full-text searches on transcripts within a
case. Contains the Word Search and Full Text Search tabs.

3. Title Bar

The Title bar displays the name of the case currently open in TextMap.

4. Ribbons

The Ribbons (Home, Reports, Transcripts, Case Tools, and View) contains menu items
and other commands for performing TextMap tasks.

Two additional ribbons (Text & Video Tools and the Search Tools ribbons) contains
menus and buttons for Annotation management, and for opening and navigating search
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hits. See About TextMap menus for additional information.

5. Quick Access Tool Bar

The TextMap Quick Access toolbar can be customized to add and/or remove buttons/
functionality. By default, the toolbar displays the most commonly used buttons.

The Quick Access Toolbar can be displayed above or below the TextMap ribbon by
selecting the 'Show Quick Access Toolbar Below the Ribbon' option when customizing
the toolbar.

6. Transcript Status Bar

Displays transcript status information, such as the current transcript and page count,
and the current cursor location within the Transcript window.

7. Case Staff User

Displays the name of the user currently logged on to TextMap.

8. Index and OCR Status Icons

Displays the current indexing and optical character recognition (OCR) processing status.

Related Topics

About the Navigation pane

Modifying Navigation pane display

About TextMap menus

About the Navigation pane

The Navigation pane is a vertical pane located on the left side of your screen when you open a
case in TextMap. TextMap's Navigation pane has three task panes. The default setup is to
display the Transcripts pane. The Transcripts pane allows you to easily transfer from working in
one case transcript to another. The Transcripts list is displays at the top of each pane.

TextMap's Navigation Pane

Elements Description

Transcripts Use to navigate between case transcripts in TextMap.

Exhibits and
Video

Use to navigate between case transcripts in TextMap, view videos
synchronized with transcripts, link exhibits to transcripts, and view exhibits
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TextMap's Navigation Pane

and other documents linked to the selected transcript.

Annotation
Detail

Use to review the selected annotation's properties, notes, and linked issues,
edit the selected annotation, send facts to CaseMap, review linked CaseMap
fact details, and open linked CaseMap facts in CaseMap.

Arrow Button Use to show/hide pane buttons to maximize viewing within the Navigation
pane.

Transcripts pane

The Transcripts pane allows you to navigate between transcripts or transcript groups within
a case. By default, transcripts are listed in alphabetical order by transcript name. Click the
Arrange By button to choose whether transcripts are sorted by transcript name, transcript
date, or import date. Click the Sort button to the right of the Arrange By button to toggle
between sorting transcripts from ascending order or descending order.
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Exhibits and Video pane

The Exhibits and Video pane has four task panes:

Transcripts pane — Allows you to navigate between transcripts or transcript groups
within a case.

Video pane — Allows you to play the video depositions that are synchronized with the
selected transcript.

Exhibit Tasks pane — Allows you to link exhibits to the selected transcript and view
exhibits and other documents linked to the selected transcript. Exhibits can be files on
your computer, Web addresses, and custom links to other document management
programs. The Open linked document feature is enabled when a linked exhibit or other
linked document is selected in the Exhibits pane.

Exhibits pane — Displays the exhibits and other documents linked to the selected
transcript, includes links to where the exhibits and documents are linked within the
transcript. Allows you to navigate to the exhibit and document links within the transcript
by clicking the link in the Exhibits task pane.
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Annotation Detail pane

The Annotation Detail pane has three tasks panes and a toolbar:

Transcripts pane — Allows you to navigate between transcripts or transcript groups
within a case.

Annotation Actions pane — Allows you to edit the selected annotation, send a new fact
to CaseMap (the fact will be linked to the current annotation), view the linked CaseMap
fact details, and view the fact record in CaseMap that corresponds to the selected
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annotation.

Annotation Properties pane — Displays the annotation properties for the annotation
currently selected in the Transcript window. The annotation properties include the
transcript page and line numbers for the annotation location in the transcript, whether
the annotation is linked to a fact record in the corresponding CaseMap case, any
annotation notes, and the name of linked case issues and the color associated with each
linked case issue. 

Annotation Detail toolbar — Allows you to navigate between annotations in the
selected transcript.
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Arrow button

Below the Annotation Detail button is the Arrow button, which allows you to collapse or
expand buttons to maximize the pane view.

Related Topics

Navigating TextMap

About the Search pane

Modifying Navigation pane display

About the Search pane

The Search pane allows you to run basic word and full-text searches on transcripts in the case.
The Search pane includes two tabs: Word Search and Full Text Search.

To view the Word Search tab

The Word Search tab allows you to run word searches on all transcripts in the case. Search
results display within the Word Search tab. See About searching and Running basic word
searches.
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To view the Full Text Search tab

The Full Text Search tab allows you to run multiple word searches on transcripts in the case
(or from the Full Text Search dialog box). Full-text searches can be run on all or selected
transcripts or transcript groups. Full-text search results display within the Full Text Search
tab. See About full-text searching and Running full-text searches.



TextMap22

© 2017 LexisNexis. All rights reserved.

     

To resize the Search pane to maximize transcript view

The Search pane displays to the right of the Transcript window. To increase your viewing
space, you can re-size the Search pane by dragging the split bar to the left or right.

You can change search tabs by clicking the Previous and Next buttons  in the top right of
the pane. The Previous and Next buttons display as the Search pane is re-sized closely to
the right side of the TextMap window.

You can still run searches in either search tab as longs as the search box is visible; however
you may not be able to view search results clearly or narrow full-text searches by category
as easily.
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Related Topics

Navigating TextMap

About the Navigation pane

About searching

Running basic keyword searches

About full-text searching

Running full-text searches

Modifying Navigation pane display

You can modify the display of the Navigation pane to suit your viewing preferences: move the
task pane buttons, resize the Navigation pane view, and hide the Navigation pane.

To change the Navigation pane display

To change the Navigation pane display, click on the respective pane's button. The active



TextMap24

© 2017 LexisNexis. All rights reserved.

pane is highlighted accordingly.

To maximize a pane for better viewing

To change the height or width of the Navigation pane, drag the split bars to the left or right,
or up or down.



Using TextMap 25

© 2017 LexisNexis. All rights reserved.

As you pull the bottom split bar down, the Navigation pane buttons change into icons on the
lower button.

You can also, click the arrow on the lower button and select Show More Buttons or Show
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Fewer Buttons to maximize the pane view.

To hide task panes for better viewing

To show/hide task panes on the Navigation pane, click the Expand/Collapse buttons . For
example, if you want to expand the display area of the Exhibits task pane in the Exhibits and
Video pane, you can hide the Transcripts, Video, and Exhibits Tasks panes.

To hide the Navigation pane to maximize the spreadsheet view

To maximize a transcript's view on-screen, click on the Collapse button to pin the Navigation
pane to the left side of TextMap. The Navigation pane can easily be expanded and locked
on-screen when you need to use it more frequently.
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Related Topics

Navigating TextMap

About the Navigation pane

About the title and status bars

TextMap has two title bars: one for the application and one for the transcript. The status bar is
on the bottom of the TextMap window.

Application title bar:

TextMap's title bar displays the name of the case you are currently viewing.

Transcript title bar:

The Transcript title bar displays above the Annotations pane and Transcript window. The left
side of the title bar displays the title of the current transcript. The right side of the title bar
displays the number of annotations in the current transcript.

If a search is performed, a Search Results bar displays just below the title bar with the search
criteria noted. Click the Cancel Search or Save buttons to remove the search or save it for later
use.

Status bar:
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The status bar at the bottom of the TextMap window displays the current transcript out of the
total number of transcripts in the case, the current transcript page out of the total number of
transcript pages, the current user name, and the indexing and OCR processing status. 

Related Topics

Navigating TextMap

About TextMap toolbar buttons

TextMap has a Quick Access toolbar that you can customize to display which buttons you use
most frequently. By default, the toolbar displays the most commonly used buttons. Place your
mouse pointer over each button to view its name. 

Click on the More Buttons  icon at the far right of the toolbar to view a listing of all available
buttons. Select a button in the button list to add or remove a button to or from the toolbar. All
checked buttons in the list display on the toolbar. 

The toolbar submenu allows you to determine which toolbar/ribbons are displayed in TextMap,
and customize the Quick Access toolbar, to include customizing ribbons and keyboard shortcuts
using the Customize dialog box. 

To reset the toolbar to its original default view, click on the More Buttons icon  to view the
toolbar menu, and then select Reset at the bottom of the Ribbon Customization dialog box.
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Quick Access toolbar buttons

Reference the following table for a listing of the Quick Access toolbar buttons and
descriptions. 

Placing your pointer over an icon (i.e., Import Transcript) within the application provides
a brief description/use of the selected icon.
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Quick Access Toolbar Buttons

Button Name Use

 
Copy
Selection

Use the Copy Selection button to copy text from a transcript
to paste into a text file or another application.

Copy with
Page:Line

Use the  Copy w/ Page:Line button to copy text or text from a
transcript with page/line numbers included.

Copy
Annotatio
ns

Use the Copy Annotations button to copy the contents of the
selected annotation.

Print Use the Print button to print transcripts, annotations, notes,
and the case index to the default printer.

Print
Preview

Use the Print Preview button to view the print preview of
transcripts, annotations, notes, and the case index.

Print to
PDF (File)

Use the Print to PDF (File) button to print transcripts,
annotations, and notes to an Adobe Acrobat PDF file. Opens
the Save As PDF dialog box and allows you to save the PDF
file to a local or network directory.

Print to
PDF
(Email)

Use the Print to PDF (Email) button to compile a PDF and then
opens the default email application so you can save the PDF
file as an e-mail attachment.

Import
Transcript

Use the Import Transcript button to select one or more
transcripts to be imported in to the case.

Export
Transcript

Use the Export Transcript button to select one or more
transcripts, along with annotations and linked exhibits to be
exported.

Play Video Use the Play Video button to play the video associated with
the selected transcript. Clicking the Play Video button opens
the Exhibits and Video pane in the Navigation pane, and the
video is displayed in the Video pane. The Play Video button is
only active when the selected transcript contains a video file.

New Local
Case

Use the New Case button to open the New Case Wizard for
adding a new local TextMap case.

Open
Local
Case

Use the Open Local Case button to open a dialog box for
selecting and opening a local case in TextMap.

Print to
Microsoft
Word

Use the Print to Microsoft Word button to print transcript
annotations and notes to a Microsoft Word file.
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Quick Access Toolbar Buttons

Button Name Use

Send Fact
to
CaseMap

Use the Send Fact to CaseMap button to send the selected
text in a transcript to CaseMap. Before you can send a fact to
CaseMap, the case must be opened in CaseMap.

  and  
Go to Prior
Hit and
Next Hit

Use the Go to Prior Hit and Next Hit buttons to navigate
search hits in your transcript.

  and  
Go to First
and Go to
Last

Use the Go to First Hit and Go to Last Hit buttons to navigate
search hits in your transcript.

Realtime Use the Realtime button to open CaseViewNet. CaseViewNet
is a free transcript viewer made by Stenograph, LLC.

 
Case
Issues

 Use the Case Issues button to create, delete, and/or import
issues associated with the case.

 
New
Annotatio
n

Use the Export to iPad button to export case issues,
transcripts, annotations, and linked exhibits to an Apple iPad.

Edit
Annotatio
n

Use the Edit Annotation button to edit the selected
annotation.

Move
Annotatio
n

Use the Move Annotation button to move the selected
annotation to a new location within the transcript.

Delete
Annotatio
n

Use the Delete Annotation button to select an option to
delete a single or all annotations from the transcript.

New Fact Use the New Fact button to create a new fact record in
CaseMap.

Full Text
Search

Use the Send Fact to CaseMap button to send the selected
text in a transcript to CaseMap. Before you can send a fact to
CaseMap, the case must be opened in CaseMap

Page
Setup

Use the Page Setup button to adjust paper size, orientation,
printer source, and report scaling options before printing
reports and other materials.

Find Use the Find feature to search case content. You can also
replace text if you need to change the spelling of a word in
your case.
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Quick Access Toolbar Buttons

Button Name Use

Close Use the Close button to close and exit the current transcript.

Related Topics

Navigating TextMap

Changing toolbar buttons and settings

Changing toolbar buttons and settings

TextMap allows you to add and remove toolbar buttons and settings for your personal view.

To add/remove toolbar buttons

1. On the Quick Access toolbar, click the More Buttons  icon in the upper left corner.

You can also right-click on the Quick Access toolbar.

2. From the Quick Access Toolbar list, select or deselect the buttons you want to display.

Menu items with a check mark display on the toolbar. The toolbar display is updated.
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To add menu commands to the toolbar

1. On the Quick Access toolbar, click the More Buttons  icon in the upper left corner.

You can also right-click on the Quick Access toolbar.

2. From the menu list, select one of the following:

Customize the ribbon

a. Click Customize the Ribbon.



TextMap34

© 2017 LexisNexis. All rights reserved.

b. In the Choose commands from area of the Ribbon Customization dialog box, select
the desired command/tab.

The Command display is updated based on the command type selected in the previous
step.

c. Under the Customize the Ribbon heading, place a check mark next to the tab(s)
to be displayed.

d. Use the applicable up  or down  arrow to place appropriately.

e. Optional: To add a new tab

1. Under the Customize the Ribbon heading, select the tab/area where the new

tab is to be added.

2. Click the Add button, and then click Add New Tab.

A new tab is added.

3. Click the Rename button.

4. In the Display name box, enter a new name for the tab.

5. Click OK.

The new name is displayed.

6. Click OK to close the Ribbon Customization dialog box.

f. Optional: To reset customized ribbon settings

1. Click the Reset button and select:

Reset only selected tab to reset only settings for the selected tab.

Reset all customizations to reset all customized settings back to the default
system settings.

2. Click OK.

To customize toolbar

1. Right-click on the Quick Access toolbar, and click Customize Quick Access Toolbar.

2. In the Quick Access Toolbar Customization dialog box, in the Choose commands from
area, select a command in the list.

3. Select applicable tabs, submenus, etc. and click the right arrow  .

4. In the Customize Quick Access Toolbar area, use the Up arrow  to adjust the
placement.
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5. Repeat Steps 2 - Steps 4 as applicable.

6. Click OK to save setting changes.

Related Topics

Navigating TextMap

About TextMap toolbar buttons

About TextMap menus

TextMap's Menu bar (now referred to as the Main Ribbon) is located at the top left of the
TextMap screen. Click on each ribbon (e.g., Home) to access the menus/commands, each
providing additional functionality in TextMap.

The commands on each menu affect the transcript currently in view. Some options will give you
an arrow that opens a submenu of additional tools. Most of the commands also have
corresponding keyboard shortcuts. See Using keyboard shortcuts.

File menu

The File menu contains menu items useful in getting started and accessing your case, such
as New Case, Open Case, Open SQL Case, Close Case, and Exit. The File menu also has
options for importing data from other applications, exporting case issues, transcripts,
annotations, and linked exhibits, changing report options in the Page Setup dialog box,
creating a replica and synchronizing data from a replica case with the master file. Print and
Print Preview options are also listed on this menu. And you can view case properties too.

If you are using CaseMap Server, the File menu has two options for opening a case:
Open Local Case and Open SQL Case. The menu also has an option: New Local Case.
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Home ribbon

The Home ribbon contains menu items for copying transcript text in the Transcript window,
finding text in the current transcript using the Find dialog box, and navigating directly to a
page and/or line within the selected transcript using the Go To dialog box. The Home ribbon
provides you with import and export capabilities, to include the ability to add new
annotations, facts and redactions with access to CaseViewNet®.
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Reports ribbon

The Reports ribbon contains menu items for printing transcripts using the Transcript Listing
tab. There is also a command for printing the TextMap Transcript Listing report, which
displays the list of transcripts in each case.

The Search Reports submenu contains menu items for generating and printing a Search
Report for the current search results or creating a new search and printing the search
results for the new search.

Transcripts ribbon

The Transcripts ribbon contains menu items for selecting the transcript to display, creating
and maintaining transcript groups, linking exhibits to transcripts, renaming, deleting,
updating, and appending transcripts, adding transcripts to a transcript group, as well as
sending transcripts to CaseMap and/or Sanction. 

The Send To CaseMap option allows you to send transcripts to CaseMap, whereas the
Advanced CaseMap submenu allows you to update the transcript in CaseMap, show the
linked CaseMap record detail, navigate to the linked CaseMap record in CaseMap. The
Transcripts ribbon also provides you with the ability to send transcripts to include Media clips
directly to Sanction.

Case Tools ribbon

The Case Tools ribbon contains menu items for managing linked exhibits, exhibit autolink
aliases, and TextMap utilities. Per one of the utilities, the Case Index submenu, you are
allowed to rebuild the case index, view linked exhibit index and OCR status, disable/enable
OCR processing, and manage the Case Ignore Words list. Other utilities allow you to
optimize the case, change annotation owners, and also provides access the LexisNexis
Expert Research On-Demand web site.
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View ribbon

The View ribbon contains menu items for modifying the TextMap user interface based on
your viewing preference. From the View ribbon, you can change the arrangement/sort order
of transcripts, choose whether to display all transcripts (i,.e., groups), manage transcript
font size and transcript properties, show/hide the Navigation, Annotation, and annotation
highlights in the Transcript window, and determine which pane (e.g., Transcripts) is currently
displayed in the Navigation pane.

With the Filter Annotations tab, you can filter annotations by creator or linked issues.

Text & Video Tools Create & Edit ribbon

The Create & Edit ribbon appears when there is transcript text focus, or when an annotation
or transcript text has been selected. It is accessed from the Text & Video Tools ribbon and
contains menu items for copying transcript text in the Transcript window, finding text in the
current transcript using the Find dialog box, and navigating directly to a page and/or line
within the selected transcript using the Go To dialog box. From the Create & Edit tab, you
can also manage videos, navigate, create and edit annotations.

Adjust navigate annotation ribbon button layout

1. Open a case in TextMap.

2. Click on any transcript text to display the Create & Edit ribbon.

3. Right-click on the Text & Video Tool Create & Edit ribbon, and on the sub-menu, click
Customize the Ribbon.

4. In the Ribbon Customization dialog box, select the Navigate Annotations option to be
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moved, and then using the Up  or Down  arrow, change the order to any order
necessary to meet your needs.

5. Click OK to implement the change.

The changed order is displayed on the refreshed Text & Video Tools Create & Edit ribbon.

Text & Video Tools Options ribbon

The Options ribbon appears when there is transcript text focus, or when an annotation or
transcript text has been selected. It is accessed from the Text & Video Tools ribbon and
contains menu items for:

selecting the annotation mode

sending annotations to CaseMap

sending annotations to Sanction as media clips when the transcript has synchronized
video

updating facts associated with an annotation in CaseMap

showing the linked CaseMap fact detail

navigating to the linked CaseMap fact in CaseMap.

Search Tools Search ribbon

The Search ribbon appears when there is an active search and contains menu items for
navigating between search hits in the selected transcript, creating reports, saving, editing,
and canceling the current search.

The Search Reports ribbon's Search Report menu item launches the Search Report Wizard to
generate and print a Search Report.
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Help & Info menu

The Help menu which is accessed from the File menu provides access to the TextMap Answer
Center as well as a variety of other reference materials. From this menu, you can also
reference your TextMap license and registration information, activate the software, and
check for Web updates of the software, to include access to TextMap Training and Support
information.

If you are using CaseMap Server and have a SQL case open, click About LexisNexis
TextMap and then click the Disabled Features button to verify if any permissions are
disabled for your user account. If no permissions are disabled, a message displays to
indicate that.

Related Topics

Navigating TextMap

Changing toolbar settings and buttons
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Getting Started

About the Getting Started pane

The Getting Started pane displays when you open TextMap or close a case. From this pane you
can access recently-opened cases, older cases, create a new case, or refresh and open the
Hawkins example case. You can access a variety of learning resources from here too. If you
already have a case open and want to open the Getting Started pane, you can still access this
pane from the File menu.

You can clear the recent case list from the Help menu, by clicking on Options and then
clicking General. On the General tab, click the Clear Recent File List button. Click OK when
you are finished.

To open/close the Getting Started pane when a case is open

1. Click the File menu.
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The Getting Started page displays.

You can also click the Getting Started tab from another tab (e.g., Case Setup) to open it.

2. On the Getting Started pane, click the X in the upper right corner t close it.

You can also click on another tab (e.g., Case Setup) to close the Getting Started page.

Related Topics

Practicing with sample data

Quick Start Tutorial

Opening cases

Practicing with sample data

TextMap provides you with a sample case, Hawkins v. Anstar, so you can practice using the
application without using your own data. Hawkins v. Anstar is a fictitious case. When
experimenting with the case, you can feel confident about clicking, adding, updating, and
deleting data without ruining it. Any changes you make to the example case are automatically
saved so you can see how the software displays and updates data.

You can always practice a feature more than once by refreshing the sample data to its original
state and starting again.

To open the example case

On the Getting Started pane, under Learn from an Example Case, click Hawkins v. Anstar.

If you cannot find the Getting Started pane, click the File menu and then click Getting
Started.

To refresh the example case

1. On the File menu, click Getting Started.

2. On the Getting Started page, under Learn from an Example Case, click Refresh
Example.

3. Click on Hawkins v. Anstar to re-open the refreshed case.

Related Topics

About the Getting Started pane
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Quick Start Tutorial

Opening cases

Using the Quick Start Tutorial

If you have not yet signed up for TextMap training, the TextMap Quick Start tutorial will help get
you grounded in using the software and working in a case.

The TextMap Quick Start tutorial is designed to help you:

Learn about TextMap's primary features.

Gain an introduction to the tools and features you need to use to create a case and start
working in it.

Practice using some of the features using the Hawkins v. Anstar example case provided in
TextMap.

Direct you to the help topics and procedures you need to accomplish initial tasks and learn
more about TextMap.

Creating new cases

TextMap cases are created using the New Case Wizard, which guides you through
answering all the questions needed to create the file. The New Case Wizard provides you
with a default new case template that accommodates most of your data entry needs. The
example case, Hawkins v. Anstar, uses a new case template. See Practicing with sample
data.

TextMap cases are used by multiple staff. Store the case in a shared location on a network
drive so more than one staff member can work on annotating and summarizing depositions
and transcripts in the case file at the same time. You can add case staff as users in the New
Case Wizard or add them later in the Case Staff dialog box by clicking File > Case Setup >
Edit Staff.

Case files are identified by the column icon and have a file extension of .txmap 

.

See About cases, Creating cases, and Adding users to cases.

Importing transcripts

You must import transcripts into your new case before you can search and annotate them or
cull out facts to send to CaseMap. Import transcript files into TextMap by clicking the Import
File(s) option on the File or Transcript menus. Transcripts display in the main Transcript
window with page and line numbers displaying in the left margin.

The most common way to import information into TextMap is by importing a file in an ASCII
text file. This allows the line numbering and page numbering of the original transcript to be
the same as the transcript inside TextMap. See About importing data for a complete listing of



TextMap44

© 2017 LexisNexis. All rights reserved.

files types you can import. See Importing transcripts for more information about the import
process.

TextMap Exhibit Packages (created by TextMap® Exhibit Linker) include a transcript,
hyperlinks to exhibits mentioned throughout the text, and the linked exhibit documents. You
import an Exhibit Package file (*.xmef) just like any other transcript. All the exhibits and
exhibit hyperlinks in the transcript are available instantly. See Importing exhibit packages.

You can also import video files like any other transcript in TextMap. When the import is
complete the transcript displays in the Transcript List with a video icon that is different than
the icon for text-only transcripts. You can search and annotate video transcripts just as you
would with other transcripts in the case. See About videos and Importing video files.

Creating case issues

If you are using TextMap and CaseMap together you can import your issue outline from a
corresponding CaseMap case and then create categorizing issues, like Background, that are
only used in the corresponding TextMap case. If you are using TextMap as a stand-alone
transcript summary tool, you can quickly create an issue outline from scratch. See About case
issues and Importing case issues.

In TextMap, all issues are initially set to the default color yellow. You can assign each issue a
color so that it can be easily identified when scrolling through the transcript. For instance,
you could color code all research items red to be easily recognizable. You can also move
topics around in an issues list, arranging issues in a different order. And you can create sub-
issues or child issues of the parent issue. See Creating case issues.

Once issues are created and coded by color, you can issue-code annotations. Annotations
can be linked to one or more case issues. See About annotations and Creating annotations.

Searching transcripts, annotations, and linked exhibits

TextMap allows you to quickly search all transcripts, exhibits, documents, annotations, and
notes in your case because it automatically creates a case index during the import process.

Searching is performed in the Search pane that displays at the bottom right of TextMap. The
Search pane contains two tabs: Word Search and Full Text Search. Search results display
within their respective tabs. See About the Search pane.

There are two methods of searching in TextMap:

Basic Word Searches — performing single word searches to locate all instances of the
word in transcript text. See Running basic word searches.

Full-Text Searching — performing full-text searches against transcript text, annotations,
and exhibits. See About full-text searching and Running full-text searches.

To learn more about searching, see also About searching and Viewing/navigating search
results.

Choosing an annotation mode

TextMap offers three annotation modes to help you simplify the annotation process,
depending on how you want to work. Each time you open a case in TextMap, the TextMap
Default Annotation Mode dialog box displays, unless you select the Don't show again check
box. You can change annotation modes at any time by clicking the Annotation menu and
then clicking the desired mode. You can also click on the Annotations button on the toolbar
or use the right-click menu. Manual Mode is the default annotation mode.
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If you choose Manual Mode (default), each time you annotate text you will have the
option to choose which mode you want to use: Annotate in TextMap or Send to
CaseMap.

If you choose Auto Annotate in TextMap, the New Annotation dialog box automatically
displays each time you highlight transcript text. You can quickly type in notes or link
issues and exhibits before you send the passage to CaseMap. See Creating annotations.

If you choose Auto Send to CaseMap mode, the annotated passage will be sent as a
new fact to CaseMap and the Send to CaseMap dialog box displays. See Sending facts to
CaseMap.

To learn more about switching annotation modes, see About annotations.

Annotating transcripts

After transcripts have been imported into TextMap, they are ready to be analyzed and
annotated. During this process, you will select phrases, sentences and paragraphs, and
comment on them. Annotations can be part of a deposition summary report, or passage you
want to use as the basis for a fact in CaseMap. You can categorize annotations by case
issue and link exhibits to the annotated text. Annotations display in the transcript as yellow
(by default). Annotations linked to issues display the color of that issue code. Annotations
can be linked to one or more issues. See About annotations and About case issues.

To annotate a transcript, use your mouse to highlight a passage of transcript text, then
right-click to select the annotation mode you want to use: Annotate in TextMap or Send Fact
to CaseMap. See Creating annotations.

Annotated text displays highlighted in the Transcripts window (center pane) with a sticky
note icon in the left margin. The annotation displays as yellow by default or in the color of
the linked issue.

Annotations also display in the Annotations pane where they can be sorted and filtered. You
can also view annotations in the Annotation Detail pane. See Viewing annotations, Sorting
annotations, and Filtering annotations.

Color-coded annotations display in reports in color. Reports can be filtered so only
annotations associated with specific issues are included. See Printing annotation reports.

Reviewing and annotating using the TextMap App for iPad

With TextMap, you can easily review and annotate transcripts on your Apple® iPad®.
Download the free TextMap app for iPad from the Apple Store and then email the transcripts
you want to review. Simply open the email attachment on your iPad to import the case.

When you are ready to update the master case with your new or edited annotations, simply
email them from the iPad. Opening the email attachment will start the import process and
prompt you to apply your updates to the master case. TextMap has no limit to the number of
case users that can send annotations from their iPads.

Anytime you need the most recent changes to the master case, export the changes and
merge them with the changes already on the iPad.

For more information, see About the TextMap app for iPad, Exporting data to an iPad, and
Importing data from an iPad.

Sending facts to CaseMap

We encourage you to use CaseMap from the first day you begin working on a new matter.
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When you use CaseMap in conjunction with TextMap, you can enter new facts well in
advance of having court-appropriate sources for these fact records. And you can always
update the existing fact records while working in TextMap. Later, when you find a source for
a given fact as you review a transcript, you can update the pre-existing fact.

TextMap is designed so you can optionally perform all basic data entry about a fact in the
midst of sending a transcript passage to CaseMap. These options are available in the dialog
boxes that display when you send a new fact to CaseMap or update an existing one. For
each transcript passage sent to CaseMap, TextMap automatically creates a source that
references the transcript and the page and line numbers of the selection. You must have the
related CaseMap case already open in order to send transcript annotations from TextMap to
CaseMap.

You can tell which annotations have already been sent to CaseMap by checking the
Annotations pane at the top of the page. The Linked Fact column has a Yes/No status
indicator for each annotation. Annotations with a Yes have been sent to CaseMap. The
CaseMap fact automatically links back to the selected passage in the transcript. If the fact
has already been sent, a message displays asking if you want to re-send the annotation (it
replaces the link to the existing fact).

If you intend to send multiple annotations to CaseMap, consider switching to the Auto Send
to CaseMap annotation mode. Click the arrow next to the Annotate in TextMap button or
click the Annotations menu, and then click Auto Send to CaseMap. Each time you annotate
transcript text the Send to CaseMap dialog box automatically launches, skipping the New
Annotation dialog box

See Sending facts to CaseMap and Updating existing facts in CaseMap.

Linking exhibits to transcripts

Exhibits can be files on your computer, web addresses, and custom links to other document
management programs. When you have a file that has been referred to as an exhibit during
a transcript, you want that file to be linked wherever that exhibit is referred to in the
transcript. You can link to exhibits using either the TextMap Exhibit Linker or the Auto Link
Exhibit Wizard. See About exhibits.

Link Exhibit Wizards include:

TextMap Exhibit Linker is used before you import transcripts into a TextMap case. This
software is provided to court reporters, vendors, and law firm staff so that they can
create TextMap Exhibit Packages (.xmef) which can then be imported into TextMap.
These files already have the exhibit links embedded in the transcripts. TextMap also
imports the linked exhibit PDFs during the import process. See Using TextMap Exhibit
Linker.

The Auto Link Exhibit Wizard is used once you have already imported a transcript into
TextMap. With this wizard, you can create a hyperlink to a file on your computer, a web
address, or a link to another document management system in all places in the transcript
where the exhibit is mentioned. See Linking exhibits to transcripts.

Hyperlinks for exhibit files display in the Exhibits and Video pane in the Exhibits pane for the
selected transcript. When you click a page and line reference, TextMap displays that point in
the transcript. You can view the exhibit by clicking the hyperlink in the transcript or by right-
clicking on the exhibit link in the Exhibits pane and clicking Open. You must have the native
application installed on your computer in order to view the file. See Viewing exhibits.

To link exhibits or any other files to a single passage in the transcript, use the New Hyperlink
Wizard. See Creating single hyperlinks in transcripts.

Working with video
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You can import video files like any other transcript in TextMap. When the import is complete
the transcript displays in the Transcript List with a video icon that is different than the icon
for text-only transcripts. For a list of video files you can import, see About videos and
Importing video files.

Videos play in TextMap with a cursor scrolling through the text in synch with the video
because there are three components working at the same time: a video file (an .mpeg or
.wmv), a text file, and a file with synchronization information.

You can search and annotate video transcripts just as you have done with other transcripts
in the case. See Annotating videos. In addition, you can use the Edit Video dialog box to
make a snippet associated with an annotation a little shorter or longer. See Editing videos.

Before you can play back transcript video in TextMap, you must first have the transcript
synchronized with the video. TextMap does not synchronize the video and the transcript for
you. Usually your court reporter or videographer can perform the video synchronization
service for you. When you schedule a video deposition with court reporters, make sure to
ask if they can perform the video synchronization service and provide the synchronized
transcript in a format that TextMap can import.

Creating and printing reports

A report is a way to retrieve information that you imported or entered in your case. TextMap
offers many useful reporting options, accessible on the Reports ribbon with single and
multiple transcript sub-menus. Many of the reports have wizards to make creating useful
work product quick and easy. Transcripts with annotations and linked issues have options
for including the selected passages and filtering highlighted passages for desired issues.
TextMap automatically creates a word index for all transcripts; you can include it with
transcript reports or not.

You can print reports to PDF file or print directly onto paper. You can run reports of only the
transcripts, just the annotations, or of both the transcripts and the annotations.

The date and time appears in brackets [ ] in front of the transcript name, and is included in
all transcript reports (i.e., Multiple Transcript Report, Annotations Digest Report, etc.).

TextMap includes the following reports:

Single Transcript Report — A simple report made from just one transcript. These reports
provide you with the contents of the transcript arranged the way you specify, with the
opportunity to select all annotations or annotations related to a specific issue. You can
print the contents with or without annotations. You also have the option of printing the
word index for that transcript as part of your report. See Printing single transcripts.

Multiple Transcript Report (a.k.a ReportBooks) — A report containing information from
more than one transcript is also called a ReportBook. You have the opportunity to choose
what transcripts to include in the ReportBook, as well as the option of including a Title
Page, Table of Contents, and Introduction. You will have the option to organize
transcripts in the order you want them. You also have the same options that you do with
a single transcript report. See Printing multiple transcripts.

Annotation Digests are also ReportBooks that can be printed to Microsoft Word.
Annotation Digests include the annotations and notes from a set of ReportBooks and can
be filtered by issue. See Printing Annotation Digests.

Search Report — The Search Reports is based upon terms you type into the Full Text
Search box. The report shows by transcript all locations that contain the search criteria.
See Printing a Search report.

Transcripts Listing — A Transcripts Listing provides a list of the transcripts in the case.
See Printing the Transcript Listing.
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Single and multiple transcript reports can be printed as full-sized, condensed or note-taking
versions. Transcripts with Annotations reports allow you to print with Footnotes or Endnotes
(full-size or condensed).  See Understanding layout options.

The Transcripts with Annotations report, Transcripts with Linked Exhibits report (and no
annotations), and Annotation Digest reports allow you to print to a PDF format that includes
linked exhibits embedded in the transcript. See Selecting print output options.

For more information, see About reports.

Taking TextMap on the road

Create replica cases for staff who need to work from home or access a case during court or
offsite depositions. Replica cases include access to linked files and exhibits, with the
exception of Web sites and links to files in a document management systems.

When case users go on the road, they can take a replica along and make additions and
updates to case records. While these individuals work in replicas, case staff back in the office
can still make changes to the master case. When the replica is returned or emailed to the
office, the latest content can be synchronized into the master case.

With TextMap, a replica can be synchronized repeatedly with the master case — without
creating duplicate transcripts and annotations. This allows users on the road to email
replicas back to the main office for synchronization each time significant updates are made,
while continuing to work in the replica.

All replica names (local and SQL versions) must be unique. Creating a replica of a TextMap
case is an exclusive process. Case staff cannot access the master case during this process.

For more information, see About replicating/synchronizing cases and Creating replica cases.

Related Topics

Practicing with sample data

Opening cases

Opening cases

Case files are databases created to store all the data related the case. Some case files are
created and saved locally on your organization's network. Other case files are created and
stored for remote user access across your organization's Wide Area Network (WAN). For
example, case files stored on a WAN can be accessed by TextMap users across the nation or
even in another country. Depending on how the case file is created and where it is saved
determines how you will open the case in TextMap. Case files that are located on the WAN may
take longer to open than those saved locally.

Three methods of opening a case:

File > Open > Recent Cases — Launches a list of cases you frequently use.
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File > Open > Computer — Launches cases saved locally on the network and written to a
Microsoft® Access database. These case files are saved in network folders where other case
file data is stored and organized.

File > Open > SQL Case — Launches SQL cases stored on the Wide Area Network (WAN)
and written to a SQL database. These cases are saved in CaseMap Server, which is a
dedicated database server designed to store TextMap cases.

If you do not have CaseMap Server, you will not see this option on the File menu.

If you are working in multiple cases, you need will need to know which option to use for each
case file you want to open. If you are opening SQL cases, your system or database
administrator will need to provide you with the network server name and which authentication
option to use when opening the case.

TextMap allows you to open one case at a time within an active application window. If you
want to work in other cases simultaneously, you'll need to launch additional TextMap windows
to access them. Case names display in your Windows title and status bars so you can
differentiate them while working.

If you cannot open a case, contact your system administrator and tell them the case name
you need to open. They can ensure that you have proper access to to the network
location where the case file is stored.

If you are working in a SQL case and a menu item is grayed out, you may not have
permission to use that TextMap feature. Contact your system administrator for more
information.

To open a local case

1. On the File menu, click Open, and then select Computer.

If you do not have CaseMap Server, click File, and then click Open.

2. In the Select Local Case to Open dialog box, browse to the network directory folder to
locate the case you want to open and click on it.

3. In the TextMap Default Annotation Mode dialog box, click Close.

We recommend you leave the default setting of Manual Mode until you understand and
learn how to use Annotation modes. See About annotations.

To open a SQL case

1. On the File menu, click Open, and then click SQL Case.

You can also press CTRL + O to open a SQL case.

2. In the Connect to CaseMap Server dialog box, select the server you want to use in the
Server Name list.

3. In the Authentication area, select the type of authentication being used to access the
SQL case: Windows Authentication or Local User.

If you select Local User, then type in your user name and password.
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If you do not know which authentication method to use, contact your system
administrator.

4. Click Connect to continue.

5. In the Select a SQL Case to Open dialog box, click on the case you want, then click
Open.

The selected SQL case now opens in TextMap.

6. In the TextMap Default Annotation Mode dialog box, click Close.

We recommend you leave the default setting of Manual Mode until you understand and
learn how to use Annotation modes. See About annotations.

To open recently viewed cases

1. On the File menu, click Open, and then select Recent Cases.
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2. In the Recent Case area, click on the case to open. You can also right-click on the case
to be opened and from the Recent Cases submenu, click Open.

A pinned case, designated by a  identifies cases that were recently viewed and added
to the top of the Recent Cases list.

An unpinned case, designated by a  identifies cases that have not been recently

viewed. A thin horizontal line  separates unpinned cases from recently viewed
cases (pinned).

3. Optional: From the Recent Cases submenu, click Pin to list to place the selected case to
the top of the Recent Cases list.

4. Optional: Click Remove from list to remove a case from the Recent Cases list.

5. Optional: Click Clear unpinned cases to remove all cases from the Recent Case list.

To close a case

On the File menu, click Close to display to the Getting Started page.

Related Topics

About the Getting Started pane

About cases

Creating cases

Setting/changing case passwords

Setting/changing passwords

Local case passwords can be set for additional security and are distinct to each case.
Passwords provide another level of security to your TextMap files. 

When you first open a local case assigned to you, your password automatically defaults to
blank (no characters). Passwords can be left as blank or be up to 10 characters long.
Passwords are not case sensitive. If you forget your password, you need to call CaseMap
Technical Support to have them reset it for you.

We recommend that you apply case security at the network folder level. This allows users
to keep the default password set to blank, but ensures case security where the case is
saved. See Managing case staff.
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If you are opening SQL case for the first time, you must use the password provided by
your system administrator. You can change your SQL case password after your first login.

If you have TextMap installed on your machine, you can open the example case, Hawkins
v. Anstar, without a log on and start experimenting with TextMap in conjunction with the
Getting Started tutorial.

To set or change a case password

1. On the File menu, click Case Setup, and then click Change Password.

If you already have a password, type in the old password in the Old Password box.

2. In New Password box, type in your password.

3. In the Confirm Password box, type in the same password.

4. Click OK.

5. In the message, click OK.

The next time you open the case for which you set the password, you will see a Case
Log On dialog box. Select your name from the Staff Member list and enter your password
to access the case.

Related Topics

Opening cases

Creating cases

Adding users to cases

Managing case staff

Working with Cases

About cases

A TextMap case is created for each case that your organization works on. A TextMap file is a
database that stores all electronic transcript files related to the case. You can create as many
TextMap cases as needed to organize your cases. You can also store as many transcripts as
you need in each case.

TextMap cases are created using the New Case Wizard, which guides you through answering
all the questions needed to create the file. Some of your answers to the New Case Wizard will
display within the software application and on reports.

Case Name is the name of the case you are working on. This name is provided on the title
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bar within the application and on reports that you create.

Organization Name is the name of the organization that is working on the case. This name
is listed on reports that you create. TextMap retains the information entered in this box the
next time the New Case Wizard is run. If you type over the information in this field, your
new entry replaces the highlighted text.

File Name is the name of the file you open whenever you want to open the case. Make
sure that the case file name is unique and specific to the case on which you are working.
We recommend that you do not use any punctuation in the case file name except the
underscore. You cannot use apostrophes, colons, quotation marks, slashes, or asterisks.

Case files are identified by the column icon and have a file extension of .txmap.

TextMap can only have one case open at a time within an active application window. If you
need more than one case open, you can open other instances of TextMap. Case names display
in your Windows Title and Status bars so you can differentiate them while working.

TextMap cases are used by multiple staff. Store the case in a shared location on a network
drive so more than one staff member can work on annotating and summarizing depositions and
transcripts in the case file at the same time.

Related Topics

Creating cases

Adding users to cases

Entering case properties

Copying cases

Moving cases

Deleting cases

Creating cases

Each case you want to include in TextMap requires its own case file. A new case can be created
quickly so you can add case staff and initial case data within minutes. TextMap's New Case
Wizard provides you with a default new case template that accommodates most of your data
entry needs. The example case, Hawkins v. Anstar, uses a new case template.

The case file name is the name of the case database file that is saved to your machine or in a
network folder. The default location for case storage is the C:\Users\[User ID]\CaseSoft
\TextMap folder on your hard drive. For other users to access the file, it must be stored in a
network folder.

TextMap cases hosted on CaseMap Server (SQL cases) must be created by a system
administrator. For more information on how to create SQL cases, refer to your CaseMap
Server documentation.

New cases are not protected by passwords until you or other users create them.
Passwords automatically default to blank, so you would simply type a password and verify
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it, and then click OK to save it. If you forget your password, you need to call CaseMap
Technical Support to have them reset it for you. See Changing case passwords and
Managing case staff.

To create cases

1. On the File menu, click New, and then click Local Case to launch the New Case Wizard.

You can also open the New Case Wizard by clicking New Case on the Getting Started
pane.

2. On the New Case Wizard's Welcome page, click Next.

The Case Setup page opens.

3. In the Case name box, type in the case name.

We recommend that you do not use any punctuation in the case file name except the
underscore. You cannot use apostrophes, colons, quotation marks, slashes, or
asterisks.

4. In the Organization box, type in the organization name, and then click Next.

The Case File page opens. The File Name is automatically filled in with the case name.

5. In the File Name box, substitute underscores for spaces in the case name so that the
result is similar to: Plaintiff_vs_Defendant.
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6. Click Browse to navigate to the network folder where you want to save case files, and
then click Next.

The case file name is the name of the case database file that is saved to your machine or
in a network folder.

The default location for case storage is the C:\Users\[User ID]\CaseSoft\TextMap folder
on your hard drive. For other users to access the file, it must be stored in a network
folder.

7. In the Case Staff Support page, choose one of the following:

Click No if you are the only person accessing this case or if you want to add case staff
later in Tools > Case Staff.

Click Yes if you want to add case staff now. In the Name field type in your first and last
name.

If you click Yes, the Additional Staff members page displays so you can type in case
user names here.

8. Click Next to continue.

9. On the Completing the New Case Wizard page, click Finish.

Your new case automatically launches so you can begin working with it. A TextMap
message displays, stating that you do not have any transcripts in your case.

10. In the message, click OK.

You are now ready to add case users or import transcripts in your new case.
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Related Topics

About cases

Entering case properties

Copying cases

Moving cases

Deleting cases

Adding users to cases

Setting/changing passwords

Entering case properties

Once you have created a case, you can enter or edit general case details for reference
purposes or modify the files paths for exhibits and videos. The case file path is read only. 

For local cases, TextMap automatically imports exhibits to a subfolder where the case file is
stored. This folder may be on your desktop or on your network if other users are accessing
case exhibit files. For SQL cases, you can specify the network folder where you want to store
exhibit files. See Changing the exhibits folder path for SQL cases.

The video path is where TextMap looks for video files. The Case Video Paths dialog box allows
you to add additional file paths to search other locations on your system or network where
videos might be stored. See Changing video paths.

You cannot edit Case Properties for SQL cases. You can however change the Exhibits Path
by clicking the Modify button and selecting the network folder you would like to use.

To enter case properties

1. On the File menu, click Case Setup, and then click Case Properties.

2. In the Case Properties dialog box, verify the file path where the case is saved.
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3. In the Org. Name and Case Name fields, type or edit these entries.

4. Click OK to save your changes.

Related Topics

About cases

Creating cases

Copying cases

You can copy cases to create custom templates or save a copy of the case for backup
purposes. Cases must be closed before you can create a copy of them.

You also can create a replica copy using the Create Replica Wizard. A replica case can be save
to a file or a zipped file, and you can attach either to an email. See About replicating/
synchronizing cases.

To copy cases

1. On the File menu, click Open.

2. In the Open pane, select Computer or SQL Case as applicable to open the storage
location of the case to be copied.

3. In the Open Case dialog box, right-click on the case you want to copy, then click Copy.

4. Navigate to the folder where you want to save the copy, then right-click and click Paste.

5. Double-click on the case name to rename it or add the word "copy" to the case name.
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6. Click Open to launch the case copy.

7. If you do not want to work in the case at this time, click File and then click Close.

Related Topics

About cases

Creating cases

About replicating/synchronizing cases

Creating replica cases

Moving cases and files

Local cases need to be stored in network folders to ensure that other users can access them in
TextMap. When you move a case to another network directory location, you may risk losing
links from the case to attached files/documents. The case file and case documents, exhibits,
and videos are often stored in separate folders.

If you are planning to move a case file to another network folder, you need to change the file
paths to all linked documents, exhibits, and videos. You do not need to change the file path if
you imported an .xmef file where the path is using the %CASE_EXHIBITS_PATH%, and the user
copies the entire exhibits folder.

To ensure case integrity when moving local case file folders, use the Change Paths Wizard
accessible by clicking Case Tools > Linked Exhibits > Change Paths. See Changing exhibit file
paths and Changing video file paths. For SQL cases, see Changing the case exhibits path.

To check the integrity of linked exhibits and documents for your case, Verifying linked
exhibits.

Related Topics

Entering case properties

Linking exhibits to transcripts

Changing exhibit file paths

Changing the case exhibits path

Changing video file paths

Editing exhibits

Verifying linked exhibits
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Deleting cases

If you need to delete a case, you may want to to store a copy in an archive folder on your
network. Once you delete a case, you cannot retrieve it. All cases and content are erased from
TextMap.

To delete a case

1. On the File menu, click Open.

2. Navigate to the folder location where the case you want to delete is stored.

3. In the Open Case box, right-click on the case and click Delete.

4. In the Confirm File Delete box, click Yes.

The case and all its contents are now permanently removed from your network and no
longer accessible in TextMap.

5. Click Cancel or Close to close the Open Case window and return to TextMap.

6. In the Getting Started pane, right-click on the case in the Open a case pane and click
Remove from list.

Related Topics

Creating cases

Copying cases

Adding users to cases

Transcript review often requires a team of staff to help review depositions and transcripts for a
case. Having a TextMap license does not allow users to open cases. Staff must be added as
users to a case before they can access it within TextMap. New users can be added to a case at
any time.

You can add new case staff even if you did not create the TextMap case. Although TextMap
suggests typing a first name, followed by last name, your organization can set standards for
how staff members’ names should be entered. You must have a case open to assign case staff.

There is no limit to the number of users a case can accommodate, though we suggest you keep
user access limited to case staff to preserve the integrity of your case data.

For more information on how to create SQL cases, refer to your CaseMap Server
documentation. You cannot add, modify, or delete users for SQL cases in TextMap.
Managing SQL case staff is done in the CaseMap Admin Console.
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To add case users

1. On the File menu, click Case Setup.

2. Under the Staff Administration area, click the Edit Staff link to open the Case Staff
dialog box.

The Case Staff dialog box opens. Notice that the user name you used to log on already
displays in the Case Staff box.

3. Click Add.

4. In the Add Staff Name box, type in the user name, and then click OK.

A message states that the password for this user is <blank>.

Click the Modify button to edit the user name.

5. In the message about the blank password, click OK.

The Case Staff dialog box now lists the new staff member. 

6. In the Case Staff dialog box, click Close.

The new user can set a password as soon as he or she logs into the case.

You can continue adding users to the case in this same manner any time.

Related Topics

Creating cases

Deactivating or deleting users

Setting/changing passwords

Managing case staff
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Deleting users

If you need to permanently remove a user from a case, you can simply delete them. Deleted
users are no longer able to open the case.

To delete a user

1. On the File menu, click Case Setup.

2. Under the Staff Administration area, click the Edit Staff link to open the Case Staff
dialog box.

3. In the Case Staff dialog box, click on the user you want, then click Delete.

4. In the message to delete the user, click Yes.

The user is now permanently deleted from the case.

5. Click Close when you are finished.

Related Topics

Adding users to cases

Managing case staff

Creating Case Issues

About case issues

If you are using TextMap and CaseMap together you can import your issue outline from a
corresponding CaseMap case and then create categorizing issues, like Background, that are
only used in the corresponding TextMap case. If you are using TextMap as a stand-alone
transcript summary tool, you can quickly create an issue outline from scratch.

In TextMap, all issues are initially set to the default color yellow. You can assign each issue a
color so that it can be easily identified when scrolling through the transcript. For instance, you
could color code all research items red to be easily recognizable. You can also move topics
around in an issues list, arranging issues in a different order. And you can create sub-issues or
child issues of the parent issue.
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Once issues are created and coded by color, you can issue-code annotations. Annotations can
be linked to one or more case issues. See Creating annotations. Color-coded passages display
in reports in color. Reports can be filtered so only annotations associated with specific issues
are included. See Printing annotation reports.

When searching transcript annotations, you can narrow your search by selected issues in the
Search pane. See Running full-text searches.

Related Topics

Creating case issues

Importing case issues

Deleting case issues

Creating case issues

New case issues are automatically assigned the default color of yellow. You can change the
default color in the Color list in the Case Issues dialog box.
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Organize your case issues by adding sub-level issues to parent or primary level issue. Color-
coding issues helps you identify annotations that are linked to each issue, especially when
there overlapping annotations in a particular section of a transcript. See Linking issues to
annotations.

To create case issues

1. On the File menu, click Case Setup, and then click Case Issues.

2. In the Case Issues dialog box, click Add .

3. In the New Issue dialog box, type in the name of the issue, then click OK.

The new issue displays in the TextMap Case Issues list in the default issue color of
yellow.

To edit or rename an issue, click on the issue and then click the Rename icon .

4. Continue adding case issues until the issues list is complete.
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You can return and add new issues here at any time.

5. Click on an issue and then click the Demote icon  to create a sub-level or child issue
like Background.

Click the Move Up, Move Down, Promote or Demote icons to organize the issues list.

If you right-click on an issue in the Case Issues dialog box, a submenu displays with the
same options available on the Case Issues toolbar. 

6. Click on an issue and then click on the arrow next to the Color button .

7. In the color palette, click on the new color you want to use for this issue.
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All annotations linked to this issue will display in the transcript in the selected color.
Transcripts with overlapping annotations will display color bars to the right of the
transcript for each linked issue, so you can easily identify where overlapping annotations
occur.

8. Click Close when you are finished.

To change the default issue color

1. On the File menu, click Case Setup, and then click Case Issues.

2. In the Color list, under Default Issue Color, click on the color you want.

3. Click Close to save your changes.

Related Topics

About case issues

Importing case issues

Deleting case issues

Importing case issues

If you are using TextMap and CaseMap together you can import your issue outline from a
corresponding CaseMap case. You must have the corresponding CaseMap case open in order
to complete this process.

If you have already imported issues from the CaseMap case into TextMap, any changes in the
CaseMap issue hierarchy will not be synchronized in the TextMap case issue list until you re-
import the CaseMap issues into the TextMap case. During the import, TextMap tries to match
the issues already imported from CaseMap using issue short names. The import will only add
new issues in TextMap.

If you rename an issue that was imported from CaseMap, it will not be sent back to CaseMap
as a linked issue. When you use the Send to CaseMap utility, TextMap only recognizes linked
issue names that are identical to the names created in and imported from CaseMap. If you
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change the name of an imported issue it will not be recognized or linked to your fact record in
CaseMap. TextMap issue names must match the short name of a CaseMap issue (no spaces).

Once case issues are imported, you will need to change the issue color for each so linked
annotations can be distinguished by issue color when viewing the transcript.

Importation of issues from CaseMap is a one-way street. Issues added in CaseMap and
linked to annotations in TextMap will be sent back to CaseMap as Linked Issues on new
facts created from annotations in TextMap. TextMap-generated issues are not recognized
by CaseMap.

The import/export structure is useful, especially if you create issues in TextMap like
Background or Possible Impeachment that are not related to the legal claims set forth in
CaseMap's Issues spreadsheet. In Annotation Digest reports generated in TextMap, you
can filter for annotations linked to any of the TextMap issues — those imported from
CaseMap and those created in TextMap.

If you want to ensure your TextMap issues are sent to CaseMap as linked issues in a new
fact record, then add new issues you want in your TextMap issue outline into the CaseMap
Issues spreadsheet first. Next import issues from CaseMap into your corresponding
TextMap case. Any new CaseMap issues will be imported into TextMap and added to the
bottom of the case issues outline.

To import case issues

1. On the File menu, click Case Setup, and then click Case Issues.

2. In the Case Issues dialog box, click the Import icon .

3. In the message  box, click Yes.

Apply issue colors to each imported case issue as needed.

4. Click Close when you are finished.

Related Topics

About case issues

Creating case issues

Deleting case issues

Linking issues to annotations

Once you have created your case issues list, you can issue-code any existing annotations
already applied to your transcripts.
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However, it is also easy to link issues to annotations while you are annotating. See Creating
annotations.

To link an issue to an existing annotation

1. In the Annotations pane, double-click on the annotation for which you want to apply an
issue.

2. In the Edit Annotation dialog box, click the Linked Issues tab.

3. On the Linked Issues tab, select the check boxes for each issue and/or sub-issue that
applies to the annotation.

The Linked Issues tab automatically displays the last issue selections to minimize issue
selection when creating annotations.

Click on the Issues Option button  and select one of the following:

Select All Issues to place a check mark beside all issues

Deselect All Issues to remove the check mark beside all selected issues

Manage Issues to open the Case Issues dialog box.

If an annotation is linked to more than one issue, the color of the issue that's the
highest in the issue outline hierarchy (that is not the default color) will be applied to the
annotation.
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4. Click OK to save your changes.

The selected issues now display in the Linked Issues column in the Annotations pane.

Related Topics

About case issues

Creating case issues

Creating annotations

Deleting case issues

If you want to delete a case issue, you first need to verify whether the issues is currently linked
to any transcript annotations. If the issue is linked to annotations, then you must transfer the
annotations to another case issue before deleting the issue you want removed from the issue
list. 

This process is managed by the Delete Issue Wizard, which offers you the option of moving the
links to an existing issue or deleting the annotation links to the case issue you want to delete.
The wizard displays how many annotations are linked to the issue.

Deleting a case issue linked to an annotation will not delete the annotation. The annotation
color will then change to the selected default color.

You cannot delete a parent issue that has sub-issues. You must first move any annotation links
to another issue and then delete the sub-issues.

To delete a case issue

1. On the File menu, click Case Setup, and then click Case Issues.

2. In the Case Issues dialog box, click on the case issue you want to delete.

3. Click the Delete icon .

4. In the message box, click Yes to delete the issue.

If the issue is linked to annotations, the Delete Issue Wizard launches so you can move
or delete annotations links.

To move links to another issue

1. On the Welcome page, click Move links to another issue, then click Next.

2. On the Select New Linked Issue page, click on the issue for which you want to
transfer the links, then click Next.
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3. On the Confirm Delete Issue page, verify the information, then click Finish.

4. In the Annotations pane, verify that the annotation is now linked to the new issue
selected.

To delete annotation links
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1. On the Welcome page, click Delete annotation links, then click Next.

2. On the Select New Linked Issue page, click on the issue for which you want to
transfer the links, then click Next.

3. On the Confirm Delete Issue page, verify the information, then click Finish.

4. In the Annotations pane, verify that the annotation is now linked to the new issue
selected.

5. In the Case Issues dialog box, click Close.

Related Topics

About case issues

Creating case issues

Importing Data

About importing data

TextMap organizes imported transcripts and depositions into a centralized electronic case
where you and other case staff can share comments, insights, research ideas, notes, links, and
documents. Once the transcripts and documents are added to a TextMap case, they are in one
location that makes it easy for you to find topics of interest, mark interesting passages, and link
to files. There is no limit to the number of files or size of files that you can import into a TextMap
case.

When transcripts and documents are imported, TextMap tracks words and their locations in a
list called a case index. The case index alphabetizes words in all of the transcripts and also
contains hyperlinks to the locations in the transcript where the words display. Not all words are
included in the case index: the most common ones, such as and, or, the, and but are not in the
case index. See About the case index.

TextMap locates the first date in a transcript or document and uses that date in the Transcript
Import Preview dialog box. TextMap recognized dates in the DD/MM/YYYY format. For example,
TextMap recognizes both 01/20/99 and January 20, 1999.

The most common way to import information into TextMap is by importing a file in an ASCII text
file. This allows the line numbering and page numbering of the original transcript to be the
same as the transcript inside TextMap. If you are receiving transcripts in a Binder format, you
can open the file and save it as a text file for importing into TextMap.

You can also import the following file types:

.mdb (Sanction)

.pcf (LiveNote Portable Case File)
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.pdf (Adobe Portable Document Format)

.ptf (LiveNote Portable Transcript File)

.txt (Amicus) 

.txt (Summation)

.xmef (TextMap Evidence Format)

.xmptf (TextMap Portable Transcript File)

TextMap does not directly import files provided in RealLegal E-Transcript Binder Format
(.ptx). Open files in .ptx format using Legal Binder or Viewer, and then save the transcripts
as text (.txt) files. You can then import the new .txt files. Formatting does not change in
this process.

TextMap also has a feature that allows you to import information from a software Clipboard to
TextMap. This allows you to import information from many file types into TextMap. See 
Importing files from a Clipboard.

You can also update or append existing transcripts in the case. See Updating or appending
transcripts.

To learn more about importing other data, see the following topics:

Importing annotations

Importing data from an iPad

Importing exhibit packages

Updating or appending transcripts

Batch importing cases

About CaseViewNet

Related Topics

Importing transcripts

Importing files from a Clipboard

Updating or appending transcripts

Batch importing cases

Importing transcripts

Once you've created a case, you must import transcripts into it before you can begin to search
them to make annotations or cull out facts to send to CaseMap. Transcripts display in the main
Transcript window (center pane) with page and line numbers displaying in the left margin. The
left margin also displays annotation note icons and linked attachments (paperclip icon). Any
annotated text that overlaps previously annotated text displays with colored bars to the left of
the transcript. See About annotations and Creating annotations.
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When importing transcripts, TextMap scans the first two pages of a transcript to locate a date.
TextMap uses the first date it finds as the transcript default date and displays it in the
Transcript Import Preview dialog box. This date can be edited if needed. To turn on page
number display, click File, click Options, and then click the Transcripts tab. On the Transcript tab,
select the Show page number in gutter area check box.

During the import process, you can select the Advanced option in the Transcript Import Preview
dialog box to specify any pages to skip as well as set the first page number. The transcript
preview automatically displays the page(s) shaded indicating the page(s) are skipped.



Using TextMap 73

© 2017 LexisNexis. All rights reserved.



TextMap74

© 2017 LexisNexis. All rights reserved.

The creation date of each imported annotation matches the original date in LiveNote, rather
than the date and time it was imported.

TextMap also accounts for front and back unnumbered pages during transcript import. Cover
sheets, initial pages, end pages and appendices do not affect the numbering of testimony
pages. If TextMap detects unnumbered pages prior to the import, you can adjust the number of
pages or accept the automatic handling of the unnumbered pages provided by TextMap.

Headers and footers are automatically left out of imported transcripts. For example, if a court
reporter uses the bottom two lines of every page for a name and office number, then the actual
testimony imported is 23 lines per page instead of 25.

Once a  transcript is imported, you can specify a new first page number. Any annotation(s) in
the transcript prior to the number change contains the exact text as prior to the page
numbering change. 

You can also adjust the font size and style for better viewing in the TextMap window. The
selected font size and style is applied to all case transcripts. See Changing transcripts fonts.

When importing transcripts into a case, the transcripts should be full-sized, single page,
and OCRd for best results.

TextMap displays a message when the format of the file you are importing doesn't appear
to be in a standard court reporting electronic transcript format. If you continue with the
import the page breaks and line numbering probably will not match the original document.
You're encouraged to discontinue the import and to contact your court reporter to request
the transcript in either Amicus® or Summation® format, standard transcript output formats
from court reporting software.

When importing transcripts into a SQL case, you will not be able to run searches (word
searches or advanced queries) until the indexing process is complete. A message box
displays to indicate processing status and completion. During the import process, you are
able to review and annotate transcripts. However, you and other case staff cannot delete
transcripts or synchronize cases. Likewise, you cannot import transcripts while another
user is synchronizing a replica case with the master case, or is in the process of deleting
transcripts from the case.

To import transcripts

1. On the Home ribbon, click Import Transcript.

You can also click Import on the File menu, and then click Import Transcripts.

2. In the Select One or More Transcripts to Import dialog box, navigate to the folder
where the transcript files are stored.

3. Select the transcripts you want to import and then click Select.

If you want to import more than one file at a time, press the CTRL key while selecting
the files you want to import.



Using TextMap 75

© 2017 LexisNexis. All rights reserved.

The Transcript Import Preview dialog box displays. 

The Name box contains the file name of the transcript that you are importing.
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4. In the first Date/Time box, notice that the date is automatically filled in for you.

5. In the second Date/Time box, type  in the time, then select AM or PM from the list.

Notice that the Include Date & Time box is selected by default. Clear this check box if you
do not want the date/time to display in the Transcripts pane along with the transcript
name.

6. In the Comments box, type in any relevant information about the transcript.

7. In the Transcript Preview box, scroll to verify that the transcript displays properly.

8. Click the Advanced button to modify page numbering, exclude pages, and format details.

9. Click OK to continue.

The Transcript Import Preview dialog box is displayed for each transcript you are
importing.

10. In the Transcript Import Preview dialog box, repeat steps 4-7 for the next transcript.

Notice how a progress filter displays while the case index is created or updated.

Imported transcripts now display in the Transcripts pane with the first transcript content
displaying in the TextMap window.

Related Topics

About importing data

Importing files from a Clipboard

Updating or appending transcripts
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Importing annotations

The Import Annotations Wizard allows you to import annotations from a comma delimited text
file (.csv) file saved from a Microsoft® Excel spreadsheet without having to do it manually. The
Import Annotations Wizard can import multiple annotations into multiple, existing transcripts.
The wizard imports page/line number and note designations, and allows the ability to link
issues to imported annotations so they can be tagged.

In order to successfully import annotations, the .csv file's columns must be in the following,
specified order: Transcript Name, Page From, Line From, Page To, and Line To. The file may also
include the Notes and Issues column (optional). This list of issues should be separated by
semicolons. The wizard's Welcome page includes a link to view a sample import file (shown
below).

If you import the same .csv file twice, you will duplicate content in the case. The Import
Annotations Wizard will display an Import Errors page if some annotations fail to import.
We recommend that you save this information to a file, resolve the errors, and then import
the skipped annotations as a separate .csv file.

If an annotation in has "Unknown" listed in the Created By column, it may be an imported
annotation. These annotations can be assigned to a case user after the import. See 
Changing annotation owner status.

To import annotations into existing transcripts

1. On the Home ribbon, click More Import, and then click Import Annotations.

You can also click Import on the File menu, and then click Import Annotations.

2. When the wizard launches, click Next.
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3. On the Import File page, click Browse to locate the file you want to import.
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4. After the selected file and path of the file(s) being imported is displayed in the wizard,
select/deselect all applicable options (e.g., First line contains field headers), to indicate
what (i.e., notes, issues) is in the file(s) being imported):

First line contains field headers -- The first line of the import file contains the field
headers (i.e., Transcript, Pg From, Ln From, etc.) and not the first annotation.

Includes Notes field -- Import file includes a field to list the note(s) associated with each
annotation.

Includes Issues field -- Import file includes a field to list the issue(s) associated with
each annotation.

These options must match what is in the import file in order for the annotations to
import correctly. If a check box (e.g., Issues or Notes) is not selected, it will not be
displayed in the Import Preview window.

5. Click Next to display the Import Preview page.

6. On the Import Preview page, review the annotations selected for import, then click
Next to start the import process.
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Since the Include Notes field option was not selected in Step 4, only Issues are
displayed in the Import Preview window.

If any annotations cannot be imported (e.g., transcripts with the same name), the
wizard displays an Import Errors page listing all annotations that did not successfully
import.
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7. Optional: Click the Save button to save a list of the import error list for future reference.

8. Click Next to continue.

9. On the Completing the Import Annotations Wizard page, review the number of
imported annotations and those skipped due to errors, then click Finish.
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The imported annotations now display in the Annotations pane. When you click on an
annotation in the Annotations pane, the transcript displays the annotated content with
the applicable issue code color, if issues were included were included in the .csv file.

Related Topics

About annotations

Creating annotations

Importing data from an iPad

The importing process applies any edits you made in the TextMap app for iPad to the master
case in TextMap. You must have the corresponding case open in TextMap before you can import
updates from the iPad. Only one case user at a time can import updates.

An import confirmation indicates how many new issues and annotations will be added. The
message also lists how many annotations have been edited or deleted and how many
transcripts in the case are affected by the changes.

During the import process, TextMap will recognize if your updates have already been applied.
See the iPad Import  Considerations table for details on how TextMap processes updates in the
master case.
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You can re-export the case to your iPad if you want to access any case user updates or new
transcripts added to the case. Otherwise, you can continue to work on the transcripts you
already have on your iPad.

To view data import considerations

Reference the following table for considerations when importing case updates from your
iPad.

iPad Import Considerations

General Only one case user at a time can import updates. TextMap
displays a message if another case user is currently importing
updates from the iPad or synchronizing a replica with the master
case.

You can import updates from your iPad as many times as you
want. TextMap will recognize any case data that was already
updated or skipped during a previous data transfer.

* You may want to email the case to your iPad again if you want
access to all case user updates or any new transcripts added to
the case.

Case updates made on an iPad can be imported into a replica
case. TextMap will recognize that the case updates from the iPad
were made in the replica when synchronizing the replica with the
master case.

See About replicating and synchronizing cases.

After a significant number of updates are made on your iPad, it's a
best practice to import your updates into the master case. This
ensures that you and other case users have access to the latest
case data at all times.

You can choose to skip importing previous updates if the latest
update includes all the data you want.

Case Issues New parent (top-level) issues created on an iPad are added to
the bottom of the TextMap's issue outline.

Annotations and
Notes

Annotations edited on the iPad but were deleted in the master
case will be imported back into the master case. TextMap counts
these as new annotations and not edited annotations.

Annotations created on the iPad will be skipped during the import
if the transcript has been deleted from the master case. The
number of skipped annotations displays in a message during the
import.

Annotations deleted on the iPad will be deleted in the master
case, even if the original annotation was edited. The total number
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iPad Import Considerations

of annotations deleted across all transcripts will be listed in the
import message.

Any annotation issue links that are deleted on the iPad will be
deleted in the master case during the import.

Any linked issues added in the master case since case data was
exported will be retained in the master case.

Existing annotations with notes updated on the iPad will override
notes made in the master case.

To import TextMap app updates from your email

1. Click More Import on the Home Ribbon, and then click Import from iPad.

You can also click Import on the File menu, and then click Import from iPad.

2. From the Select TextMap Mobile Import File dialog box, open the email that contains
the case updates that you want to import from the TextMap app.

3. Open the master case in TextMap, if it is not already open.

4. Double-click on the email attachment to open it.
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5. In the Opening Mail Attachment dialog box, click Open.

Click Save if you want to save the case updates to a file to import later, then close the
email.

6. In the Import Updates from iPad dialog box, review the issues and annotation updates,
then click OK.

The imported data now displays in your transcripts in the master case.

To import updates saved to a file

You can also import case updates directly from the .xmmi file, if you chose to save the
attachment to a folder to import at a later time. If a TextMap case is not already open, a
dialog box displays for you to browse to and select the existing or recent case you want to
open. Once the case is open in TextMap, the import process automatically starts. If the
corresponding TextMap case is already open, click OK in the message box to initiate the
import.

1. On the File menu, click Import and then click Updates from iPad.

2. In the Select TextMap Mobile Import File dialog box, navigate to the folder where the
import file is stored.

You can also right-click on the file in the folder where it is stored and then click Import
into TextMap or simply double-click on the file to initiate the import.

3. Select the import file and then click Open.

4. In the Import Updates from iPad dialog box, review the issues and annotation updates,
then click OK.
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Related Topics

About the TextMap iPad app

Exporting data to an iPad

Importing exhibit packages

TextMap Exhibit Packages (created by TextMap® Exhibit Linker) include a transcript, hyperlinks
to exhibits mentioned throughout the text, and the linked exhibit documents. You import an
Exhibit Package file (*.xmef) just like any other transcript. All the exhibits and exhibit hyperlinks
in the transcript are available instantly.

When you import an Exhibit Package file (*.xmef), the following occurs:

It creates a folder and is stored in its own folder.

If the name of the transcript is longer than 80 characters, the folder created will also be
truncated at 80 characters.

When TextMap imports a transcript with a name of one that already exists, it and the
associated folder names are made unique by applying a number to the end.

Invalid characters are not allowed in the transcript name, and will be removed.

You can also import TextMap Exhibit Packages (*.xmef files) with linked exhibits into a SQL
case. During the import process, TextMap displays a message for you to select the exhibits
path folder for the case, if it has not already been set.

Exhibit files should be saved to a network folder to ensure that all case users have access to
the files. You can also set this path in the Case Properties dialog box, if you have permissions
to do so. See Changing exhibits file paths. If you choose not to set the exhibit folder path
during the import, the transcript will be imported into the SQL case without the linked exhibit
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files.

To import exhibit packages with linked exhibits

1. On the Home ribbon, click Import Transcript.

You can also click Import on the File menu, and then click Import Transcripts.

2. In the Select one or more Transcripts to Import dialog box, select the exhibits package
that you want to import, and then click Select.

3. In the Transcript Import Preview dialog box, review the transcript information and type
in any comments you want to track regarding the imported files.

TextMap searches the transcript and uses the first date it locates to automatically fill in
the Date field. You can modify this date, if necessary.

4. Click the Advanced button if you want to modify page numbering or review transcript
format details.

5. Click OK to continue.

When the import process is complete, the imported transcript displays in the Transcripts
pane and the exhibit files are copied into the case exhibits folder.

4. In the Navigation pane, click the Exhibits and Video button to display linked exhibits
and other documents included in the exhibit package.
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Related Topics

About exhibits

Using TextMap Exhibit Linker

Changing exhibit file paths

Importing binders

Using the TextMap Binder Import Utility, you can convert and import a binder case from
RealLegal Binder directly into your TextMap case file along with any case exhibits (including
linked exhibits) or synched video files. The utility supports importing one binder case at a time.

Once you have imported the binder case into TextMap, you can create a case file from it.

To import a binder case

1. Double-click on the TextMap Binder Import Utility icon to display the TextMap Binder
Import Utility dialog box.

2. Next to the Source Binder case field, click Browse to navigate to the network folder
where the binder file (.pxl) you want to import is stored.

3. In the Select a Binder case dialog box, click on the binder file you want to import, then
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click Open.

4. Next to the Output TextMap case folder field, click Browse to locate the network folder
where you want to save the case file (.txmap).

5. In the Browse For Folder dialog box, locate the network folder you want to use, then
click OK.

6. In the Organization name field, type in the name of your organization.

7. Select the Index transcripts during import check box if you want this option.

8. Click the Import button to import the file into your TextMap case.

9. In the message box verifying the import is complete, click OK.

The imported case now displays in TextMap.

To generate a .pcf file

1. Double-click on the TextMap Binder Import Utility icon to display the TextMap Binder
Import Utility dialog box.

2. Next to the Source Binder case field, click Browse to navigate to the network folder
where the binder file (.pxl) you want to import is stored.

3. In the Select a Binder case dialog box, click on the binder file you want to import, then
click Open.

4. In the Output area, click Generate PCF.



TextMap90

© 2017 LexisNexis. All rights reserved.

5. Next to the PCF File field, click the Browse button to navigate to the network folder
where you want to save the converted binder case file (.pcf).

6. In the File name field, type in the name of the filed, then click Save.

7. Click the Import button to convert the binder case to the .pcf file format.

8. In the message box verifying the import is complete, click OK.

You can now import the .pcf into TextMap and create a new case with it.

Related Topics

Installing the TextMap Binder Import Utility

Importing files from a Clipboard

Importing transcripts using a Clipboard is not used as often to import files as the Import File(s)
method. However, this feature allows you to import content from many software programs such
as Microsoft® Word or Outlook, or any text file. It's a great way to add complaints, research
copies from the Internet, or even interview notes.

First you must open the electronic file in its original program and copy the contents onto an
electronic Clipboard. Then, you import the contents into your TextMap case. When importing
content, TextMap limits text to 25 lines per page, which is a common transcript format, but may
not match the formatting of the original document. If you send a fact from this type of text file
to CaseMap, the page/line reference will not the that of the original document.

If you try to save a PDF to a text file using the Save as Text command, the formatting of
the original will not match the formatting of the original text file. The discrepancy in content
will be detrimental in any situation where you are referring to the original file.

To import files from a Clipboard

1. Open the electronic file in its native software program, such as Microsoft Word.

2. Press CTRL+A to select all text within the document.

3. Press CTRL+C to copy the selected text to the Clipboard.

4. Close the file and the software program.

5. In TextMap, on the Home ribbon, click More Import, and the click Import from
Clipboard.

You can also click Import on the File menu, and then click Import from Clipboard.

6. click More Import on the Home ribbon, and then click Import from Clipboard.
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The Import from Clipboard dialog box opens.

7. In the Name box, type in a name for the file, then click OK.

8. Select the Word Wrap check box if you want the text to wrap within the dialog box.

9. In the message about file format, click OK.

The Transcript Import Preview dialog box opens.

The Name box in this dialog box is filled with the contents of the Name box on the Import
from Clipboard dialog box. The Date/Time field is also automatically filled in.

10. In the first Date/Time box, notice that the date is automatically filled in for you.
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11. In the second Date/Time box, type in the time, then select AM or PM from the list if that
information is applicable.

Notice that the Include Date & Time box is selected by default. Clear this check box if you
do not want the date/time to display in the Transcripts pane along with the transcript
name.

12. In the Comments box, type in any relevant information about the file content.

13. In the Transcript Preview box, scroll to verify that the file content displays properly.

14. Click OK when you are finished.

15. In the Transcripts pane, verify that the letter now displays with case transcripts.

The file's content displays in the Transcript window and displays by line and page
number like transcripts do.

Related Topics

About importing data

Importing transcripts
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Updating or appending transcripts

You have the option of either updating or appending an existing transcript. The steps for
performing either option are nearly identical:

If you update an existing transcript, TextMap updates the existing transcript and creates a
backup of the original transcript with a draft that is appended to the original transcript
name.

If you append an existing transcript, TextMap appends the existing transcript and creates a
backup of the original transcript renamed with "[Draft]" appended to the name. The original
draft transcript will retain the original transcript ID.

The backup and the updated/appended copy will both display in the Transcripts pane. You can
later delete the backup draft by selecting it in the Transcript pane and then clicking Delete
Transcript on the Transcript menu.

To learn about updating rough transcripts

If a rough copy of a transcript was already imported into the case, you can easily update it
with the final transcript. TextMap creates a backup copy of the transcript when updating it.
The name of the transcript will be the same, but with [DRAFT] appended.

Any annotations applied to the rough copy will be transferred to the final transcript. If
TextMap cannot locate the exact transcript location for an annotation, it will label it as an
orphaned annotation. Orphans occur when the annotation text or the text surrounding the
annotation has changed significantly. This change can be actual, textual change or a large
change in formatting. TextMap moves orphaned annotations to the top of the transcript
(Page 1, Line 1). The note section includes the original page and line number of the
annotation to help you place the annotation manually. Move annotations by using the Move
Annotation option on the Annotation menu.

Any redactions applied to the rough copy will be transferred to the final transcript. TextMap
cannot apply redactions to the final transcript if there are spelling errors, or if there is
information removed from the transcript text. 

In the event that you have multiple rough transcript files that are all part of the same
transcript, TextMap also offers the option to combine these files into a single transcript by
appending the later testimony to an existing transcript. In this instance, choose the Append
to Transcript option from the right-click menu.

If you are updating/appending a transcript that is assigned to one or more transcript
groups, the updated and DRAFT transcripts will both display within the transcript
group(s). If the rough transcript is assigned to a group that no longer exists, then the
rough and final transcripts will display in the Transcript List under Unassigned. See 
Creating transcript groups.

To update or append an existing transcript

1. In the Transcripts pane, right-click on the transcript you want to append.
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2. On the submenu, click one of the following:

To update a transcript

a. Click Update.

b. In the Select Updated Transcript File dialog box, navigate to and select the
updated transcript, and then click Select.

c. In the message box to continue, click Yes.

d. In the Transcript Import Preview box, confirm the name of the transcript, and click
OK to continue.

e. In the message box for backups, click OK.

f. Click OK on the subsequent message box(es) to complete the transcript update
process.

The updated transcript displays in the Transcript pane, identified by the word
[DRAFT] appended at the end of the name.
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To append to a transcript

a. Click Append to.

b. In Select Transcript File to Append dialog box, navigate to and select the updated
transcript, and then click Select.

c. In the Transcript Import Preview dialog box, modify any transcript information if
needed, such as the date and time, and then click OK.



TextMap96

© 2017 LexisNexis. All rights reserved.

d. In the transcript message, click OK.

The original transcript now displays in the Transcript List with [DRAFT] appended to
the name. The updated or appended transcript also displays.

Related Topics

Importing transcripts

About CaseViewNet
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Batch importing cases

The Batch Import Cases Wizards assists you in importing Portable Case Format (.pcf) files into a
TextMap case. TextMap will create a new case for each of the files included. TextMap saves
each case to the same folder as the original .pcf file and uses the .pcf file name for each new
TextMap case created.

You have the option to skip building the word indices to reduce processing time. You may want
to choose this option when importing large cases. TextMap can build the word indices anytime
after the cases are created.

To bulk import cases

1. On the File menu, click Batch Import Cases.

2. In the message box to close the case, click OK.

The Batch Import Cases Wizard launches.

3. On the Welcome page, click Next.

4. On the Select Portable Case Files page, click Add Files.
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If you want to import more than one file at a time, press the CTRL key while selecting
the files you want to import.

5. In the Select one or more cases to import dialog box, navigate to the folder where the
.pcf file is saved.

6. Select the file you want to import and then click Open.

To remove a file from the import, select it in the Selected Portable Case Files box and
click Remove File.

To remove all files from the import, click Remove All.

7. Click Next to continue.

8. In the Word Index Options dialog box, choose whether to build a word index for each
case, then click Next.

Yes, I want to build the new word index.

No, I do not want to build the word index.

9. In the Cases to Create dialog box, review the file location of the case files, then click
Next.

10. In the Ready to Create Cases dialog box, review the number of cases you are bulk
importing, then click Next.

11. In the Import Complete dialog box, review the number of cases successfully imported.

12. Select the View detailed result check box to view more details about the import, then
click Next.

13. In the Detailed Results dialog box, scroll to view each case's details.
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14. Click the Save to File button to save this information to a .csv file.

15. In the Completing the Batch Import Cases Wizard, click Finish.

You can now open the cases in TextMap.

Related Topics

About importing data

Importing transcripts

Importing exhibit packages

Using CaseViewNet Realtime

About CaseViewNet

CaseViewNet® is a free transcript viewer made by Stenograph, LLC, and it is automatically
installed when you install TextMap.

CaseViewNet provides interactive real-time access to testimony through a court reporter’s
private WiFi network or a wired connection. CaseViewNet updates all edits during a session. 
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CaseViewNet and TextMap integrate so that you can instantly import a transcript into TextMap
during a deposition and start annotating and issue linking. You can even start CaseViewNet by
clicking on TextMap's toolbar. When you're ready to import the transcript to TextMap just click
the Send to TextMap button.

CaseViewNet software is free. There are no tokens to purchase, no royalties to pay, and no
compliance issues to worry about. You are free to concentrate on the important testimonial
matters at hand.

For more information about CaseViewNet, click here. Customer Support for CaseViewNet is
provided by Stenograph. For TextMap-related questions, call CaseMap Customer Support.

Learn what you  can do with CaseViewNet

CaseViewNet is intuitive and easy to learn. It has its own Help system and customer support
through Stenograph.

Here is a list of what you can expect to do using CaseViewNet:

Mark testimony for quick and easy review.

Search testimony for a question, answer, word, phrase, marked lines, time or notes.

Use Quick Find to locate questions, answers, marked lines and notes.

Write on-screen notes linked to specific testimony.

Use Quick Issues commands to identify specific testimony for on-screen review.

Locate time-specific testimony segments.

Generate printed reports of annotated text for printing and save information to file.

Save the realtime transcript as a CaseViewNet, LiveNote, ASCII text, Summation text,
Amicus text or TextMap portable transcript file.

Instantly export the transcript to a TextMap case by clicking Send to CaseMap button.

Find a CaseViewNet court reporter

CaseViewNet client viewer accepts serial input from any court reporter capable of sending
realtime to viewers such as CaseView® II, LiveNote®, Summation®, and others. It uses the
same serial cables, splitters, and adapters traditionally used for realtime court reporting.

Case CATalyst users with a CaseViewNet certificate can distribute realtime to CaseViewNet
wirelessly. Client computers will receive the entire transcript, even if they arrive late.
CaseViewNet's RapidRefresh™ instantly updates all edits, including globals, on clients’
computers so your realtime looks better. This process allows you to eliminate cables,
splitters, adapters, and the time it takes to connect them.

Ask the reporters you normally use if they can provide realtime service using CaseViewNet.
Reporters who have Stenograph's Case CATalyst reporting software can add CaseViewNet
capability as an optional annual license.

You can find court reporters who are licensed to provide CaseViewNet realtime output via
network connection allowing for wired/wireless connection and instant refreshing of the
transcript. Search the Stenograph licensed CaseViewNet reporter directory.

Get a free download of CaseViewNet

CaseViewNet automatically launches when you click on the Realtime toolbar button. If

http://www.stenograph.com/v3minisplash.aspx?id=caseviewnetatty
http://www.stenograph.com/cgi-bin/search.pl
http://www.stenograph.com/pages.aspx?docid=552&id=
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TextMap can't find CaseViewNet a message displays with a link to the Stenograph website
for information about CaseViewNet and a free download.

Related Topics

Sending a transcript to TextMap

Updating or appending transcripts

Sending a transcript to TextMap

Sending a transcript from CaseViewNet to TextMap is easy. If you are importing a rough
transcript using CaseViewNet, you can begin annotating the transcript as soon as the import is
complete. Later, you can update the rough or draft transcript with the final transcript. TextMap
creates a backup copy of the transcript when updating it. The name of the transcript will be the
same, but with [DRAFT] appended to it. Any annotations applied to the rough copy will be
transferred to the final transcript. See Updating or appending transcripts.

You can send a transcript two ways:

On the File menu in CaseViewNet, click Send to TextMap.

On the CaseViewNet toolbar, click the Send to TextMap button .

Related Topics

About CaseViewNet

Updating or appending transcripts

Working with Transcripts

About transcripts

Once transcripts are imported into a case, you can organize, sort, and edit them to prepare for
transcript review. When a transcript is imported or added to TextMap, it is displayed
alphabetically (by name) in the Transcripts pane and can be sorted accordingly. Transcripts can
also be sorted by the transcript or import date/time.

After a transcript has been imported to TextMap:
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it can remain as unassigned or placed in a group with other transcripts for better search
capabilities

a new starting page number can be specified (page numbering can be changed). 

If the transcript group(s) do not display in the Transcripts pane, right-click on the Arrange
By heading in the Transcripts pane and select Show Groups. 

Related Topics

Resizing the Transcripts pane

Changing transcripts fonts

Editing transcript properties

Sorting transcripts

Creating transcript groups

Renaming transcripts

Deleting transcripts

Sending transcripts to Sanction
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Resizing the Transcripts pane

The Transcript pane is located at the top of the Navigation pane when you click on the
Transcripts, Exhibits and Video, and Annotation Detail buttons. The Transcript pane contains all
transcripts and other documents imported into the TextMap case, and displays a date and time
stamp for each. You can easily resize the Transcripts pane for better viewing or hide it from to
maximize the TextMap window during transcript review.

You can sort transcripts in alphabetical order by name, and by transcript or import date/time.
TextMap saves the sort order last used when you when you reopen the case.

To hide task panes for better viewing

To show/hide the Transcript List, click the Expand ( )/Collapse ( ) buttons. For example, if
you want to focus on searching transcripts in one group (e.g., Group A), you may want to
hide transcripts from other groups (e.g., Unassigned) from view. You can also double-click on
the group header (e.g., Unassigned) to expand and/or collapse the area.

Expanding and collapsing groups is not supported for Windows® XP users.

To maximize the Transcript pane for better viewing

To change the height or width of the Transcript pane, drag the split bars to the left or right,
or up or down.
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To hide the Transcript pane to maximize transcript display

To maximize a transcript's display in the TextMap window, click on the Collapse button to pin
the Navigation pane to the left side of TextMap. The Navigation pane can easily be
expanded and locked on-screen when you need to use it more frequently.

To hide the date and time display

1. On the File menu, click Options.

2. In the Options dialog box, click the Transcripts tab.

3. In the Transcripts List Options area, clear the check boxes for Show transcript date
and Show transcript time.

4. Click OK to save your changes.

Related Topics
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About transcripts

Changing transcripts fonts

Sorting transcripts

Creating transcript groups

Changing transcripts fonts

Once transcripts are imported, you can adjust the font size and style for better viewing in the
TextMap window. The selected font size and style is applied to all case transcripts.

To change transcript fonts

1. On the View ribbon, click the Transcript Font to open the Font dialog box.

2. In the Font list, click on the font you want to use.

3. In the Font style list, click on the font style you want: Regular, Italic, Bold, Bold Italic.

4. In the Size list, click on the font size.

5. Review your selections in the Sample box.

6. In the Script list, click on the font script type, if necessary.
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7. Click OK to save your changes.

Related Topics

About transcripts

Importing transcripts

Changing transcript page numbers
If you receive a transcript for which the page numbering is incorrect and do not correct it during
the initial import, you can still update the page numbering after the fact.  The Change Transcript
Page Numbers feature only changes the page numbers and does not change the transcript text
or line numbering on each of the pages.

TextMap automatically updates existing annotations to reflect the new page numbers.

To change a transcript page numbers

1. On the Transcripts list, select the transcript where the page numbering will be changed.

2. Right-click on the selected transcript, and then select Change Transcript Page Numbers.

The Change Transcript Page Numbers menu item is disabled if you do not have 'Update
Transcript' permission.

3. In the Change Transcript Page Numbers dialog box:
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To number all pages in the transcript

a. In the New First Page No: box, enter a value (e.g., 1) for the first page of the
transcript.

b. Under the Are all pages in the transcript numbered? heading, select Yes to
number all pages.

c. Optional: Go to the To set unnumbered pages procedure to identify unnumbered
pages in the front/back of the transcript, otherwise, proceed to Step 4.

To set unnumbered pages

a. Under the Are all pages in the transcript numbered? heading, select No, there
are pages at the front/back without numbers to identify the number of pages in
the front and/or back of the transcript.

b. In the No. of pages at front: box, enter the number of pages at the front of the
transcript that are not numbered.

c. In the No. of pages at back: box, enter the number of pages at the back of the
transcript that are not numbered.

d. Proceed to Step 4.

4. In the Change Transcript Page Numbers dialog box, click OK to make the page
numbering change in the transcript.

Related Topics

About transcripts

Importing transcripts
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Sorting transcripts

The Transcripts pane allows you to sort transcripts in alphabetical order, by date and time, and
name. TextMap saves the sort order last used when you re-open the case.

Setting the date/time option is useful when a case contains multiple depositions from the same
person. Dates display in brackets to the left of the transcript name in the Transcripts pane. The
date and time options are set in the Options dialog box, accessible from the Tools menu.
Options are personal to each user's view, and do not affect other users in the same case. If a
user changes the date of a transcript, the updated date immediately displays in the list.

When changing from a name sort to a date sort, and vice versa, the Transcripts pane
automatically sorts in ascending order from A to Z.

To sort transcripts in alphabetical order

1. In the Transcripts pane, click on the A on top button to sort transcripts alphabetically in
descending order from A to Z.

You can also click on the View ribbon, and then on the Arrange By tab, click Transcript
Name.

2. Click on the button again to resort transcripts in ascending order from A to Z.
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3. On the shortcut menu, click Transcript Name.

To sort transcripts by date and time

1. On the File menu, click Options.

2. In the Options dialog box, click the Transcripts tab.

3. Select the check boxes for Show transcript date or Show transcript time.

You cannot select the Show transcript time check box without also selecting the Show
Transcript date check box.

4. Click OK to close the Options dialog box.

5. In the Transcripts pane, notice that the date and/or time for each transcript now
displays.

Transcripts or interview notes without a date sort to the bottom and display No Date in
the Arrange By: column.

Transcripts will sort by date even if you choose not to display the date and time in the
Transcripts pane.

6. Right-click on the Arrange By: column header and click Transcript Date or Import Date.

Transcripts sorted by date can then be sorted from oldest to newest.
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7. You can also click the Oldest on top button to sort transcripts from oldest to newest by
date and/or time. 

To resort the list, click the Newest on top button.

To remove the date and time from the Transcripts pane, click Options on the Tools menu
and clear the check boxes for showing the transcript date or time on the Transcript tab.

To sort transcripts by group

1. In the Transcripts pane, click the Arrange By: column header to choose how you want
to sort transcripts.

You can also click on the View ribbon and then select the Show Groups check box.

2. On the shortcut menu, click Show Groups.

Related Topics

About transcripts

Importing transcripts

Creating transcript groups

Filtering transcripts

Filtering transcripts allows you to quickly locate a transcript and load it for display. 

A minimum of 30 transcripts must be imported into the case before the Filter Transcripts by
Name box displays in the Transcripts pane.

TextMap will automatically save any transcript filter you have. If you close a case, TextMap will
display transcripts with the last filter applied.

To filter transcripts by name

1. On the Arrange By menu of the View ribbon, click Transcript Name to sort accordingly
all Transcript by name.
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The Transcripts pane now displays the transcripts sorted based on the filter.

The transcript now displays in the Transcript window, and any annotations now display
in the Annotations pane.

To clear the transcript filter

You can clear the transcript filter four ways:

Click the Clear button  next to the Filter Transcripts by Name box.

Select text in the Filter Transcript by Name box and then press the Delete key.

On the View menu, click Show All Transcripts.

Press the Esc key.

To modify or disable the transcript filter setting

1. On the File menu, click Options.

2. In the Options dialog box, click on the Transcripts tab.
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3. In the Transcripts List Options area, click the up/down arrows in the number list to set
it to the minimum number of transcripts you want in a case before the Filter Transcripts
by Name box displays.

The default setting is for the filter box to display after 30 transcripts are imported into a
case. You can adjust this setting by depending on the number of case transcripts in your
case.

4. Clear the Show filter box for 30 or more transcripts if you want to disable the Filter
Transcripts by Name box from displaying in the Transcripts pane.

5. Click OK to save your settings.

Related Topics

About filtering

Sorting transcripts

Updating or appending transcripts

You have the option of either updating or appending an existing transcript. The steps for
performing either option are nearly identical:

If you update an existing transcript, TextMap updates the existing transcript and creates a
backup of the original transcript with a draft that is appended to the original transcript
name.
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If you append an existing transcript, TextMap appends the existing transcript and creates a
backup of the original transcript renamed with "[Draft]" appended to the name. The original
draft transcript will retain the original transcript ID.

The backup and the updated/appended copy will both display in the Transcripts pane. You can
later delete the backup draft by selecting it in the Transcript pane and then clicking Delete
Transcript on the Transcript menu.

To learn about updating rough transcripts

If a rough copy of a transcript was already imported into the case, you can easily update it
with the final transcript. TextMap creates a backup copy of the transcript when updating it.
The name of the transcript will be the same, but with [DRAFT] appended.

Any annotations applied to the rough copy will be transferred to the final transcript. If
TextMap cannot locate the exact transcript location for an annotation, it will label it as an
orphaned annotation. Orphans occur when the annotation text or the text surrounding the
annotation has changed significantly. This change can be actual, textual change or a large
change in formatting. TextMap moves orphaned annotations to the top of the transcript
(Page 1, Line 1). The note section includes the original page and line number of the
annotation to help you place the annotation manually. Move annotations by using the Move
Annotation option on the Annotation menu.

Any redactions applied to the rough copy will be transferred to the final transcript. TextMap
cannot apply redactions to the final transcript if there are spelling errors, or if there is
information removed from the transcript text. 

In the event that you have multiple rough transcript files that are all part of the same
transcript, TextMap also offers the option to combine these files into a single transcript by
appending the later testimony to an existing transcript. In this instance, choose the Append
to Transcript option from the right-click menu.

If you are updating/appending a transcript that is assigned to one or more transcript
groups, the updated and DRAFT transcripts will both display within the transcript
group(s). If the rough transcript is assigned to a group that no longer exists, then the
rough and final transcripts will display in the Transcript List under Unassigned. See 
Creating transcript groups.

To update or append an existing transcript

1. In the Transcripts pane, right-click on the transcript you want to append.
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2. On the submenu, click one of the following:

To update a transcript

a. Click Update.

b. In the Select Updated Transcript File dialog box, navigate to and select the
updated transcript, and then click Select.

c. In the message box to continue, click Yes.

d. In the Transcript Import Preview box, confirm the name of the transcript, and click
OK to continue.

e. In the message box for backups, click OK.

f. Click OK on the subsequent message box(es) to complete the transcript update
process.

The updated transcript displays in the Transcript pane, identified by the word
[DRAFT] appended at the end of the name.

To append to a transcript

a. Click Append to.
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b. In Select Transcript File to Append dialog box, navigate to and select the updated
transcript, and then click Select.

c. In the Transcript Import Preview dialog box, modify any transcript information if
needed, such as the date and time, and then click OK.

d. In the transcript message, click OK.

The original transcript now displays in the Transcript List with [DRAFT] appended to
the name. The updated or appended transcript also displays.
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Related Topics

Importing transcripts

About CaseViewNet

Creating transcript groups

TextMap can hold hundreds or even thousands of transcripts, depending on the size of your
case. TextMap allows you to create transcript groups for sets of transcripts that may be similar
in content. Transcript groups make searching easier and enable focused searching.

Each transcript group must have a unique name to identify it. Transcript group names are not
case sensitive and can be up to 255 characters with no leading or trailing punctuation. Each
transcript group must include at least one transcript.

Once created, you can edit, rename, and/or delete transcripts groups. Although a transcript
group can be deleted, the transcript(s) is/are not removed from the case, but instead, no
longer grouped. TextMap only supports deleting one transcript group at a time.

When searches are performed, you can select either transcript groups or specific transcripts to
filter (narrow your search), but not both for a single search.

To display groups in the Transcripts pane, click on the Arrange By header and click Show
Groups. See Sorting transcripts.

You can also create transcript groups for reporting if you find yourself repeatedly running
the same reports on the same set of transcripts. When you create a transcript group
simply name that group with a heading that reflects the report you are printing.

To create a transcript group

1. On the Transcripts ribbon, click Create & Edit Transcript Groups.

2. In the Transcripts Groups dialog box, click the New button.

3. In the Select Transcripts for New Group dialog box, select the transcripts in the
Available box that you want to add to a group.
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Transcripts display in alphabetical order.

4. Click Item or All to move the selected transcripts into the Selected box.

5. Click OK to continue.

6. In the New Transcript Group Name dialog box, type in a meaningful name for the
transcript group, then click OK.

The new group now displays in the Transcripts Groups box.
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The Group Detail area displays the name of the person who created the group and the
included transcripts.

7. Click Close when you are finished.

To edit a transcript group

1. On the Transcripts menu, click Transcript Groups.

2. In the Transcripts Groups dialog box, select the transcript group you want to edit, then
click the Edit button.

3. In the Select Transcripts dialog box, select the transcripts you want to edit.

Select transcripts in the Selected box that you want to remove from the transcript
group.

Select transcripts in the Available box that you want to add to the transcript group.

Click the Item or All buttons to move transcripts between the two boxes.

4. Click OK to save your changes.

5. Click Close when you are finished.

To add a transcript to a group

If you want to add a transcript to a group directly from the Transcript pane (e.g., Unassigned
area):

1. Select/highlight a transcript on the Transcript pane.
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2. Perform one of the following:

On the Transcript menu, click Add Transcript to Group, and then select the group
from the submenu list that the transcript will be added to.

Right-click on a transcript in the Transcript pane, click Add Transcript to Group, and
then select the group from the submenu list that the transcript will be added to.

There will be no system response if you attempt to add a transcript to a group where it
already exists.

The transcript now displays in the new group.

To rename a transcript group

1. On the Transcripts menu, click Transcript Groups.

2. In the Transcripts Groups dialog box, select the transcript to be renamed and click
Rename.

3. In the Rename Transcript Group dialog box, type in the new name, then click OK.

4. Click Close when you are finished.

To delete a transcript group

1. On the Transcripts menu, click Transcript Groups.

2. In the Transcripts Groups dialog box, select the transcript group you want to delete,
then click Delete.

3. In the message box to confirm the action, click Yes.

The transcript group is now deleted from the case.

4. Click Close when you are finished.

Related Topics

About transcripts

Importing transcripts

Sorting transcripts

About full-text searching

Linking exhibits to transcripts

The Auto Link Exhibit Wizard is used once you have already imported a transcript into TextMap.
With this wizard, you can add multiple files, web addresses, or link to another document
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management system anywhere in the transcript where the exhibit is mentioned. You can bulk
link exhibit files on your computer and web addresses, as well as add custom links to other
document management programs. You can even make a document in CaseMap a hyperlinked
exhibit in TextMap. 

To link exhibits or any other files to a single passage in the transcript, use the New
Hyperlink Wizard. See Creating single hyperlinks in transcripts.

To link a new exhibit to this case

1. In the Navigation pane, click the Exhibits and Video button.

2. In the Exhibit Tasks pane, click Link exhibits to this transcript to open the Auto Link
Exhibit Wizard.

3. On the Auto Link Exhibit Wizard's Welcome page, click Next.

4. On the New or Existing Exhibit page, select the option, Yes, I want to link a new
exhibit to this case, and then click Next.

5. On the Document Type page, select the type of document you want to link, and then
click Next:

To add Files:

To add Files, do the following: 

1. On the Bulk Link Multiple Files page, click the Add drop down arrow and then
click Add Files. 

2. Navigate to the folder location where the files are saved.

3. In the Select One or More Exhibits dialog box, select the file(s), and then click
Open.

To Add URLs, do the following:

1. On the Bulk Link Multiple Files page, click the Add arrow and then click Add
URLs.

2. Enter the address of the web page for the new exhibit and then click OK.

To add files via the drag-and-drop operation, drag your selected files into the specified
area on the Bulk Link Multiple Files page.
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To add a document linked in CaseMap:

1. On the Connect to CaseMap page, launch CaseMap and open the corresponding case
(if you have not already done so), and then click Next.

2. On the Select CaseMap Object page, select the file(s) you want to link, and then
click Next.
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To add a custom link:

1. On the New Exhibit Path page, click Open or Browse to navigate to the folder
location where the file is saved, and then click Open.
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2. In the File Viewer list, click the type of viewer you need for the file, and then click
Next.

3. On the New Exhibit Name page, type or edit the file name.

The contents of the Name box is automatically filled with the file name of the linked
file. TextMap searches the transcript for the name and creates a hyperlink to the file
at each location.

4. For the question, Is this document an exhibit?, click Yes or No.

If the document is not an exhibit it will display in the Exhibits pane under Other Linked
Documents.

5. On the Found References to Document page, review the number of references found
in the transcript.

If there are no references found, on the No References to Document Found page,
type in a word or phrase to link to this document, then click Next. TextMap
automatically creates links in the transcript where all instances of the word or phrase
is located in the transcript. 

6. Determine whether you want to add more words or phrases and select on one of the
following: 

Yes, I want to add more words or phrases to auto link.

1. On the Enter Words or Phrases to Auto Link page, type in a word or phrase
to auto link, and then click Add.
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2. In the message box, click OK.

3. Continue adding words or phrases until finished. 

No, I do not want to add more words or phrases to auto link.

Skip to Step 7.

By default, all files will be marked as exhibits. To change, click .

If the Exhibit name or Autolink ID need to be modified, click the Exhibit Name or
Autolink ID fields to modify. The Autolink ID will update based on the exhibit name.

Exhibit names and Autolink IDs must be unique and cannot be duplicated.

If the Link exhibit files with autolink aliases check box is selected, the hyperlink will
be created by pairing the Autolink alias with the Autolink ID.  If the box is not selected,
and there are no Autolink alias names defined, the hyperlink will be created from the
Exhibit name. 

6. Click Next. 

7. On the Completing the Auto Link Exhibit Wizard page, click Finish.
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To link an existing linked document to this case

1. In the Navigation pane, click the Exhibits and Video button.

2. In the Exhibit Tasks pane, click Link exhibits to this transcript to open the Auto Link
Exhibit Wizard.

3. On the Auto Link Exhibit Wizard's Welcome page, and then click Next.

4. On the New or Existing Exhibit page, select the option, No, I want to link to an
existing linked exhibit, and then click Next.

5. On the Select Exhibit page, select the file for which you want to link, and then click
Next.

6. On the Completing the Auto Link Exhibit Wizard page, click Finish.

When you click Finish, TextMap will open the Exhibit Properties dialog for the selected
exhibit. 

7. In the Exhibit Properties dialog box, enter a word or phrase to autolink to this
document, and then click Add. 

TextMap automatically creates links in the transcript where all instances of the word or
phrase is located in the transcript.

8. Continue adding words or phrases until finished, and then click OK.
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Related Topics

 

About exhibits

Using TextMap Exhibit Linker

Importing exhibit packages

Creating single hyperlinks in transcripts

Viewing exhibits

Editing transcript properties

Once transcripts are imported you can view or edit transcript properties for the date/time,
comments, video files, and the transcript ID and signature.

To view or edit transcript properties

1. On the View ribbon, click Transcript Properties to open the Transcript Properties dialog
box.

2. In the Date box, notice that the date is automatically filled in for you.

You can modify this date as needed.

3. In the Time box, type  in the time, then select AM or PM from the list.

Notice that the Include Date & Time box is selected by default. Clear this check box if you
do not want the date/time to display in the Transcripts pane along with the transcript
name.

4. In the Comments box, type in any relevant information about the transcript.

5. Click Advanced button if you want to view or modify the transcript ID and signature.

6. Click OK to save your changes.
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Related Topics

About transcripts

Importing transcripts

Renaming transcripts

Edits to a transcript name can be made quite easily.

To rename a transcript

1. In the Transcripts pane, click on the transcript you want to rename.

2. On the Transcript menu, click Rename Transcript.

You can also right-click on the transcript and then click Rename Transcript.

3. In the Rename dialog box, type or edit the transcript name.

4. Click OK to save any changes.

Related Topics

About transcripts

Sorting transcripts

Deleting transcripts

Deleting transcripts

Once a transcripts is deleted it is permanently removed from the case. TextMap only supports
deleting one transcript at a time.

To delete transcripts

1. In the Transcripts pane, click on the transcript you want to delete.

2. On the Transcript menu, click Delete Transcript.



TextMap128

© 2017 LexisNexis. All rights reserved.

You can also right-click on the transcript and then click Delete Transcript.

3. In the message to confirm this action, click Yes.

Related Topics

About transcripts

Sorting transcripts

Creating transcript groups

Renaming transcripts

Sending transcripts to Sanction

To assist in organizing presentations of key evidence for trial, you can connect to a case in Sanction®

3.5 and send information from TextMap to Sanction. Please refer to the Sanction Answer Center for
additional information.

To send a transcript to Sanction

1. Open a case in Sanction 3.5 or later.

It is necessary to have a case open in Sanction for the Send Transcript to Sanction
option to be successful.

2. In the Transcript pane, select/highlight the transcript you want to send to Sanction.

3. On the Transcript menu, click the Send To Sanction button. 

You can also right-click on a transcript in the list, click Send To, and then click Send to
Sanction. 

http://help.lexisnexis.com/litigation/ac/sanction/index.html?welcome.htm
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The Send Transcript to Sanction dialog box opens.

To select multiple transcripts

a. In the Send Transcript to Sanction dialog box, click Select transcripts.

b. In the Select Transcripts dialog box, click Transcripts Groups to list transcripts by
groups, or click Individual Transcripts to list transcripts individually.

For this example, Individual Transcripts has been selected.
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c. In the Available Transcripts column, place a check mark beside transcript(s) to be
sent to Sanction.

Optional: Place a check mark in the Select all check box to simultaneously select all
transcripts.

d. Click OK to display the Send Transcript to Sanction dialog box.

To include media clips when sending transcripts to Sanction, see Sending annotations as
Sanction media clips. 

4. In the Send Transcript to Sanction dialog box, click OK.
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Related Topics

About transcripts

About annotations

Sending annotations as Sanction media clips

Editing videos

Sorting Data

About sorting

Sorting determines the order that case elements display in pane views, allowing you to review
information in various ways to determine what items need to be addressed first or categorized
based on the status of items. Sorting is distinct to each user ID and does not affect the view
that others see for this spreadsheet. 

Transcripts can be sorted in alphabetical order by name, or by transcript or import date/time.
TextMap saves the sort order last used when you re-open the case.

You can sort data in the following places:

Transcripts pane — Sort transcripts or transcripts groups alphabetically by name or by the
transcript's date/time, or by the import date.

Annotations pane — Sort by columns in the Annotations pane by Source, Note, Linked
Issue, Linked Fact, Text,  Created By, and Creation Time Stamp.

Sorting is independent of any filter function. If you filter transcripts or annotations, they
are still sorted as specified by the view's sort order.

Related Topics

Sorting annotations

Sorting transcripts

About filtering

About searching
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Sorting transcripts

The Transcripts pane allows you to sort transcripts in alphabetical order, by date and time, and
name. TextMap saves the sort order last used when you re-open the case.

Setting the date/time option is useful when a case contains multiple depositions from the same
person. Dates display in brackets to the left of the transcript name in the Transcripts pane. The
date and time options are set in the Options dialog box, accessible from the Tools menu.
Options are personal to each user's view, and do not affect other users in the same case. If a
user changes the date of a transcript, the updated date immediately displays in the list.

When changing from a name sort to a date sort, and vice versa, the Transcripts pane
automatically sorts in ascending order from A to Z.

To sort transcripts in alphabetical order

1. In the Transcripts pane, click on the A on top button to sort transcripts alphabetically in
descending order from A to Z.

You can also click on the View ribbon, and then on the Arrange By tab, click Transcript
Name.

2. Click on the button again to resort transcripts in ascending order from A to Z.
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3. On the shortcut menu, click Transcript Name.

To sort transcripts by date and time

1. On the File menu, click Options.

2. In the Options dialog box, click the Transcripts tab.

3. Select the check boxes for Show transcript date or Show transcript time.

You cannot select the Show transcript time check box without also selecting the Show
Transcript date check box.

4. Click OK to close the Options dialog box.

5. In the Transcripts pane, notice that the date and/or time for each transcript now
displays.

Transcripts or interview notes without a date sort to the bottom and display No Date in
the Arrange By: column.

Transcripts will sort by date even if you choose not to display the date and time in the
Transcripts pane.

6. Right-click on the Arrange By: column header and click Transcript Date or Import Date.

Transcripts sorted by date can then be sorted from oldest to newest.
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7. You can also click the Oldest on top button to sort transcripts from oldest to newest by
date and/or time. 

To resort the list, click the Newest on top button.

To remove the date and time from the Transcripts pane, click Options on the Tools menu
and clear the check boxes for showing the transcript date or time on the Transcript tab.

To sort transcripts by group

1. In the Transcripts pane, click the Arrange By: column header to choose how you want
to sort transcripts.

You can also click on the View ribbon and then select the Show Groups check box.

2. On the shortcut menu, click Show Groups.

Related Topics

About transcripts

Importing transcripts

Creating transcript groups

Sorting annotations

The Annotations pane allows you to sort annotations by columns: Source, Note, Linked Issues,
Linked Fact, Text, Created By, and Creation Time Stamp. The default sort order is by page/line
number.

To sort annotations

1. In the Transcripts pane, click on the transcript for which you want to view annotations.

2. In the Annotations pane, click on the column you want to sort by.
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For example, if you want to sort all annotations by linked issues, click on the Linked
Issues column.

All annotations now display by linked issues and in alphabetical order. An arrow displays
in the column indicating which column annotations are sorted by.

Related Topics

About sorting

About filtering

Viewing annotations

Filtering annotations

Filtering Data

About filtering

TextMap allows you to filter both transcripts and annotations. Filtering enhances your viewing
capabilities by allowing you to find and focus on specific transcripts or annotations more
efficiently. Filtered data remains in the current viewing pane (Transcripts pane or Annotations
pane); while other data is temporarily hidden from view.

Related Topics

Filtering transcripts

Filtering annotations

About sorting

Filtering transcripts

Filtering transcripts allows you to quickly locate a transcript and load it for display. 

A minimum of 30 transcripts must be imported into the case before the Filter Transcripts by
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Name box displays in the Transcripts pane.

TextMap will automatically save any transcript filter you have. If you close a case, TextMap will
display transcripts with the last filter applied.

To filter transcripts by name

1. On the Arrange By menu of the View ribbon, click Transcript Name to sort accordingly
all Transcript by name.

The Transcripts pane now displays the transcripts sorted based on the filter.

The transcript now displays in the Transcript window, and any annotations now display
in the Annotations pane.

To clear the transcript filter

You can clear the transcript filter four ways:

Click the Clear button  next to the Filter Transcripts by Name box.

Select text in the Filter Transcript by Name box and then press the Delete key.

On the View menu, click Show All Transcripts.

Press the Esc key.

To modify or disable the transcript filter setting

1. On the File menu, click Options.

2. In the Options dialog box, click on the Transcripts tab.
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3. In the Transcripts List Options area, click the up/down arrows in the number list to set
it to the minimum number of transcripts you want in a case before the Filter Transcripts
by Name box displays.

The default setting is for the filter box to display after 30 transcripts are imported into a
case. You can adjust this setting by depending on the number of case transcripts in your
case.

4. Clear the Show filter box for 30 or more transcripts if you want to disable the Filter
Transcripts by Name box from displaying in the Transcripts pane.

5. Click OK to save your settings.

Related Topics

About filtering

Sorting transcripts

Filtering annotations

TextMap now allows you to filter annotations by creator or linked issues. To apply an
annotation filter, click the View ribbon and select Filter by Creator or Filter by Linked Issues. (No
Filter is the default view, where all annotations display). The selected filter is then applied to all
transcripts in the case for the current user session or until another filter option is selected.
When you close or re-open a case, any previously applied filters are automatically cleared. The
annotation filter status displays in the top right corner of the Annotations pane.
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If you or another user deletes an annotation or issue while a filter is applied, it will be
deleted regardless.

View filtering considerations

Reference the following table to learn about considerations that affect filtering.

Filtering Considerations

Filters Description

Filter by Creator Any new annotations added by other case users when the
filter is running only display if they match the current filter.

If there are no annotations for selected users, the
Annotations pane displays a message, Filter Excludes All
Annotations.

Case users who have been deleted will still display with
that designation. If an annotation has "unknown" as the
creator, you can assign it to another users. See Changing
annotations' owner status.

If the Filter by Creator menu item is grayed out, the case
does not currently have any users.

Filter by Linked Issues Annotations created or edited when the filter is running
only display if they match the current filter.

If you select a parent issue, all child issues are also
selected. Clear the check box for any issue you do not want
in the filter.

If an issue filter is already applied, those issues will already
be selected in the Filter Annotations by Linked Issues
dialog box.

If there are no annotations for selected issues, the
Annotations pane displays a message, Filter Excludes All
Annotations, and the Filter by Annotations by Linked Issues
dialog box displays a message, There are no issues in this
TextMap case.

To filter by creator

1. On the View ribbon, click Filter by Creator on the Filter Annotations tab.

2. In the Filter Annotations by Creator dialog box, select one or more users to filter by.
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3. Click OK to apply the filter.

Only annotations by selected users now display in the Annotations pane.

The information bar in the top right corner of the Annotations pane now displays the
number of annotations filtered and total annotations in the transcript.

To filter by linked issues

1. On the View ribbon, click Filter by Linked Issues on the Filter Annotations tab.

2. In the Filter Annotations by Linked Issues dialog box, select the check box for each
issue you want included in the filter, then click OK.

You can also right-click to check or clear all issues.
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Only annotations linked to the selected issues now display in the Annotations pane.

To clear an annotation filter

1. On the View menu, click No Filter on the Filter Annotations tab.

The previous filter is now removed from all transcripts in the case.

If you select another filter option, the previous filter is cleared and the new filter is
applied.

Related Topics

About annotations

Creating annotations

Viewing annotations

Sorting annotations

Searching Data

About searching

TextMap allows you to quickly search all transcripts, exhibits, documents, annotations, and
notes in your case because it automatically creates a case index during the import process.

There are two methods of searching in TextMap:

Basic Word Searches — performing single word searches to locate all instances of the
word in transcript text.

See Running basic word searches.

Full-Text Searching — performing full-text searches against transcript text, annotations,
and exhibits.

See About full-text searching.

Learn how the case index works

TextMap creates a case index when you import transcripts and files into a case. During the
indexing process, TextMap reads each imported document and compiles a case index based
off the each word it reads.
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The case index is used when you perform searches so you can locate important words,
dates, and text phrases easily in your case.

For more information, see About the case index.

Lean how ignore words help narrow search results

TextMap provides you with a default, global Ignore List and a Case Ignore Words list. Both
lists are used by TextMap to skip or ignore words and text from both lists during searches.
Words or alphanumeric text can be added or deleted from either list.  When search queries
are performed, any words or text added to the lists are skipped and not included in search
results or tallied as search "hits".

For more information, see Modifying ignore words.

Related Topics

Running basic word searches

Running full-text searches

Running full-text searches
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About the case index

Rebuilding the case index

Modifying ignore words

Running basic word searches

Basic word searches are performed to locate all instances of a single word in transcript text for
all transcripts in a case. Transcripts that include the search term display in the Word Search
pane. Under each transcript are page/line number hyperlinks that jump directly to the search
term for that transcript. When you click on a hyperlink, the applicable transcript displays in the
main TextMap pane with the search term highlighted.

If you want to search selected transcripts, exhibits, documents, and annotations, you need to
run a full-text search. See Running full-text searches.

To run a basic keyword search

1. In the Search pane, click the Word Search tab.

2. In the Word Search box, type in the word you want to locate.
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By default, only the words for the selected transcript are displayed in the search results
for large cases when it has more than 100 transcripts.

As you type, you will see partial word results display as TextMap matches the root word
to other similar words.

Search results display in the Word Search pane and are grouped by transcript.

3. Point your mouse to a hyperlink to display a preview of the the search term that includes
the two lines before and after it in the transcript.

4. Click on a page/line number hyperlink to jump directly to the search term within the
applicable transcript.

The applicable transcript displays in the main TextMap pane with the search term
highlighted for easy identification.

Related Topics
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About searching

About full-text searching

Running full-text searches

Running form-based searches

Modifying ignore words

Full-text Searching

About full-text searching

Full-text searching allows you to run both form-based and full-text searches on all case
transcripts or selected transcripts/groups in your case. Once a full-text search is run, you can
view and narrow your results in the Search pane.

TextMap offers two methods of full-text searching:

The Full Text Search tab allows you write your own search queries and locate key case
information by narrowing your search by categories: transcript text, exhibits, and
annotations (also by select issues). You can search all case transcripts or select individual
transcripts or transcripts groups. Once a full-text search is run, you can view and narrow
your results in the Full-Text Search tab in the Search pane.

For more information, see Running full-text searches and Using search operators.

The Form Based tab has search operator parameters provided for you and allows you to
locate terms without having to learn about search operators. The Form Based tab allows
you to learn about full-text searching without having to write your own queries. Form-based
searches are run in the Full Text Search dialog box in the Form Based tab. Once you
understand how to use search operators, you can type your own search queries in the Full
Text Search tab.

Use the Search Assistant to write faster search queries

As you type in search queries, TextMap's Search Assistant displays suggested terms from
the case index to help you write queries faster. The word options narrow as you continue to
type. Once you identify a term, click on it or highlight it and press Enter to add it to the
search query. Continue typing terms to complete the search query.

Many common words, such as "they", "the", "it" are not included in the case index. 
Additionally, any words added to the Ignore Word list will simply be ignored in searches.

For more information, see About the case index and Modifying ignore words.
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Related Topics

About searching

Running basic word searches

Running full-text searches

Using search operators

Adding terms to the case thesaurus

Running full-text searches

Full-text searching allows you to locate key case information by searching transcript text,
exhibits, and annotations (also by select issues). You can search each of these categories
individually or expand your search further by selecting a combination of categories to include
that information in your search results.

The Full Text Search tab also allows you to write your own search queries using search
operators, which also help you garner precise search results. See Using search operators.

TextMap automatically searches all transcripts by default when a search is run, unless specific
transcripts are selected. TextMap will automatically recall selected transcripts from the last
search run. This feature is distinct to each user for the current TextMap session. If no searches
have been run in the current session, TextMap will default to the All Transcripts setting. 

Search results display in the Full Text Search tab after a search is run. See also Viewing/
navigating search results.
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To preview search results, expand/reduce the range between search terms, write longer
complex queries, view search history, re-run saved searches, or access the case
thesaurus, see additional Full Text Search features.

To run a full-text search

1. In the Search pane, click the Full Text Search tab.

2. In the Full Text Search tab, type in your search query.

3. Click the Full Text Search button  to run the query.

Search results are displayed to the right in the Search Pane, and the Search ribbon
displays at the top of the workspace.

4. In the Full Text Search tab, view the search results.
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5. In the Full Text Search tab, click on a page/line number hyperlink (example: 15:14) to
jump directly to the search term within the applicable transcript or exhibit.

The transcript displays in the main TextMap window with the search term highlighted for
easy identification.

6. On the Search ribbon, click Next Hit to go to the next term.

7. Optional: On the Navigate tab of the Search  ribbon, click on the:

Click the First icon to go back to the first search hit.

Click the Prior icon to go back to the search hit just viewed.

Click the Last icon to go to the last search hit.

For more information on viewing and navigating search results, see Viewing search
results.

8. Optional: Click Search Report to open the Search Report wizard which is used to create
a report of your search results.

9. In the Search Report Wizard, complete all steps as applicable.
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See Printing a Search report for additional information.

10. Optional: Click Edit to edit a saved search.

See To edit a saved search for additional information.

11. Optional: Click Save to save the search.

See Saving searches for additional information.

For more information on viewing and navigating search results, see Viewing search
results.

To choose which types of case data to search

A search can be performed and/or narrowed using any combination of categories (i.e.,
Transcript Text and Annotations). When multiple categories are selected, results for all
categories display in the search results.

1. In the Narrow Categories pane, select the check box for each category that you want to
search. (i.e., Transcript Text and Annotations).

The Transcript Text check box is selected by default.

2. Click the Full Text Search button  to initiate to search.

Results display in the Full Text Search tab (right). Search hits in the transcript text are
highlighted, and if the first hit is in an annotation, that annotation will be selected.

To select specific transcripts to search

1. In the Narrow Transcripts pane, click Select transcripts to select specific transcripts or
transcripts groups.
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3. In the Select Transcripts dialog box, select Transcript Groups to search a specific group
of transcripts, or select Individual Transcripts to select/search specific transcripts only,
and then click OK to continue.

A Search all transcripts link displays in the Narrow Transcripts pane and can be used to
search all transcripts if hits aren't found in previous searches.

4. Click the Full Text Search button  to initiate to search.

To limit annotations to specific issues

When searching annotations, search results will include annotations that match the search
text and are linked to any of the selected issues. You can also search annotations by
entering an issue name in the Search box (e.g. if the you search for the Background issue,
TextMap will find annotations linked to the issue Background.

1. In the Narrow Categories area, select the Annotations check box.

The Annotations check box must be selected for the Narrow Annotations pane to display.

2. In the Narrow Annotations pane, click Select issues to focus the search on specific
issues.
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3. In the Select Issues screen, select the check box for each issue you want to search,
then click OK.
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The selected issues display in the Narrow Annotations pane.

A Search all annotations link also displays, which can be used to search all annotations if
hits aren't found in previous searches. Click Select all annotations to search all
annotations and removed the selected issues.

4. Click the Full Text Search button  to initiate to search.

Search results include annotations that match the search text and are linked to any of
the selected issues.

If there are no hits/results found based on the search, TextMap will display a message
that no hits were found.

To preview search results, adjust the nearness indicator, view saved searches, or run
complex queries

You will run the majority of your searches in the Search pane using the Full Text Search tab
(located to the right of the Transcript window). When necessary, however, you can access a
few more search features by opening the Full Text Search dialog box from the Search menu.
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The Full Text Search tab in the Full Text Search dialog box offers a few more search
features:

Previewing search results without having to load all search results

After you type in a search query in the Query box, you can preview the number of search
hits found before loading the full search results. Search results display in the Preview
Results box, showing the total number of hits as well as the number of hits found per
transcript.

Adjusting the nearness indicator to expand or reduce the range in which you want locate
both words

The Nearness default setting is used to locate search terms within five words of each
other. You can expand/reduce this range from one to 100 words.

Access saved searches in your My Favorites folder or All Users' Favorites

See Saving searches

Access the Thesaurus to find word synonyms in searches

TextMap offers both a global thesaurus and a case thesaurus so you can find synonyms
or "like" terms that are referenced in your case transcripts.

See Using search operators and Adding terms to the case thesaurus.

Viewing search history for the past 30 days.

See Viewing search history.

To open the Full Text Search dialog box from the Search pane, leave the Search Text
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box blank and then click the the green arrow button .

Related Topics

About full-text searching

Using search operators

Adding terms to the case thesaurus

Viewing/navigating search results

Viewing search results

Saving Searches

Canceling searches

Viewing search history

Running form-based searches

Using the Form Based tab is a great way to practice running full-text searches until you are
ready to write your own search queries. The Form Based tab has search operator parameters
provided for you and allows you to locate terms without having to learn about search
operators. Once you understand how to use search operators, you can type your own search
queries in the Full Text Search tab.

Form-based searches are run in the Full Text Search dialog box in the Form Based tab
(accessible from the Search ribbon). You can narrow your search by selecting categories in the
Full Text Search tab in the Search pane. See Running full-text searches.

TextMap automatically searches all transcripts, unless specific transcripts are selected.

To run a form-based search

1. On the View ribbon, click the Search icon to open the Full Text Search dialog box.

2. In the Full Text Search dialog box, click the Form Based tab.
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3. In the Find Transcripts area, type in the search terms for the option(s) you want to use.

with all of the words 

with the exact phrase 

with at least one of the words

without the words

You can enter search terms in more than one field to narrow your search results by
including or excluding words.

For example, a search with the exact phrase of water damage and with at least one of
the words mold, locates all transcripts that include the phrase water damage and also
includes the word mold. Transcripts that include the phrase water damage but do not
include the word mold will not display in your search results.

Once you have typed in your search terms, click on the Full Text Query tab to view how
the search query is written using search operators. Next time you have a similar search,
try typing the query yourself.

5. Click the Preview button to review the number of search results found.

6. In the Preview Results box, review all transcripts located as well as the number of hits
found per transcript.

7. Click the Search button to run the search query and view the results in the Search pane.

7. In the Full Text Search pane, click on a page/line number hyperlink (ex: 15:14 water) to
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jump directly to the search term within the applicable transcript.

The transcript displays in the main TextMap window with the search term highlighted for
easy identification.

For more information on viewing and navigating search results, see Viewing/navigating
search results.

Related Topics

About full-text searching

Running full-text searches

Using search operators

Viewing search results

Viewing/navigating search results

After a full-text search is run, results display in the Search pane in the Full Text Search tab.
Search hits for transcripts text, annotations, and exhibits display by transcript. Annotation hits
have a yellow comment icon to you help distinguish between transcript text and annotations
hits.
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The first transcript text hit in your search results is highlighted in black and displays in the main
Transcript window (center pane).
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If annotations are included in the search (shown in the screen shot below), then the first
annotation is displayed in the Transcript window for the first transcript in your search results.
The annotation is also highlighted in the Annotations pane (top, above the transcript).

In the Full Text Search tab, you can navigate search hits by:

Clicking on the transcript text page/line number (e.g., 20:15 testimony) in the Full Text
Search tab to jump directly to the search term within the applicable transcript.

Clicking on an annotation page/line number (e.g., 10:10 example) to jump directly to the
annotated text within the applicable transcript.

Clicking on an exhibit (e.g., Exhibit 1 (1) example) to view the exhibit in the file viewer
window.

On the Search ribbon, you can use the features on the Navigate tab  to
navigate and view transcript text and annotation hits. If annotations are included in the search
hits, then you can also find these features in the Annotation Detail Pane under the Annotation
Properties area.

Go to First — Click Ctrl+F7 to navigate to the first search hit.

Go to Prior — Click or press F7 to navigate to a prior search hit.
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Go to Next — Click or press F8 to navigate to the next search hit.

Go to Last — Click Ctrl+F8 to navigate to the last search hit.

Search results can be printed in a Search Report. The Search Report option, available on
the Search menu, opens the Search Report Wizard which can be used to create a report of
the current search results. See Printing a Search report.

Related Topics

About searching

About full-text searching

Running full-text searches

Running form-based searches

Printing a Search report

Using search operators

Search operators allow you to write your own advanced queries to garner precise search
results in your case transcripts and notes. Once you learn to use search operators, you can
advance to typing complex searches that will help you locate facts and details that might
otherwise take hours of transcript review to uncover.

Full-text queries can be run from the Full Text Search box in the Search pane (or from the Full
Text Search dialog box in the Full Text Query tab). See Running full-text searches.

Full-text searches use the following operators:

Boolean

Proximity

Wildcard

Numeric

LIKE

Learn about Boolean operators

Boolean operators are based on the binary logic used in computers today, producing strict
true or false results. The most common Boolean operators are AND, OR, and NOT.

Search terms are not case sensitive; you don't have to enter all caps for "AND" when typing
a search query. However, it is important to type spaces between the search terms and the
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operator being used.

Boolean Operators

Operator Query Results

AND contains both
words

water AND
damage

All transcripts with both the words: water and
damage

OR contains either
word

water OR
damage

All transcripts with either water or damage, or
both

NOT contains first
word, but not second

water and
NOT
damage

All transcripts with water, but not damage

Learn about proximity operators

Proximity operators are useful in finding text that appears in transcripts within a specified
range of words. The proximity operators used in TextMap are NEAR and BEFORE.

You can use the Nearness scroll bar to adjust the range of terms you want from zero to
100. This range is the maximum number of intervening indexed words, excluding those on
the ignore list. The Nearness default range is set to five terms.

Proximity Operators

Operator Query Results

NEAR water
NEAR3 mold

Both terms appear within three words of each
other

BEFORE water
BEFORE3
damage

All transcripts where water is three words before
damage

Learn about wildcard operators

Wildcard operators are symbols you can use as a substitute for characters or series of
characters, creating a broader search with stronger results.
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Wildcard Operators

Operator Query Results

Asterisk * replaces a
character at the
beginning or end of a
search string

*count*

leak*

*holding

Finds the following: account, accountant,
country, countries, and discount

Finds the following: leak, leakage, leaking

Finds the following results: withholding

Question mark ?
represents any character
in its place in the
character sequence

wom?n

??99

10:??

Finds the following: woman, women

Finds all dates in the year 1999

Finds all timeframes of 10:00 o'clock (a.m. or
p.m.), i.e. 10:00, 10:42

[ ] represents any
character specified
within the brackets [afp],
or in a range of
characters specified in its
place in the character
sequence [a-z]

New[a-s]

New[prt]

Finds news, but not newt

Finds newt, but not news

Learn about numeric operators

Use numeric operators to help you locate numbers in a transcript.

Numeric Operators

Operator Query Results

<                   less
than

 < 50

Florida < 32803

Finds numbers less than 50

Finds Florida followed by a number less than
32803

>                  
greater than

> 50 Finds numbers greater than 50

<=                 less
than or equal to

<=50 Finds numbers less than or equal to 50

>=                
greater than or
equal to

>=50 Finds numbers greater than or equal to 50

=                   equal
to

=50 Finds the number 50
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Numeric Operators

Operator Query Results

<x and >x     not
equal to

<50 and >50 Finds all numbers except 50

Learn about the LIKE operator

Use the LIKE operator to finds synonyms from the global and case thesauruses for the
search term you specify. The global thesaurus and case thesaurus include lists of terms that
have been defined as having the same meaning. You cannot add new terms to the global
thesaurus, but you can add terms to the case thesaurus so you do not miss those
references in a transcript search. This is especially helpful if you have a case with many
similar terms mentioned that may mean the same thing.

Example: LIKE water

A search like this may return results for irrigation and wet.

Example: LIKE aspirin

For a case involving the pain reliever aspirin, you may want to add the terms: Advil®,
Bayer®, ibuprofen, and Tylenol®.

Example: LIKE mold

For a case involving mold, you may want to add the types of mold strains, such as
Stachybotrys, Penicillium, and Aspergillus.

For more information, see Adding terms to the case thesaurus.

Learn about advanced searches and operator precedence

Advanced queries can combine multiple operators and search terms. TextMap uses a
hierarchy to evaluate search queries and return results in a specific order. When you
combine search queries, you can use parentheses to enforce operator precedence. Searches
within parentheses are evaluated before they are combined with other search operators.
Parentheses have the highest precedence.

How the operator hierarchy works

TextMap searches terms in a query in the following operator precedence.

Operator order of precedence:

Wildcard characters

LIKE
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Numerics

NOT

OR

BEFORE, NEAR

AND

Example: mold AND carpet OR drywall

In this query, "carpet OR drywall" has search precedence over "mold AND".

The same would be true if the query were reversed: "carpet OR drywall AND mold". Both
queries return the same results.

Example: mold BEFORE carpet NEAR drywall

Search queries that have operators at the same precedence level are processed from left
to right. In the example query, "mold BEFORE carpet" is processed first, then "NEAR
drywall".

The query can be reversed by using parentheses to override the operator precedence.

Example: mold BEFORE (carpet NEAR drywall)

In this query, the search term and operator within the parentheses (carpet NEAR drywall)
is processed first, regardless of the left-to-right precedence.

Use parentheses to enforce operator precedence

When formulating search queries with more than one search operator, we recommend
you use parentheses. By using parenthesis, you can force TextMap to search the terms
you type within the parentheses first, regardless of operator precedence. This allows you
flexibility in formulating your own searches and garnering stronger results.

Example:  mold NEAR25 (seminar* OR train*)

This query returns results where "mold" appears in a transcript within 25 words of
"seminar", "seminars", or "training". 

The OR operator carries precedence because the search results do not return instances
where "mold" may appear in a transcript within a range of 50 words of "seminar",
"seminars", or "training".

How to formulate complex queries

Complex queries are advanced queries that contain two or more operators and multiple
search terms. Using parentheses helps to offset search terms so you can read your
queries easier.

Example: valve OR main NEAR25 crew OR LIKE employees

This query returns results for "valve" or "main" first. Then TextMap finds these terms
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within a range of 25 words of "crew" or synonyms of "employees". You can adjust the
range of words by moving the Nearness indicator in the Full Text Query tab or simply
changing the number value typed with the NEAR operator.

Because of operator precedence, this query is also the equivalent of: (valve OR main)
NEAR25 (crew or LIKE employees).

Example: LIKE water NEAR50 valve* OR main

This query finds "water" or synonyms of water within a range of 50 words of "valve",
"valves", or "main".

Because of operator precedence, this query is also the equivalent of: (LIKE car) NEAR50
(valve* OR main)

Related Topics

About full-text searching

Running full-text searches

Creating transcript groups

Adding terms to the case thesaurus

Saving searches

Viewing search history

Viewing search history

TextMap stores your full-text search queries for up to 30 days. You can view and reference
search history from Search menu by clicking Full Text Search and then clicking the History
button. Search history is individual to each user ID; you will not see other users' search history.

Search history for each stored query includes the query text and the date/time the search was
run. Click on an individual search to display search details, including the query text. Searches
can be reloaded to edit or re-run from the Full Text Search dialog box.

Delete searches as needed to clear search history. Once a search is deleted it is permanently
removed from the case. Any searches older than 30 days are automatically deleted by TextMap.

To view search history

1. On the Search ribbon, click Edit to open the Full Text Search dialog box.

A search must be run to activate the Edit button.
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2. In the Full Text Search dialog box, click the History button.

3. In the Search History dialog box, scroll to view recent search history.

4. Click on a search to view search details, including the query text and transcripts included
when the query was run.

5. Click Close when you are finished.

To load and rerun a stored search

1. On the Search ribbon, click Edit to open the Full Text Search dialog box.

2. In the Full Text Search dialog box, click the History button.

3. In the Searches box, click on the search you want to edit or run again.

4. Click the Load button to open the Advanced Search dialog box.

Notice that the search now displays in the Query box in the Full Text Query tab.

5. Click the Search button to re-run or edit the search.

To delete search history

1. On the Search ribbon, click Edit to open the Full Text Search dialog box.

2. In the Full Text Search dialog box, click the History button.

3. In the Search History dialog box, highlight the searches you want to delete.

4. Click the Delete button.

5. In the message box, click Yes.

6. Click Close and then click Cancel to continue.

Related Topics

About full-text searching

Saving searches

Saving searches

There are many reasons to save your search queries. One primary benefit is that once saved,
you can re-run them on updated case transcripts to collect new search results. 

Reasons to save your search queries:

You need to perform the same search more than once.
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You create complex queries and do not want to retype or forget them.

You can re-run searches when new transcripts are imported into the case.

Other case staff can run or build upon saved searches, saving data entry time.

You are interrupted during a complicated set of searches that you want to resume later.

You can save search queries two ways:

My Favorite Searches — Search queries you save that only you can re-run.

All Case Users' Favorite Searches — Search queries saved and accessible for all case staff
to run.

 

Saved searches are stored in Favorites folders: All Users' Favorites or My Favorites (your
personal searches). Each saved search name must be unique when saved within a Favorites
folder, though both folders may contain searches with the same name. Search names are case
sensitive and can be up to 50 characters. Saved searches display in alphabetical order.

You can overwrite previous saved searches with the same name. TextMap displays a message
box when you try to save a search with a search name that has already been used. You have
the option to overwrite the previous saved search or you can save the search with a unique
name.

In the Favorite Searches dialog box, click on a saved search to view additional information in
the Favorite Detail area, including the search name, who created it, and the query text.

To save a search
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1. Run a form-based or full-text search.

2. On the Search ribbon, click Save.

3. In the Save Search to Favorites dialog box, type a name that identifies the query.

4. Select the save option you want: My Favorite Searches or All Case Users' Favorite
Searches.

5. Click OK to save the search query.

To re-run a saved search

1. On the Search ribbon, click Edit to open the Full Text Search dialog box.

2. In the Full Text Search dialog box, click the Favorites button.

3. In the Favorite Searches dialog box, highlight the search you want to re-run.

4. Click the Load button.

The search now displays in the Query box in the Full Text Query tab.

5. Click the Search button to re-run the search.

You can also re-run searches from the Search History tab. For more information, see 
Viewing search history.

To rename a saved search

1. On the Search ribbon, click Edit to open the Full Text Search dialog box.

2. In the Full Text Search dialog box, click the Favorites button.

3. In the Favorite Searches dialog box, highlight the search you want to rename, then click
the Rename button.

4. In the Rename Favorite Search dialog box, type in the new search name, then click OK.

5. Click Close and then click Cancel to continue.

To edit a saved search

1. On the Search ribbon, click Edit to open the Full Text Search dialog box.
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2. In the Full Text Search dialog box, click the Favorites button.

3. In the Favorite Searches dialog box, highlight the search you want to edit.

4. Click the Load button.

5. In the Query box on the Full Text Query tab, edit the search query.

6. Click the Search button to run the search.

To delete a saved search

1. On the Search ribbon, click Edit to open the Full Text Search dialog box.

2. In the Full Text Search dialog box, click the Favorites button.

3. In the Favorite Searches dialog box, highlight the search you want to delete, then click
the Delete button.

4. In the message box, click Yes.

5. Click Close and then click Cancel to continue.

Related Topics

About full-text searching

Using search operators

Running full-text searches

Viewing search results

Canceling searches

Viewing search history

Canceling searches

After running a search and reviewing the results, you can easily cancel/clear the search results

by clicking the Cancel Search button  in the Full Text Search tab. 

You can also click on the Search ribbon and then click Close Search, or you can type over a

search query in the Full Text Search box and click the Full Text Search button  to run the
new search.
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Once the search is canceled, the query is deleted from the Search box and the Full Text Search
tab refreshes to display the Narrow Categories, Narrow Transcripts, and Narrow Annotations
areas.

Related Topics

About searching

Running full-text searches

Saving searches

Adding terms to the case thesaurus

TextMap includes a global thesaurus that helps process advanced, full-text query searches
using the LIKE operator. Search results will include synonyms found in the global thesaurus or
synonyms you add to the case thesaurus that are specific to the current case. A synonym is a
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word having the same or nearly the same meaning as another. Case synonyms have a
maximum character limit of 30 and display in alphabetical order.

For more information, see Learn about the LIKE operator.

To add synonyms to the case thesaurus

1. On the Search ribbon, click Edit to open the Full Text Search dialog box.

2. In the Full Text Search dialog box, click the Thesaurus button.

3. In the Advanced Search Thesaurus dialog box, type in a word in the Find Synonyms for
box.

Synonyms from the global thesaurus display in the Global Synonyms box.

4. Click the Edit Case Synonyms button to add similar words to the case thesaurus.

5. In the Edit Case Synonyms dialog box, type a synonym that applies to transcripts in
your case, then press Enter.

The new words now display in the Case Synonyms box.
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6. Continue typing in synonyms until you are finished, then click OK.

Each time you type a synonym, press Enter to add a new word.

7. Click the Close button to save new words.

8. In the Full Text Search dialog box, click Cancel.

New searches will now capture the synonyms you added to the case thesaurus.

To edit case synonyms

1. On the Search menu, click Full Text Search.

2. In the Full Text Search dialog box, click the Thesaurus button.

3. In the Advanced Search Thesaurus dialog box, type the word in the Find Synonyms for
box for which you want to edit synonyms.

4. Click the Edit Case Synonyms button.

5. In the Edit Case Synonyms dialog box, select the word you want and make any
necessary edits.

6. Click OK to save your changes.

7. In the Advanced Search Thesaurus dialog box, click Close.

8. In the Full Text Search dialog box, click Cancel.

To delete case synonyms

1. On the Search menu, click Full Text Search.

2. In the Full Text Search dialog box, click the Thesaurus button.

3. In the Advanced Search Thesaurus dialog box, type the word in the Find Synonyms for
box that you want to delete.
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4. Click the Edit Case Synonyms button.

5. In the Edit Case Synonyms dialog box, select the word you want to delete and press
Delete twice to remove the word and the space in the list.

6. Click OK to save your changes.

7. In the Advanced Search Thesaurus dialog box, click Close.

8. In the Full Text Search dialog box, click Cancel.

Related Topics

About advanced searching

Using search operators

About the Search report

TextMap can prepare a Search Report from any full-text search that you run. The Search Report
includes the search and highlights the terms located in the transcript. To print a Search report,
click the Reports ribbon or the Search ribbon and then click Search Report to open the Search
Report Wizard. Complete the steps outlined in the wizard to complete the report.

For more information, see Printing a Search report.

Related Topics

Running full-text searches

Saving searches

Printing a Search report

Annotating Transcripts

About annotations

After transcripts have been imported into TextMap, they are ready to be analyzed and
annotated. During this process, you will select phrases, sentences and paragraphs, and
comment on them. You will also use TextMap to categorize text selections and attach files.

Any note that you can put on a sticky note, you can create in TextMap. Add annotation notes to
explain why a section is important, mark a section to research further, or flag a certain section
as important to build or refute your case. You can create a list of claims and arguments related
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to a case and then categorize notes related to the issues. You can also import an issues list
that you created in CaseMap or import a list of opposing designations.

In TextMap, all issues are initially set to the default color yellow. You can assign each issue a
color so that it can be easily identified when scrolling through the transcript. For instance, you
could color code all research items red to be easily recognizable. See About case issues and
Creating case issues.

Annotations that overlap each other will display colored bars to the left of a transcript. Each
color represents the issue color designated for the annotation and shows where each
annotation begins and ends.  

Annotations also display in the Annotations pane where they can be sorted and filtered. You
can also view annotations in the Annotation Detail pane. See Viewing annotations and Filtering
annotations.

Switch annotation modes to save time

TextMap offers three annotation modes to help you simplify the annotation process,
depending on how you want to work. Each time you open a case in TextMap, the TextMap
Default Annotation Mode dialog box displays, unless you select the Don't show again check
box. You can change annotation modes at any time by clicking the Annotation menu and
then clicking the desired mode. You can also click on the Annotations button on the Text &
Video Tools Options ribbon or use the right-click menu. Manual Mode is the default
annotation mode.
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Annotation modes include:aw

Manual (Auto Off) allows you to choose whether to apply the annotation in Annotate in
TextMap or Auto Send to CaseMap mode.

Auto Annotate in TextMap displays the New Annotation dialog box for entering notes or
linking to issues or files before you choose to send the annotation as a new fact to
CaseMap.

Auto Send to CaseMap creates a new annotation and displays the Send to CaseMap
dialog box, skipping the New Annotation dialog box.

To quickly determine what mode you are using, you can look at your mouse pointer indicator
as you annotate text.

Annotation mode indicators include:

No Indicator — Manual Mode

Text Balloon — Auto Annotate in TextMap

Column — Auto Annotate in CaseMap

Learn about annotations in reports

When printing reports, the annotation will reference the line(s) where the partial annotation
is created in the transcript.

You also have the option to highlight the entire line in reports. Click Print, and then click
Page Setup. Click the Annotations tab and in the Highlighting area, select the check box.
This allows you to highlight the entire line when creating and printing annotation reports.
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Learn about overlapping annotations in reports

Overlapping annotations bars print in full-size and condensed reports, single or multiple
transcripts. In full-size reports, colored annotation bars display to the left of the transcript
text up to one quarter of an inch or approximately six bars deep. 

The overlapping annotation feature is turned on by default but can be turned off from the
File menu by clicking Print, and then click Page Setup. Click the Annotations tab and clear
the overlapping check boxes.
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Related Topics

About case issues

Creating case issues

Creating annotations

Viewing annotations

Changing page setup options

Sending annotations as Sanction media clips

Creating annotations

Annotations are easily applied to transcripts simply by selecting the text you want highlighted.
You can select and annotate the entire line in the transcript as well as select and annotate
partial lines in the transcript. Annotating partial lines allows you to select the exact area of
testimony as needed. See Changing page setup options for information on settings for
highlighting the entire or partial line when printing annotation reports.

Annotated text displays in color on the transcript in the default color of yellow. If you want to
add an annotation to text that is already highlighted, simply select text over an existing
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annotation and continue dragging your mouse pointer until you have all text you want
highlighted. The overlapping annotation will display in yellow (by default) unless you choose to
link it to another color-coded issue. Annotations linked to issues display the color of that issue
code.

Overlapping annotations display colored, vertical bars to the left of the transcript text with each
bar spanning the length of the selected text. Each issue color bar stacks beside the next so
you can easily see where one annotation starts and the next one begins. Issue color bars for
the newest created annotation will display to the right, closest to the transcript text. 

You can point to the issue color bar to display any linked notes and annotations.

A paperclip icon displays in the left margin of the transcript to indicate that those annotations
have a linked file associated with them.

Overlapping annotation bars can also be printed in both full-size and condensed reports, as
well as single or multiple transcript and end note options. In reports, colored annotation bars
display to the left of the transcript text up to 1/4 inch. This feature is turned on by default, but
can turned off in the Annotations tab in the Page Setup dialog box.

If color annotations are too hard on your eyes during transcript review, you can hide the
highlights during the review session. Issue color bars remain visible to easily identify where
annotations occur in the transcript.  Toggle this feature on or off from the View ribbon by
clicking Highlight Annotations.

If you color-code an issue black, the transcript text will appear as redacted in a printed
hard copy. The text is still available for viewing in a PDF if the selection is copied to the
Clipboard and pasted into another application for viewing.

To manually create annotations

1. Perform any necessary searches needed to locate transcript text.

2. In the TextMap window, highlight the transcript section you want to annotate.

3. Right-click the selected text and click Annotate in TextMap.

You can also click the New Annotation button located on the Text & Video Tools ribbon. 

The New Annotation dialog box opens.

4. On the Note tab, type in any notes you have regarding the annotated text.

5. Click OK when you are finished or click on a tab to link the annotation to case issues or
document files.

To link annotations to case issues

1. In the New Annotation dialog box, click the Linked Issues tab.
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If you have closed this box, double-click on the annotation in the Annotations pane.

2. Select the issue check boxes for primary and sub-level issues you want to link to the
annotation.

The Linked Issues tab automatically displays the last issue selections to minimize issue
selection when creating annotations.

Click on the Issues Option button  to select one of the following:

Select All Issues to place a check mark beside all issues

Unselect All Issues to remove the check mark beside all selected issues

Manage Issues to open the Case Issues dialog box.

If an annotation is linked to more than one issue, the color of the issue that's the
highest in the issue outline hierarchy (that is not the default color) will be applied to the
annotation.

3. Click OK to save your selections.

The selected issues now display in the Linked Issues column in the Annotations pane.

To link annotations to files

1. In the New Annotation dialog box, click the Linked Issues tab.
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If you have closed this box, double-click on the annotation in the Annotations pane.

2. Click on the Linked Files tab, and then click the Add button.

3. On the New Linked File Wizard's Welcome page, click Next.

4. On the New or Existing Document page, choose whether to link to a new or existing
document file.

To link to a new document

1. If you select Yes, I want to link a new document to this case, then the Document
Type page displays.

2. In the Document Type page, select the type of document for which you want to link:
File, Web Address, Document linked in CaseMap, or Custom Link.

3. Click Next to continue.

4. On the New Exhibit Path page, click Browse. 

5. In the Open dialog box, navigate to the folder where the file is saved, select it and
click Open.

6. Click Next to continue to open the New Document Name page.

7. In the Name field, type in or edit the document name.

8. Under the question Is this document an exhibit?, click Yes or No.

9. Click Next to continue.

10. On the Completing the New Linked File Wizard page, review the selected file, then
click Finish.

To link to an existing document

1. If you select No, I want to link to an existing linked document, then the Select
Document page displays.

2. In the Select Exhibit box, click on the file for which you want to link the annotation,
then click Next.

3. On the Completing the New Linked File Wizard page, review the selected file, then
click Finish.

5. In the New Annotation dialog box, click OK to save your selections.

To view annotation update history

1. In the New Annotation dialog box, click the Update History tab.

If you have closed this box, double-click on the annotation in the Annotations pane.

The tab lists who created the annotation and the date/time, as well as who updated the
annotation and the date/time.
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To change the annotation default color

The default annotation and case issue color are the same.

1. On the File menu, click Case Setup and then click Case Issues.

2. In the Color list, under Default Issue Color, click on the color you want.

3. Click Close to save your changes.

To turn off annotation highlights

On the View ribbon, click Highlight Annotations so that menu item displays as unchecked.

The Highlight Annotations feature is enabled when a check mark displays next to the menu
option and is automatically turned on by default. The setting change only applies to the
current TextMap session. The next time you open a case in TextMap, the annotation color
highlights will display.

Related Topics

About annotations

Viewing annotations

Filtering annotations

Editing annotations

Moving annotations

Changing annotation owner status

Deleting annotations

Viewing annotations

Annotations displays in the Annotations pane directly above the TextMap window where
transcripts are viewed. For each annotation in the Annotation list, the page/line number, any
notes, linked case issues, whether it was sent as a new fact to a corresponding CaseMap case,
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the annotated text, who created it and the time stamp is displayed.

The Annotations pane also displays a count and filter status in the top right corner allowing you
to see at a glance how many annotations exist for the current transcript and whether a filter is
running. The count and filter status immediately update as you view different transcripts, run or
cancel filters, and add or delete annotations.

The Annotation Detail pane allows you to view the full note and all linked case issues. By using
the navigation icons you can quickly navigate through all annotations in the selected transcript.
An Annotation Actions pane contains links for editing annotations and quickly accessing the
corresponding fact record in CaseMap. See annotation details below.
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To navigate annotations

You can navigate a transcript's annotations in multiple ways:

Click on an annotation to view, and then on the Create & Edit ribbon, click on the
Navigation Annotation icons to navigate through all annotations in a selected transcript.

In the Annotations pane, click on an annotation to view the applied annotation in the
transcript.

In the Annotation Detail pane, click on the navigation icons 
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 to navigate through all annotations in a
selected transcript and view the applied annotation in the transcript. With the
Annotation Detail pane open, you can also view the full note and all linked issues. See 
annotation details.

To view annotation details

1. In the Transcripts pane, click on the transcript you want to review.

2. In the Annotations pane, click on the annotation for which you want to view details.

3. In the Navigation pane, click on the Annotation Detail button.

The Annotation Detail pane displays in the Navigation pane.

4. In the Annotation Properties pane, click on the applicable navigation icon(s) 

 to navigate through all annotations in the
selected transcript.

5. In the Annotations Actions pane, click on a link for the action you want.

Edit Annotation displays the Edit Annotation dialog box, where you can view notes or
link to a case issue or file.

CaseMap - New Fact launches the Send to CaseMap tool, sending the selected
annotation as a new fact to a corresponding CaseMap case. The new fact record in the
CaseMap Facts spreadsheet will have a link to the current annotation in the TextMap
case. By default, the text and page/line information is sent. The annotation will
indicate Yes for the Linked Fact column in the Annotations pane and the Linked Fact
section in the Annotation Properties task pane in the Annotation Detail pane.

Show Linked CaseMap Fact Detail displays the Fact Detail dialog box containing
information about the fact linked to the selected annotation. You can edit this
information and update the CaseMap case by clicking OK.

Go to Linked CaseMap Fact displays the CaseMap case in front of TextMap and
selects the fact record linked to the selected annotation.

6. In the Annotation Properties pane, review the page/line reference number, whether the
annotation is linked to a fact record in the corresponding CaseMap case, review the full
annotation note, and review any linked case issues.

Related Topics

About annotations

Creating annotations

Filtering annotations

Editing annotations
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Sorting annotations

The Annotations pane allows you to sort annotations by columns: Source, Note, Linked Issues,
Linked Fact, Text, Created By, and Creation Time Stamp. The default sort order is by page/line
number.

To sort annotations

1. In the Transcripts pane, click on the transcript for which you want to view annotations.

2. In the Annotations pane, click on the column you want to sort by.

For example, if you want to sort all annotations by linked issues, click on the Linked
Issues column.

All annotations now display by linked issues and in alphabetical order. An arrow displays
in the column indicating which column annotations are sorted by.

Related Topics

About sorting

About filtering

Viewing annotations

Filtering annotations

Filtering annotations

TextMap now allows you to filter annotations by creator or linked issues. To apply an
annotation filter, click the View ribbon and select Filter by Creator or Filter by Linked Issues. (No
Filter is the default view, where all annotations display). The selected filter is then applied to all
transcripts in the case for the current user session or until another filter option is selected.
When you close or re-open a case, any previously applied filters are automatically cleared. The
annotation filter status displays in the top right corner of the Annotations pane.

If you or another user deletes an annotation or issue while a filter is applied, it will be
deleted regardless.
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View filtering considerations

Reference the following table to learn about considerations that affect filtering.

Filtering Considerations

Filters Description

Filter by Creator Any new annotations added by other case users when the
filter is running only display if they match the current filter.

If there are no annotations for selected users, the
Annotations pane displays a message, Filter Excludes All
Annotations.

Case users who have been deleted will still display with
that designation. If an annotation has "unknown" as the
creator, you can assign it to another users. See Changing
annotations' owner status.

If the Filter by Creator menu item is grayed out, the case
does not currently have any users.

Filter by Linked Issues Annotations created or edited when the filter is running
only display if they match the current filter.

If you select a parent issue, all child issues are also
selected. Clear the check box for any issue you do not want
in the filter.

If an issue filter is already applied, those issues will already
be selected in the Filter Annotations by Linked Issues
dialog box.

If there are no annotations for selected issues, the
Annotations pane displays a message, Filter Excludes All
Annotations, and the Filter by Annotations by Linked Issues
dialog box displays a message, There are no issues in this
TextMap case.

To filter by creator

1. On the View ribbon, click Filter by Creator on the Filter Annotations tab.

2. In the Filter Annotations by Creator dialog box, select one or more users to filter by.
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3. Click OK to apply the filter.

Only annotations by selected users now display in the Annotations pane.

The information bar in the top right corner of the Annotations pane now displays the
number of annotations filtered and total annotations in the transcript.

To filter by linked issues

1. On the View ribbon, click Filter by Linked Issues on the Filter Annotations tab.

2. In the Filter Annotations by Linked Issues dialog box, select the check box for each
issue you want included in the filter, then click OK.

You can also right-click to check or clear all issues.
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Only annotations linked to the selected issues now display in the Annotations pane.

To clear an annotation filter

1. On the View menu, click No Filter on the Filter Annotations tab.

The previous filter is now removed from all transcripts in the case.

If you select another filter option, the previous filter is cleared and the new filter is
applied.

Related Topics

About annotations

Creating annotations

Viewing annotations

Sorting annotations

Editing annotations

Annotations edits can made be in the Edit Annotations dialog box. You can edit notes, linked
issues and files, and view update history. Click OK to save any changes.



Using TextMap 187

© 2017 LexisNexis. All rights reserved.

You can access the Edit Annotation dialog box five ways:

Double-click the annotation in the Annotations pane.

Right-clicking an annotation in the Annotations pane or in the transcript and then click Edit
Annotation.

Click the Edit Annotation link in the Annotation Detail pane under Annotation Actions.

Click the issue color bar in the Transcript window.

Select the annotation in the Transcript window and click Edit Annotation on the Create &
Edit tab located on the Text & Video Tools ribbon. 

Related Topics

About annotations

Creating annotations

Moving annotations
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Changing annotation owners

The Change Annotations' Owner wizard allows you to change the creator or owner of an
annotation from one case user to another. This feature is helpful when a staff member is no
longer working on the case or you have new a staff member and need to re-assign an
annotation to new owner. It's also beneficial when you have imported new transcripts that
display a Created By status of "unknown" in the Annotations pane. You can then assign the
annotation to a case user for tracking purposes.

When you change the annotation owner status, the change affects the whole transcript. You
cannot change the owner status for individual annotations within a transcript.

To change an annotation owner to another user

1. On the Case Tools ribbon, click Change Annotations Owner.

If this menu item is grayed out, you do not have permission to change annotation owner
status or there are no users in the case.

2. When the wizard launches, click Next.

3. On the Select Transcripts page, select the transcripts that include annotations you
want to change.
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4. Click the Modify button to select the transcripts for which annotations will change.

In the Select Transcripts dialog box, select the transcripts in the Available box that you
want to add or select transcripts in the Selected box that you want to remove. 

Use the Item button to move the transcripts accordingly, then click OK.

5. Click Next to open the Select Staff Members page.
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6. In the Current annotations' owner list, click the name of the person that created the
annotation.

7. In the New annotations' owner list, click the name of the user you want to assign the
annotation to.

8. Click Next to continue.

9. On the Ready to Change page, review your annotation owner change selections and
how many transcripts are affected, then click Next.
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10. On the Completing the Change Annotations' Owner Wizard page, review how many
annotations were updated, then click Finish.
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The annotation owner is now updated in the Created By column in the Annotations
pane.

Related Topics

Creating annotations

Editing annotations

Importing annotations

The Import Annotations Wizard allows you to import annotations from a comma delimited text
file (.csv) file saved from a Microsoft® Excel spreadsheet without having to do it manually. The
Import Annotations Wizard can import multiple annotations into multiple, existing transcripts.
The wizard imports page/line number and note designations, and allows the ability to link
issues to imported annotations so they can be tagged.

In order to successfully import annotations, the .csv file's columns must be in the following,
specified order: Transcript Name, Page From, Line From, Page To, and Line To. The file may also
include the Notes and Issues column (optional). This list of issues should be separated by
semicolons. The wizard's Welcome page includes a link to view a sample import file (shown
below).
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If you import the same .csv file twice, you will duplicate content in the case. The Import
Annotations Wizard will display an Import Errors page if some annotations fail to import.
We recommend that you save this information to a file, resolve the errors, and then import
the skipped annotations as a separate .csv file.

If an annotation in has "Unknown" listed in the Created By column, it may be an imported
annotation. These annotations can be assigned to a case user after the import. See 
Changing annotation owner status.

To import annotations into existing transcripts

1. On the Home ribbon, click More Import, and then click Import Annotations.

You can also click Import on the File menu, and then click Import Annotations.

2. When the wizard launches, click Next.
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3. On the Import File page, click Browse to locate the file you want to import.
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4. After the selected file and path of the file(s) being imported is displayed in the wizard,
select/deselect all applicable options (e.g., First line contains field headers), to indicate
what (i.e., notes, issues) is in the file(s) being imported):

First line contains field headers -- The first line of the import file contains the field
headers (i.e., Transcript, Pg From, Ln From, etc.) and not the first annotation.

Includes Notes field -- Import file includes a field to list the note(s) associated with each
annotation.

Includes Issues field -- Import file includes a field to list the issue(s) associated with
each annotation.

These options must match what is in the import file in order for the annotations to
import correctly. If a check box (e.g., Issues or Notes) is not selected, it will not be
displayed in the Import Preview window.

5. Click Next to display the Import Preview page.

6. On the Import Preview page, review the annotations selected for import, then click
Next to start the import process.
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Since the Include Notes field option was not selected in Step 4, only Issues are
displayed in the Import Preview window.

If any annotations cannot be imported (e.g., transcripts with the same name), the
wizard displays an Import Errors page listing all annotations that did not successfully
import.
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7. Optional: Click the Save button to save a list of the import error list for future reference.

8. Click Next to continue.

9. On the Completing the Import Annotations Wizard page, review the number of
imported annotations and those skipped due to errors, then click Finish.
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The imported annotations now display in the Annotations pane. When you click on an
annotation in the Annotations pane, the transcript displays the annotated content with
the applicable issue code color, if issues were included were included in the .csv file.

Related Topics

About annotations

Creating annotations

Printing annotation reports

You can create annotation reports from single or multiple transcripts' annotations. Or you can
print Annotation Digest ReportBooks, which include the annotations and notes from a set of
ReportBooks that can be filtered by issue. Using the Annotation Digest Wizard, you can also
customize the order of annotations and decide whether to include linked CaseMap facts.

For more information, see the following topics:

Printing single transcripts

Printing multiple transcripts
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Printing Annotation Digests

Related Topics

About annotations

Creating annotations

Viewing annotations

Moving annotations

If an annotation was not applied properly, you can simply move it to the right page/line location
in the transcript.

The issue color bar will display in the new location.

To move an annotation

1. In the Transcripts pane, click on the transcript for which you want to view annotations.

2. In the Annotations pane, right-click on the annotation you want to move.

3. On the sub-menu, click Move Annotation.

You can also click the  button located on the Text & Video Tools ribbon. 

4. In the Move Annotation dialog, select the new text for annotation.
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5. Click OK to move the annotation.

Related Topics

Creating annotations

Editing annotations

Deleting annotations

Once an annotation is deleted from a transcript, it is permanently removed from the case.
Removing annotations from TextMap does not delete any corresponding fact records in
CaseMap.
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To delete a single annotation

1. In the Annotations pane, click on the annotation(s) you want to delete.

Press the Shift key while clicking the annotations to select more than one.

2. Right-click the annotation and then click Delete Annotation.

You can also click the annotation in the transcript, click Delete in the Text & Video Tools
ribbon, and then click Delete Annotation.

3. In the message box, click Yes.

All annotations are permanently deleted from the transcript.

To delete all annotations in a transcript

1. Click Delete in the Text & Video Tools ribbon, and then click Delete All Annotations.

2. In the message box, click Yes.

All annotations are permanently deleted from the transcript.

Related Topics

Creating annotations

Editing annotations

About the case index

Sending facts to CaseMap

Sending facts to CaseMap

We encourage you to use CaseMap from the first day you begin working on a new matter.
When you use CaseMap in conjunction with TextMap, you can enter new facts well in advance
of having court-appropriate sources for these fact records. And you can always update the
existing fact records while working in TextMap. Later, when you find a source for a given fact as
you review a transcript, you can update the pre-existing fact.

TextMap is designed so you can optionally perform all basic data entry about a fact in the midst
of sending a transcript passage to CaseMap. These options are available in the dialog boxes
that display when you send a new fact to CaseMap or update an existing one. For each
transcript passage sent to CaseMap, TextMap automatically creates a source that references
the transcript and the page and line numbers of the selection. You must have the related
CaseMap case already open in order to send transcript annotations from TextMap to CaseMap.

You can tell which annotations have already been sent to CaseMap by checking the
Annotations pane at the top of the page. The Linked Fact column has a Yes/No status indicator
for each annotation. Annotations with a Yes have been sent to CaseMap. The CaseMap fact
automatically links back to the selected passage in the transcript. If the fact has already been
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sent a message displays asking if you want to re-send the annotation (it replaces the link to
the existing fact).

If you intend to send multiple annotations to CaseMap, consider switching to the Auto Send to
CaseMap annotation mode. Click the arrow next to the Annotate in TextMap button or click the
Annotations menu, and then click Auto Send to CaseMap. Each time you annotate transcript
text the Send to CaseMap dialog box automatically launches, skipping the New Annotation
dialog box.

If your organization uses CaseMap, follow those established guidelines for creating short
names in CaseMap. If you do not understand the concept of short names, please refer to
the CaseMap Answer Center.

Once you have sent annotations to CaseMap, you can use options on the Annotations
menu to instantly jump to a selected annotation's associated fact in CaseMap or display a
Fact Detail window with information about the associated fact. Right-clicking an annotation
in the Annotations pane opens a shortcut menu with the same CaseMap-related options.

Some organizations install program files on servers, along with the case files. If your
organization installs CaseMap and TextMap on a server, these programs must be installed
on the same server in order for the links to hold. Additionally, if you move a TextMap case
file that contains links to a CaseMap case, you could break the link to the CaseMap record.
See Moving cases and Managing/changing file locations topic to plan the case file move
beforehand.

To send annotations to CaseMap

1. In CaseMap, open the corresponding case.

2. In TextMap, select the transcript text you want to send as a new fact to CaseMap.

3. Select/highlight the annotations to be sent to CaseMap, and on the Text & Video ribbon,
click the Options tab.

4. On the Options tab, click Send to CaseMap.

You can also right-click on the selected text and click Send To, and then click CaseMap -
New Fact.

The Send to CaseMap - New Fact dialog box displays.

5. In the Step 1. Link this Proceeding to CaseMap dialog box, review the information that
is automatically filled in for you, and then click OK.
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Notice that the transcript content displays in the Text Selection box. Do not delete these
brackets as they help link it to the source file. Fact Text is also selected in the Append
Text Selection to list and the deposition is listed in the Source(s) field. Any annotation
notes display in the Fact Text field.

If you have already sent an annotation from this transcript to CaseMap, the Step 1. Link
this Proceeding to CaseMap dialog box does not display.

You can also send note text to CaseMap after an annotation is already sent. Notes are
added to the Fact Text field as mentioned above. If you add more than one note to an
annotation, the annotation and its new note are added to the Facts spreadsheet as a
new fact record.

5. Click the Advanced link if you also want to add the transcript as an object in CaseMap's
All Objects and Proceedings spreadsheets.
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Click the Save & Edit button to open the Edit Proceeding dialog box and enter additional
information about the new object record, such as the type and status of the document,
and any attendees present.

6. In the Step 2 Edit the CaseMap Fact dialog box, review the information that is
automatically filled in for you.
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Notice that the transcript content displays in the Text Selection box. Do not delete these
brackets as they help link it to the source file.

Also notice that the Append Text Select to box automatically lists the Fact Text field. You
can select other columns on the spreadsheet to receive the text or click "Do Not Append"
if you're entering a summary of the fact and simply want to refer back to the actual text
when necessary.

Annotation notes display in the Fact Text box and will display in the Fact Text field in the
Facts spreadsheet directly under the annotated text in brackets. You can turn this option
off from the Tools menu by clicking Options and then clicking the Annotation tab. Next
clear the Use Annotation Note for new Fact Text check box.

The deposition is listed in the Source(s) field.

7. Enter additional information about the new fact record, such as the date and time,
whether the information is a key fact, and its current status.

8. Click the Issue Linker bar to link to case issues in the CaseMap case.
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9. Click OK to continue.

10. In the message box, click Yes to view the new fact record in CaseMap.

11. In CaseMap, locate the new, highlighted fact record in the Facts spreadsheet.

12. In the Facts spreadsheet, click the Paperclip icon for the new fact record to view the
linked path to the transcript in TextMap.

13. Click the file path to review the TextMap transcript.

In TextMap, the transcript opens to the page/line number of the annotation.

14. In the Annotations pane, notice that the Linked Fact column now contains Yes,
indicating that the excerpt is a linked fact in CaseMap.

To remove an annotation's fact link

You can remove annotation links to fact records in CaseMap. Annotations in the transcript
will remain. Deleting the links in TextMap does not delete the fact records in the CaseMap
case.

1. Select the annotation(s) in the transcript or in the Annotations pane.

2. Click Options on the Text & Video Tools Options ribbon, and then click Advanced.

3. On the submenu, click Remove Fact Link.

4. In the message to remove the CaseMap link, click Yes.
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Related Topics

About annotations

Creating annotations

Updating existing facts in CaseMap

Updating existing facts in CaseMap

Once annotations have been sent as new facts to CaseMap, you can still update these existing
fact records while working in TextMap. For example, when reviewing a transcript you might
locate the source for the fact you already sent to CaseMap. You can easily update the fact
record with this information.

You must have the related CaseMap case already open in order to update existing fact records
in CaseMap. You must also select the fact record that you want to update.

To update existing fact records in CaseMap

1. In CaseMap, open the corresponding case for which you want to update fact text.

2. On the CaseMap Facts spreadsheet, select the fact record for which you want to add an
additional source.

3. In TextMap, select the case transcript you are working with by clicking its name in the
Transcripts list.

The transcript text you want to send to CaseMap must first be an annotation in TextMap.
If it is not annotated text, highlight the transcript text and then right-click on it and click
Annotate in TextMap. You can type in a note or link to case issues too. Click OK to save
the annotation. See Creating annotations.

4. Click Options on the Text & Video Tools ribbon, and then click Advanced.

5. On the submenu, click Update Existing Fact in CaseMap.

6. In the message to replace the existing link to the fact record, click OK.

7. In the Send to CaseMap - Edit Fact dialog box, verify that the transcript text displays in
the Text Selection box.

8. Complete additional field information for the fact record, then click OK.

The fact record is now updated in CaseMap and a link back to the annotated text is now
set to its page/line number in the transcript in TextMap.

You can link multiple annotations to the same fact record in CaseMap using the
procedures above.
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Related Topics

About annotations

Creating annotations

Sending annotations to CaseMap

Exporting annotations

Using the Export Annotations Wizard, you can export annotations from one or more transcripts
to a .csv file that can be viewed in Microsoft® Excel. Using the wizard, you can:

Select the transcripts from which you want to export annotations

Limit the annotations included by issue

Choose the storage location/output file

To export annotations to a .CSV file

1. In the Transcripts pane, select a transcript, and then select the annotation you want to
export.

2. Click More Export on the Home ribbon, and then click Export Annotations.

On the File menu, you can also click Export, and then click Export Annotations.

3. In the Export Annotations Wizard, click Next.

4. On the Select Transcripts page, select the transcripts that have annotations you want
to export.
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The transcript now displays in the Transcript pane now displays in the export wizard.

The default transcript is the current, active transcript.

4. Optional: To modify the transcript list:

a) Click the Modify button to add more transcripts to the export.

The Select Transcripts dialog box opens.

b) In the Available Transcripts box, select the check box beside the transcript you
want to add.

When an item is selected, it is added to the Selected Transcripts area of the Select
Transcripts dialog box.

c) Optional: Click the Select All check box to add all transcripts in the Available box.

d) Click OK to close the dialog box.

5. Click Next to display the Limit Annotation by Issue dialog box.
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6. On the Limit Annotations by Issue page, select one of the following:

To include all annotations

a. Select  the Yes, include all annotations check box to export all annotations.

b. Click Next.

To include only annotations linked to issues

a. Select the No, only include annotations linked to the selected issues check box
to include only the  annotations that are linked to the issues that are selected
here.

b. In the Select issues to include area, select the check box(es) for all annotations
to be included in the export.

c. Click Next.

7. In the Optional Annotations Fields dialog box, select the field(s) to be included with the
exported annotations:
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Notes -- Include a field to list the note(s) associated with each annotation.

Issues -- Include a field to list the issue(s) associated with each annotation.

Video Duration --  Include a field to list the length of the video clip.

8. Click Next to continue.

The Output File dialog box opens.

9. Click the Browse button to choose a file name and storage location.

10. In the Export Annotations dialog box, navigate to the folder where you want to save
the .CSV file.

This folder defaults to the export folder selected in the File Locations tab in the Tools >
Options dialog box.

12. In the File Name field, type in a name for the .CSV file, and then click Save.

13. On the Output File page, click Next to
initiate the export.

The Completing the Export Annotations Wizard displays the number of annotations
exported.

14. Optional: Click the hyperlink to view the output file.

The exported annotations can be viewed in Microsoft Excel. Transcripts display in
alphabetical order.
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15. Optional: To calculate video clip duration, perform the following:

Calculating the total video duration is very beneficial when it comes to determining if you
are within the allotted time when making presentations.

a. In the Completing the Export Annotations Wizard dialog box,  click the Click here to
open the output file hyperlink.

      The output file opens in Microsoft® Excel®.

b. In the Excel spreadsheet, place the cursor below the last entry in the Video
Duration column and click the Auto Sum button.

      The total duration time is displayed.

c. Save and close the Excel spreadsheet.

16. Click the Finish button to close the wizard.

Related Topics

About exporting

Exporting transcripts

Exporting data to an iPad

Exporting a Sanction clip list

The Export Sanction Clip List Wizard allows you to export a transcript's annotations by select
issues to a Sanction clip list. TextMap skips any annotations that are not linked to a selected
issue. Once the text file is exported, you can then import the clip list into Sanction. Annotations
display in the text file in page/line order.

To export a Sanction clip list

1. In the Transcript pane, select the transcript for which you want to export annotations.

2. Click More Export on the Home Ribbon, and then click Export Sanction Clip List.

On the File menu, you can click Export, and the Export Sanction Clip List to open the
wizard.

3. In the Export Sanction Clip List Wizard, click Next.
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4. On the Limit Annotations by Issue page, you can choose to only export annotations to
the linked issues you select.

5. Click Next to continue.

6. On the Output File page, click the Browse button.

7. In the Export Sanction Clip List dialog box, navigate to the folder where you want to
save the file.

The default file type is a text file.

This folder defaults to the export folder selected in the File Locations tab in the Tools >
Options dialog box.

8. In the File Name field, type in a name for the text file, then click Save.

9. On the Output File page, click Next to initiate the export.

10. Click the hyperlink to view the output file.

The clip list now displays in a text file.

11. Click the Finish button to close the wizard.

You can now import the text file into Sanction.
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Related Topics

About exporting

Exporting annotations

Exporting videos

Sending annotations as Sanction media clips

TextMap® allows you to send a single annotation, or bulk send all annotations that contains

video to the LexisNexis® Sanction® application as media clips.

To send an annotation to Sanction as a media clip

1. Open a case in Sanction® 3.5 or later.

2. In the Transcripts pane, select a transcript from the list that has both annotations and
video.

The video icon  indicates a transcript with video.

3. Click on the annotation to be sent to Sanction.

4. On the Create & Edit tab of the Text & Video Tools ribbon, click More, and then click
Send Media Clip to Sanction.

You can also right-click on the annotation to be sent, select Send To, and then click
Sanction - New Media Clip. 
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 If adjustments have been made to the start and stop times of a video, those adjustments will be
retained when the media clip(s) are sent to Sanction. See Editing videos for additional
information.

To bulk send annotations as Sanction media clips

1. Open a case in Sanction® 3.5 or later.

2. In the Transcripts pane, select a transcript from the list that has both annotations and
video.

The video icon  indicates a transcript with video.

3. Select the annotations to be sent to Sanction to display the Text & Video Tools ribbon.

4. On the Options tab, click Send Multiple Media Clips.

You can also right-click on the annotations to be sent, click Send To, and then click
Sanction - Multiple Media Clips. 

5.  In the Send Multiple Media Clips to Sanction dialog box, perform all applicable steps:
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To select multiple transcripts

a. In the Select Transcripts dialog box, click Transcripts Groups to list transcripts by
groups, or click Individual Transcripts to list transcripts individually.

For this example, Individual Transcripts is selected.

b. In the Available Transcripts column, place a check mark beside the transcript(s)
to be sent to Sanction.

Optional: Place a check mark in the Select all check box to simultaneously select all
transcripts.

c. Click OK to display the Send Multiple Media Clips to Sanction dialog box.

To send media clips by issue
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a. In the Send Multiple Media Clips to Sanction dialog box, click Select issues to
open the Select Issues dialog box.

b. In the Select Issues dialog box, select (place a check mark) beside the issue(s)
associated with media clip(s) to be sent to Sanction.

c. Click OK to display the information being sent to Sanction.

The issues selected here are recalled the next time the Send Multiple Media Clips
to Sanction dialog box is opened, unless otherwise changed.

d. Optional: Click Include all annotations to deselect the issues selected in the step
above and to return to sending all annotations to Sanction.

e. Click OK to continue.
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Related Topics

About transcripts

About annotations

Sending transcripts to Sanction

Editing videos

Working with Exhibits

About exhibits
Exhibits can be files on your computer, web addresses, and custom links to other document
management programs. When you have a file that has been referred to as an exhibit during a
transcript, you want that file to be linked wherever that exhibit is referred to in the transcript.
You can link to exhibits using either the TextMap Exhibit Linker or the Auto Link Exhibit Wizard.

Link Exhibit Wizards include:

TextMap Exhibit Linker is used before importing transcripts into a TextMap case. This
software is provided to court reporters, vendors, and law firm staff so that they can create
TextMap Exhibit Packages (.xmef) which can then be imported into TextMap. These files
already have the exhibit links embedded in the transcripts. TextMap also imports the linked
exhibit PDFs during the import process.

Auto Link Exhibit Wizard is used once a transcript is imported into TextMap. With the Auto
Link Exhibit Wizard, you can create a hyperlink to a file on your computer, a web address, or
a link to another document management system everywhere in the transcript where the
exhibit is mentioned.

The Exhibit Autolink Aliases tool is used to configure aliases on a per-case level to find
automatic links within a transcript. Once the aliases have been created, you can bulk link
exhibits to the selected transcript using the Auto Link Exhibit Wizard. See Creating exhibit
autolink aliases.

Hyperlinks for exhibit files display in the Exhibits and Video pane in the Exhibits pane for the
selected transcript. When you click a page and line reference, TextMap displays that point in
the transcript. You can view the exhibit by clicking the hyperlink in the transcript or by right-
clicking on the exhibit link in the Exhibits pane and clicking Open. You must have the native
application installed on your computer in order to view the file. See Adding/changing file
viewers.

Exhibit files that do not create transcript hyperlinks appear in the Exhibits and Video pane as
non-hyperlinked exhibits and are copied to the case transcript exhibit folder. Hyperlinks can be
created at a later time by updating the Exhibit Properties. See Editing exhibits.

Exhibit files should be saved to a network folder to ensure that all case users have access to
the files. For more information about file paths for both local and SQL cases, see Changing the
case exhibits path.

To link exhibits or any other files to a single passage in the transcript, use the New Hyperlink
Wizard. See Creating single hyperlinks in transcripts.
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If you move exhibit files linked to a transcript, you will need to change the file paths in
TextMap in order to preserve the hyperlinks. See Changing exhibit file paths.

If you are working on a case while out of the office, create a replica case so you have
access to all linked files and exhibits. Web sites and links to files in a document
management systems will not transfer to a replica case. See Creating replica cases.

Related Topics

Using TextMap Exhibit Linker

Importing exhibit packages

Linking exhibits to transcripts

Viewing exhibits

Editing exhibits

Verifying linked exhibits

Changing exhibit file paths

Changing case exhibits path

Creating exhibit autolink aliases

Using TextMap Exhibit Linker

Using TextMap Exhibit Linker

TextMap Exhibit Linker is tool used before you import transcripts into a TextMap case. This
software is provided to court reporters, vendors, and law firm staff so that they can create
TextMap Exhibit Packages (*.xmef), which can then be imported into TextMap. This simplifies
the process of adding hyper-linked exhibit files to an ASCII or PTF text file of a deposition or
other transcript.

TextMap Exhibit Linker creates a word index from the imported transcript file. You can then use
the search pane to locate references to exhibits or other words. As you type a word, Exhibit
Linker searches for and displays "hits" for the search along with page/line references that are
hyperlinks to the word you're looking for. Place your mouse over a page/line reference and
Exhibit Linker will give you a preview of the context you will find if you click the hyperlink.

TextMap Exhibit Linker must be installed before you can import transcripts into the case. To
download TextMap Exhibit Linker, go to www.casemap.com/appsdownload. For more
information about the product, see www.casemap.com/textmap.

To use TextMap Exhibit Linker

These steps are an overview of the import process. In TextMap Exhibit Linker, click the Help
menu for complete instructions on how to use this software.

http://casemap.com/appsdown.asp
http://casemap.com/textmap/index.asp
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1. Open a transcript (ASCII text file).

2. Import linked exhibits to the file.

3. Save it in .xmef file format.

4. Email it to the user who imports the file into the TextMap case.

Related Topics

About exhibits

Linking exhibits to transcripts

Importing exhibit packages

Changing exhibit file paths

Importing exhibit packages

TextMap Exhibit Packages (created by TextMap® Exhibit Linker) include a transcript, hyperlinks
to exhibits mentioned throughout the text, and the linked exhibit documents. You import an
Exhibit Package file (*.xmef) just like any other transcript. All the exhibits and exhibit hyperlinks
in the transcript are available instantly.

When you import an Exhibit Package file (*.xmef), the following occurs:

It creates a folder and is stored in its own folder.

If the name of the transcript is longer than 80 characters, the folder created will also be
truncated at 80 characters.

When TextMap imports a transcript with a name of one that already exists, it and the
associated folder names are made unique by applying a number to the end.

Invalid characters are not allowed in the transcript name, and will be removed.

You can also import TextMap Exhibit Packages (*.xmef files) with linked exhibits into a SQL
case. During the import process, TextMap displays a message for you to select the exhibits
path folder for the case, if it has not already been set.

Exhibit files should be saved to a network folder to ensure that all case users have access to
the files. You can also set this path in the Case Properties dialog box, if you have permissions
to do so. See Changing exhibits file paths. If you choose not to set the exhibit folder path
during the import, the transcript will be imported into the SQL case without the linked exhibit
files.

To import exhibit packages with linked exhibits

1. On the Home ribbon, click Import Transcript.
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You can also click Import on the File menu, and then click Import Transcripts.

2. In the Select one or more Transcripts to Import dialog box, select the exhibits package
that you want to import, and then click Select.

3. In the Transcript Import Preview dialog box, review the transcript information and type
in any comments you want to track regarding the imported files.

TextMap searches the transcript and uses the first date it locates to automatically fill in
the Date field. You can modify this date, if necessary.

4. Click the Advanced button if you want to modify page numbering or review transcript
format details.

5. Click OK to continue.

When the import process is complete, the imported transcript displays in the Transcripts
pane and the exhibit files are copied into the case exhibits folder.

4. In the Navigation pane, click the Exhibits and Video button to display linked exhibits
and other documents included in the exhibit package.

Related Topics

About exhibits

Using TextMap Exhibit Linker

Changing exhibit file paths
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Creating exhibit autolink aliases

The Exhibit Autolink Aliases tool is used to configure aliases on a per-case level to find
automatic links within a transcript. Once the aliases have been created, you can bulk link
exhibits to the selected transcript using the Auto Link Exhibit Wizard.

Aliases can be imported and exported using a text file, or added and deleted using the Exhibit
Autolink Aliases tool.     

To create exhibit autolink aliases

1. Click the Case Tools tab, and then click Exhibit Autolink Aliases.

2. In the Exhibit Autolink Alias dialog box, click Add. 

3. Type the new alias name and then click OK.

The alias is added to the list of Autolink search templates. 
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4. Click OK to close the Exhibit Autolink Alias dialog box.

To delete exhibit autolink aliases

1. Click the Case Tools tab, and then click Exhibit Autolink Aliases.

2. In the Exhibit Autolink Alias dialog box, select the alias you want to remove, and then
click Delete.

The alias is removed from the list of Autolink search templates. 

3. Click OK to close the Exhibit Autolink Alias dialog box. 

Existing hyperlinks are not removed when the alias name is deleted. 

To import exhibit autolink aliases from a text file

1. Click the Case Tools tab, and then click Exhibit Autolink Aliases.

2. In the Exhibit Autolink Alias dialog box, click Import.

3. Navigate to the folder of the existing text file, select the file you want to import and then
click Open.

The imported alias names are added to the list of Exhibit autolink search templates. 

4. Click OK to close the Exhibit Autolink Alias dialog box.

To export exhibit autolink aliases to a text file

1. Click the Case Tools tab, and then click Exhibit Autolink Aliases.
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2. In the Exhibit Autolink Alias dialog box, click Export.

3. Navigate to the folder where you want to save the file and type the File name.

The default name is AutolinkAliases.txt.

4. Click Save.

The alias names are exported to the text file.

5. Click OK to close the Exhibit Autolink Alias dialog box. 

Related Topics

About exhibits

Linking exhibits to transcripts

Linking exhibits to transcripts

The Auto Link Exhibit Wizard is used once you have already imported a transcript into TextMap.
With this wizard, you can add multiple files, web addresses, or link to another document
management system anywhere in the transcript where the exhibit is mentioned. You can bulk
link exhibit files on your computer and web addresses, as well as add custom links to other
document management programs. You can even make a document in CaseMap a hyperlinked
exhibit in TextMap. 

To link exhibits or any other files to a single passage in the transcript, use the New
Hyperlink Wizard. See Creating single hyperlinks in transcripts.

To link a new exhibit to this case

1. In the Navigation pane, click the Exhibits and Video button.

2. In the Exhibit Tasks pane, click Link exhibits to this transcript to open the Auto Link
Exhibit Wizard.

3. On the Auto Link Exhibit Wizard's Welcome page, click Next.

4. On the New or Existing Exhibit page, select the option, Yes, I want to link a new
exhibit to this case, and then click Next.

5. On the Document Type page, select the type of document you want to link, and then
click Next:

To add Files:

To add Files, do the following: 

1. On the Bulk Link Multiple Files page, click the Add drop down arrow and then
click Add Files. 
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2. Navigate to the folder location where the files are saved.

3. In the Select One or More Exhibits dialog box, select the file(s), and then click
Open.

To Add URLs, do the following:

1. On the Bulk Link Multiple Files page, click the Add arrow and then click Add
URLs.

2. Enter the address of the web page for the new exhibit and then click OK.

To add files via the drag-and-drop operation, drag your selected files into the specified
area on the Bulk Link Multiple Files page.

To add a document linked in CaseMap:

1. On the Connect to CaseMap page, launch CaseMap and open the corresponding case
(if you have not already done so), and then click Next.

2. On the Select CaseMap Object page, select the file(s) you want to link, and then
click Next.
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To add a custom link:

1. On the New Exhibit Path page, click Open or Browse to navigate to the folder
location where the file is saved, and then click Open.
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2. In the File Viewer list, click the type of viewer you need for the file, and then click
Next.

3. On the New Exhibit Name page, type or edit the file name.

The contents of the Name box is automatically filled with the file name of the linked
file. TextMap searches the transcript for the name and creates a hyperlink to the file
at each location.

4. For the question, Is this document an exhibit?, click Yes or No.

If the document is not an exhibit it will display in the Exhibits pane under Other Linked
Documents.

5. On the Found References to Document page, review the number of references found
in the transcript.

If there are no references found, on the No References to Document Found page,
type in a word or phrase to link to this document, then click Next. TextMap
automatically creates links in the transcript where all instances of the word or phrase
is located in the transcript. 

6. Determine whether you want to add more words or phrases and select on one of the
following: 

Yes, I want to add more words or phrases to auto link.

1. On the Enter Words or Phrases to Auto Link page, type in a word or phrase
to auto link, and then click Add.
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2. In the message box, click OK.

3. Continue adding words or phrases until finished. 

No, I do not want to add more words or phrases to auto link.

Skip to Step 7.

By default, all files will be marked as exhibits. To change, click .

If the Exhibit name or Autolink ID need to be modified, click the Exhibit Name or
Autolink ID fields to modify. The Autolink ID will update based on the exhibit name.

Exhibit names and Autolink IDs must be unique and cannot be duplicated.

If the Link exhibit files with autolink aliases check box is selected, the hyperlink will
be created by pairing the Autolink alias with the Autolink ID.  If the box is not selected,
and there are no Autolink alias names defined, the hyperlink will be created from the
Exhibit name. 

6. Click Next. 

7. On the Completing the Auto Link Exhibit Wizard page, click Finish.
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To link an existing linked document to this case

1. In the Navigation pane, click the Exhibits and Video button.

2. In the Exhibit Tasks pane, click Link exhibits to this transcript to open the Auto Link
Exhibit Wizard.

3. On the Auto Link Exhibit Wizard's Welcome page, and then click Next.

4. On the New or Existing Exhibit page, select the option, No, I want to link to an
existing linked exhibit, and then click Next.

5. On the Select Exhibit page, select the file for which you want to link, and then click
Next.

6. On the Completing the Auto Link Exhibit Wizard page, click Finish.

When you click Finish, TextMap will open the Exhibit Properties dialog for the selected
exhibit. 

7. In the Exhibit Properties dialog box, enter a word or phrase to autolink to this
document, and then click Add. 

TextMap automatically creates links in the transcript where all instances of the word or
phrase is located in the transcript.

8. Continue adding words or phrases until finished, and then click OK.
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Related Topics

 

About exhibits

Using TextMap Exhibit Linker

Importing exhibit packages

Creating single hyperlinks in transcripts

Viewing exhibits

Creating single hyperlinks in transcripts

The New Hyperlink Wizard allows you to link an exhibit or other file anywhere in a transcript or
annotation. Using this wizard is helpful, after you have used the Auto-Link Wizard or received
files from your court reporter.

Linked files can be exhibit files on your computer, web addresses, and custom links to other
document management programs. Linked exhibits or other files can be added to a transcript
anywhere you want to link to them in the transcript. The document or file that you link to the
transcript or annotation may be an existing document already linked or a new document. It may
also be an exhibit. You can specify what type of document it is in the New Hyperlink Wizard. 

Linked files display under Other Linked Documents in the Exhibits task pane of the Exhibits and
Video pane, unless marked as an exhibit in the Exhibit Properties dialog box. See Editing
exhibits.

For more information on linking files when annotating, see Creating annotations.
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To link files to transcripts

1. Select the transcript text where you want to link to an exhibit.

2. Right-click on the text just selected, and on the menu, click Hyperlink, and then on the
submenu, click Insert.

3. On New Hyperlink Wizard's Welcome page, click Next.

4. On the New or Existing Document page, select whether to link to a new or existing
document, then click Next.
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Yes, I want to link a new document to this case

On the Document Type page, select the type of document you want to which you want
to link, and then click Next.

File

a. On the New Document Path page, click Browse to navigate to the folder
location where the file is saved.

b. In the Open dialog box, select the file and then click Open.

c. Click Next.

Web Address

On the New Document Web Address page, type in the web page address for the
document, then click Next.

Document Linked to CaseMap

a. On the Connect to CaseMap page, launch CaseMap and open the corresponding
case (if you have not already done so), then click Next.

b. On the Select CaseMap Object page, select the type of file for which you want
to link, then click Next.
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Custom Link

a. On the New Document Path page, click Open or Browse to navigate to the
folder location where the file is saved, then click Open.

b. In the File Viewer list, click the type of viewer you need for the file, then click
Next.

No, I want to link to an existing document

a. On the Select Document page, select the file for which you want to link, then click
Next.
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b. Skip to Step 7.

5. On the New Document Name page, type or edit the file name.

The contents of the Name box is automatically filled with the file name of the linked file.
TextMap searches the transcript for the name and creates a hyperlink to the selected
location.

6. For the question, Is this document an exhibit?, click Yes or No.

If the document is not an exhibit it will display in the Exhibits pane under Other Linked
Documents.

7. On the Completing the New Hyperlink Wizard page, click Finish.

Related Topics

About exhibits

Linking exhibits to transcripts

Creating annotations
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Viewing exhibits

View and navigate to hyperlinked exhibits in the Exhibits panel of the Exhibits and Video pane.
Linked files that are not exhibits display under Other Linked Documents in the same pane.

Exhibits automatically sort in alphabetical order, but you can also sort exhibits and video by
exhibit number.

You must have the native application installed on your computer in order to view the files. To
add an application as a file viewer in TextMap, see Adding/changing file viewers.

To view and open exhibits

1. In the Navigation pane, click the Exhibits and Video button.



TextMap236

© 2017 LexisNexis. All rights reserved.

2. In the Exhibits pane under Linked Exhibits, click the Expand button beside an exhibit to
view the list of transcript hyperlinks.

3. Click on a link to open the transcript to the page/line number where the text link is
located.

4. In the Transcript window, notice that a Paperclip icon displays next to the page/line
number.

You can also right-click on the Exhibit link and click Open.
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5. Click the Paperclip icon to view the hyperlink path for the linked file.

A pop-up window lists the exhibit location and the name and location of the linked file.
The name and location is hyperlinked to the file.

You can also click Open linked document in the Exhibit Tasks panel.

6. Click the hyperlink to view the file in its native application.

7. When you are finished viewing the file, click Close.

Related Topics

About exhibits

Linking exhibits to transcripts

Adding/changing file viewers

Importing exhibit packages

Editing exhibits

Editing exhibits involves editing exhibit properties, renaming a linked exhibit, adding words or
phrases to automatically link to previously non-hyperlinked exhibits, deleting a linked exhibit,
changing exhibit file paths, and verifying linked exhibits.

To edit a linked exhibit

1. On the Case Tools ribbon, click Linked Exhibits.
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2. In the Linked Exhibits dialog box, select the linked file you want to edit.

3. On the Linked Exhibits toolbar, click Edit.

You can also right-click on the linked file you want to edit, and then click Edit.

4. In the Exhibit Properties dialog box, edit the exhibit properties as needed.

5. In the Name field, edit the name of the linked exhibit.
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6. Under Path or URL, click Open or Browse to view a linked exhibit file path.

7. In the File Viewer list, click on the file viewer you want to use to view the file.

8. Click the Edit button to add, remove, edit, or change the default file viewer.

9. Select or clear This document is an exhibit check box as needed.

If an exhibit is not marked as an exhibit, then it will display under Other Linked
Documents in the Exhibits pane.

10. Click OK to save your changes.

To rename a linked exhibit

1. On the Case Tools ribbon, click Linked Exhibits.

2. In the Linked Exhibits dialog box, select the linked exhibit you want to rename.

3. On the Linked Exhibits toolbar, click Rename.

You can also right-click on the linked file you want to rename, and then click Rename.

4. In the Rename Exhibit dialog box, type in the new name, then click OK.

5. In the Linked Exhibits dialog box, click Close.

To delete a linked exhibit

1. On the Case Tools ribbon, click Linked Exhibits.

2. In the Linked Exhibits dialog box, select the linked exhibit you want to delete.

3. On the  Linked Exhibits toolbar, click Delete.

You can also right-click on the linked file you wan to delete, and then click Delete.

4. In the message box, review the number of hyperlinks and annotations affected.

5. Click OK to delete the exhibit.

6. In the Linked Exhibits dialog box, click Close.

Related Topics

About exhibits

Linking exhibits to transcripts

Viewing exhibits

Verifying linked exhibits

Changing exhibit file paths
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Verifying linked exhibits

The Verify Paths tool checks that all linked exhibits are accessible in the selected file viewer. A
message displays indicating files successfully verified and lists the number of linked exhibits and
any linked files that were not checked because they are not local or network files.

TextMap cannot verify web site addresses. If there is a problem with the linked file path, the
Status field will display "This file was note found".

To verify linked file paths

1. On the Case Tools ribbon, click Linked Exhibits.

2. In the Linked Exhibits dialog box, click Verify Paths.

3. In the message box verifying completion, click OK.

Related Topics

Creating single hyperlinks in transcripts

Changing exhibit file paths

Changing exhibit file paths

Linked exhibits and other case files should be stored in a network folder so other case users
can access them. You can change the file paths using the Change Path Wizard, which will
change all matching paths to the new path so that links in the case will open specified
documents.

We recommend you make a backup copy of the case before making any global changes,
like changing linked file paths. Once the process is completed, you cannot undo the
changes without restoring a backup copy of the case.

To change exhibit file paths

1. On the Case Tools menu, click Linked Exhibits.

2. In the Linked Exhibits dialog box, click Change Paths.
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3. On the Change Paths Wizard's Welcome page, click Next.

4. On the Select a Path to Update page, select the path you want to update.

Select the Show whole path only check box if you prefer to change the whole file path at
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once.

5. Click Next to continue.

6. On the Enter a New Path page, click Browse navigate to the folder where the files are
now stored, then click OK.

7. On the Enter a New Path page, click Next.

8. On the Completing the Change Paths Wizard page, review the previous and new folder
paths, then click Finish.

9. In the Linked Documents dialog box, click Close.

Related Topics

About exhibits

Linking exhibits to transcripts

Creating single hyperlinks in transcripts

Changing the case exhibits path

Changing the case exhibits path

Exhibit files and other case files should be stored in a network folder so other case users can
access them.

For local cases, TextMap automatically imports exhibits files to a subfolder where the case file is
stored. If you move the exhibits folder along with the case file, the imported exhibits link will
still work. See Changing exhibit file paths.

For SQL cases, you specify the network folder where you want to store exhibit files in the Case
Properties dialog box. You must have permission granted in the CaseMap Admin Console to use
this feature.

To change the exhibits path folder for SQL cases

1. On the File menu, click Case Setup, and then click Case Properties to open the Case
Properties dialog box.

The current folder path for exhibits displays in the Exhibits Path box.

2. Click the Modify button to change the folder path.

3. In the Browse for Folder dialog box, navigate to the folder where you want to save
exhibit files, then click OK.

4. Click OK to save your changes.
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Related Topics

Entering case properties

Importing exhibit packages

Changing exhibit file paths

Working with Video

About videos

You can import video files like any other transcript in TextMap. When the import is complete the
transcript displays in the Transcript List with a video icon that is different than the icon for text-
only transcripts.

Videos play in TextMap with a cursor scrolling through the text in synch with the video because
there are three components working at the same time: a video file (an .mpeg or .wmv), a text
file, and a file with synchronization information.

You can search and annotate video transcripts just as you have done with other transcripts in
the case. In addition, you can use the Edit Video dialog box to make a snippet associated with
an annotation a little shorter or longer.

Before you can play back transcript video in TextMap, you must first have the transcript
synchronized with the video. TextMap does not synchronize the video and the transcript for
you. Usually your court reporter or videographer can perform the video synchronization service
for you. When you schedule a video deposition with court reporters, make sure to ask if they
can perform the video synchronization service and provide the synchronized transcript in a
format that TextMap can import.

Learn about video file types you can import

Reference the following table for a list of the standard formats for importing transcripts with
synchronized video that are supported by TextMap.

Import Video Files Types

File Types File
Extensions

Description

Sanction
(preferred)

.mdb Most video synchronization service providers should be
able to produce this format.

*.mdb files have the text and synch information that
TextMap needs. You will need the video file for the
transcript too.
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Import Video Files Types

File Types File
Extensions

Description

YesLaw CDs
(preferred)

*.mdb and
*.vid

YesLaw CDs include both the *.mdb and *.vid files.
TextMap looks automatically for video files to play on
your CD drive.

LiveNote
Portable
Transcript
Format with
Video

*.ptf and
*.vid

Most video synchronization service providers should be
able to produce this format. You can also get this
format from exporting from LiveNote or TextMap.

*.ptf files have the text and a *.vid file with synch info
for an individual transcript that TextMap needs.  You
will need the video file for the transcript too. *.ptf files
can imported as you would import a text (.txt) file.
TextMap automatically imports the video (.vid) format
and the synchronization information.

TextMap Exhibit
Packages

*.xmef TextMap Exhibit Packages can be created from an
*.mdb and *.ptf-sw with *.vid. 

*.xmef files made with TextMap Exhibit Linker from
video transcript .mdb or .ptf files include transcript
text, hyperlinked exhibits, and video synch data. You
will need the video files for the transcripts too.

Portable Case
Format

*.pcf You can get this format by exporting from LiveNote or
TextMap. 

*.pcf files have the text and synch info that TextMap
needs for more than one transcript. You will need the
video files for the transcripts too.

Esquire Video
Project

*.evp Esquire Video Project files include the following:
transcript text with video time stamps, transcript
videos, and exhibit links. 

The exhibit files are not stored in the *.evp file. If the
*.evp file is on a CD, the exhibit files should be in an
Exhibits folder on the CD.  The exhibits can be
imported into TextMap separately using the normal
exhibit linking process. For more information on exhibit
linking, see Auto Link Exhibit Wizard and TextMap
Exhibit Linker. 

TextMap does not support importing LiveNote Exhibit Format (*.lef).

If you have a text file and a video that are not synchronized into a Sanction *.mdb file
for import, you can contact a company that can combine the video recording of the
deposition and the transcript into the Sanction format. Look for a company that
advertises video depositions or multi-media depositions.
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It is not possible to simply import a video file from a camcorder. TextMap requires a
video file, a text file, and time coding information in order to synchronize video with text.
Sanction .mdb files contain each of these.

Related Topics

Importing video files

Playing videos

Annotating videos

Editing videos

Changing search options for videos

Changing video file paths

Importing video files

Import video files just as you would import a transcript or other file into your TextMap case.
When the import is complete, the transcript displays in the Transcript List with a video icon that
is different than the icon for text-only transcripts.

To import videos

1. On the TextMap toolbar, click the Import Transcripts button.

You can also click the File menu and then click Import, and then Import Transcripts.

2. In the Select one or more Transcripts to Import dialog box, navigate to the location
where the files you want to import are saved.
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3. In the Files of type list, select the file type you are importing.

4. In the File name box, type or edit in the name of the file.

5. Click Select.

6. In the Transcript Import Preview dialog box, review the file import information and type
in any comments regarding the file.
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7. Click OK.

Related Topics

About videos

Playing videos

Annotating videos

Editing videos

Changing search options for videos

Changing video file paths

Playing videos

Videos display in the Exhibits and Video pane in the Video task pane.

For imported .mdb, .ptf, and .pcf files, TextMap automatically looks on your CD drive for the
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accompanying video file when you click the Play Video button. If it doesn't find the video on
your CD drive, TextMap displays a Browse for Folder dialog box for you to navigate to the folder
where the files are saved. Once the file is selected, the video and synched text are ready and
the video will begin to play.

If an annotation is applied to the transcript and video, you can quickly navigate to the
location by right-clicking on the annotation in the Annotations pane or in the transcript text
and then clicking Video and Play Video Snippet. See Annotating videos.

To play a video

1. In the Navigation pane, click on the Exhibits and Video button.

2. In the Transcripts pane, click on the video you want to play.

3. In the Video pane, click on the Play button.

You can also click the Play Video button on the TextMap toolbar.

Click on the buttons in the Video pane to stop the video or adjust the volume.
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Related Topics

About videos

Importing video files

Annotating videos

Editing videos

Changing video file paths

Annotating videos

You can make annotations in the text accompanying a video transcript just as you would in a
text-only transcript. Simply click and drag your mouse over the text you want annotated, then
right-click on the highlighted text and select Annotate in TextMap. 

Once an annotation is applied to the transcript and video, you can quickly navigate to the
location by right-clicking on the annotation in the Annotations pane or in the transcript text and
then clicking Video and Play Video Snippet.

For more information on annotating, see Creating annotations.

Related Topics

About videos

Playing videos

Editing videos

Editing videos

You can use the Edit Video dialog box to make a snippet associated with an annotation a little
shorter or longer. You can adjust the video time in increments of one hundredths of a second.
You can clear your edits from the video file any time you need to re-apply edits.

To edit a video

1. In the Annotations pane, right-click on the annotation associated with the video snippet
and click Video, and then Edit Video Snippet.

You can also click Video and then Edit Video Snippet on the Annotations menu.
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2. In the Edit Video Snippet dialog box, click the - and + buttons to increase or decrease
the Start Time and End Time for the video.

3. In the Adjust By list, clicking on the arrow list to click on the time adjust you want to
make.

4. Click Play Snippet to view the video excerpt to see the time adjustment.

Click Reset to Default if you need to clear your edits from the video and re-edit it.

5. Click OK to save your changes.

Related Topics

About videos

Importing video files

Playing videos

Annotating videos

Exporting videos

Export video files just as you would export a transcript or other file from your TextMap case.
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To learn about files you can export

Reference the following table for a list of the standard formats for exporting transcripts with
synchronized video that are supported by TextMap.

Import Video Files Types

File Types File
Extensio
ns

Description

LiveNote *.pcf and
*.ptf

Portable Transcript Format (*.ptf) is a file format for a single
transcript that can be imported into LiveNote® Stream.

Portable Case Format (*.pcf) is a file format for a single 
transcript or multiple transcripts that can be imported into
LiveNote®.

Both *.ptf and *.pcf files contain the text and all
annotations. TextMap creates a *.vid file with associated
video synchronization information to go along with the *.ptf
and *.pcf files.

Sanction *.mdb *mdb is a file format for a single transcript that can be
imported into Sanction®. 

Amicus,
Summation,
and Page
Image Format

text or
*txt

Text files are formatted for single transcript that contains all
text.

Amicus *txt is a format that can be imported into Amicus®
Attorney.

Summation *.txt is a format that can be imported into
Summation®.

To export a video

1. In the Transcripts pane, right-click the video transcript you want to export and then
click Export Transcript.

You can also click More Export on the Home Ribbon, and then click Export to Portable
Case Format.

2. In the Select Name, Location, and Type for Exported Transcript dialog box, navigate to
the folder where you want to save the export file.

3. In the File name field, type or edit the name of the export file.

4. In the Save as type list, click the file type you want for the export (e.g., Portable Case
Format (*pcf)).

5. Click Save.

6. In the Export Case dialog box, if groups have been created, then select an applicable
location/group, and then click OK.
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7. In the message box, click OK to acknowledge the location of the saved file.

Related Topics

About videos

Importing video files

Exporting video clips

Exporting video clips

Video clips can be any selected text in a transcript or annotations made of video transcripts
during review. To identify video clips you want to export, you can read the transcripts or search
them using TextMap's Search functions. Or you can review the Annotations pane to find a
desired passage by scanning your notes, linked issues, linked facts and text highlights for a
selected transcript.

You can export the clip to a media file, insert it into an existing PowerPoint presentation, or put
it into a new PowerPoint presentation. Exporting to PowerPoint requires version 2002 or
higher. Although the default location for saved *.wmv, *.mpg and *.mp4 files are My Media\My
Videos, TextMap also allows you to determine where you want to save exported video clips.

You will need Windows Media Encoder version 9 or higher to export clips. You may have
installed the encoder as part of TextMap's Install Wizard. If not, TextMap will look for the
encoder on your computer when you try to export a clip. If you don't have Windows Media
Encoder, TextMap provides a link to a Microsoft Downloads page where you can get more
information about the free component and download it.

TextMap can optionally use the FFmpeg encoder to export clips to the .wmv, .mpg, and .mp4
format. You can set the option to export to these formats in the Options tabs. See Changing
case options for more information.

Please note that LexisNexis makes no warranty regarding, and is not responsible for the
installation or use of FFmpeg or any other third-party product or software code.

If you are exporting a video clip to a Microsoft PowerPoint presentation, the video clip displays
on a slide with a page/line reference and all text from the annotation, along with an image of
the first frame of the video clip. 

TextMap has options to export video clips to a new or existing PowerPoint file. You can select
and preview the following presentation format preferences:

Video Format (WMV, MPG or MP4)

Video Position (Left, Right, Above or Below transcript text)

Include Transcript Title   

https://www.microsoft.com/en-us/download


Using TextMap 253

© 2017 LexisNexis. All rights reserved.

TextMap saves exported clips as media files in the same location as the presentation. Double-
click the image in PowerPoint's Normal mode or click on it in Presentation mode to play the
video.

To export video clips

1. In the Annotations pane, right-click the annotation that you wish to export, click Video,
and then click Export Clip.

You can also right-click the color annotation in the transcript and then click Video and
Export Clip.

2. In the Export Video Clip dialog box, select the option you want.

3. Click OK.

To a Media File

1. In the Export Video Clip dialog box, click the list under the Video Format header
and select one of the options.

2. Click Browse and navigate to the folder where you want to save the file.

3. Click Save.

4. In the message box, click OK.

To a new PowerPoint presentation

1. In the Export Video Clip dialog box, click the list under the Video Format header and
select one of the options. 
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2. In the Export Video Clip dialog box, click the list under the Video Position header
and select one of the options. 

3. Select or clear the option to Include Transcript Title.

If setting preference for the first time, this is selected by default. 
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The selections will appear in the Preview area of the dialog box.

4. Click Browse and navigate to the folder where you want to save the file.

5. Click OK.

The exported clip is opened as a new slide in the PowerPoint presentation.   

To an existing PowerPoint presentation

1. In the Export Video Clip dialog box, click the list under the Video Format header
and select one of the options.

2. In the Export Video Clip dialog box, click the list under the Video Position header
and select one of the options. 
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3. Select or clear the option to Include Transcript Title.

If setting preference for the first time, this is selected by default. 

The selections will appear in the Preview area of the dialog box.

4. In the Please specify a PowerPoint presentation to export to area, click Browse
and navigate to the folder of the existing PowerPoint file.

5. Select the file.

6. Click Open.

The exported clip is added to a new slide in the presentation.

To export multiple video clips all at once

1. In the Annotations pane, right-click the annotation that you wish to export, click
Video, and then click Export Multiple Clips.

You can also right-click the color annotation in the transcript, or click the Annotations
menu, click Video, and then click Export Multiple Clips.

The Export Multiple Video Clips Wizard displays.
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2. In the Export Multiple Video Clips wizard, click Next to open the Limit Annotations
by Issue dialog box.
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3. Select one of the following:

To include all annotations

a. Select  the Yes, include all annotations check box to export all annotations.

b. Click Next.

To include only annotations linked to issues

a. Select the No, only include annotations linked to the selected issues check
box to include only the annotations that are linked to the issues that are
selected here.

b. In the Select issues to include area, select the check box(es) for all
annotations to be included in the export.

c. Click Next.

If you have enabled the use of FFmpeg encoder to export multiple output formats,
the following option is available. If not enabled, skip to step 6.

4. In the Export Multiple Video Clips wizard, select one of the following output formats
for the video clips:

Windows Media Video (.wmv)
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MPEG-2 (.mpg)

MPEG-4 (.mp4)

5. Click Next.

6. In the Output Destination dialog box, click Browse to locate a storage location/
folder for the exported file.

7. In the Browse For Folder dialog box, click OK. 

The Export Multiple Video Clips Wizard opens, displaying the location/path of the
exported files.

8. Click Next to export the video clips.

The Exporting Video Clips screen displays. 

Please wait while TextMap exports the video clips.

9. Optional: In the Exporting Video Clips window, click Cancel to stop the export.

10. In the Completing the Export Multiple Video Clips wizard, click Finish.

TextMap completes the export and stores the file(s) in the selected folder. It makes
the name of each file unique by adding a number to the end of it (e.g., Deposition of
Wayne Varvaro Pg 4 Ln 6 - 7 (2).wmv), where (2) is the unique identifier.
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To save clips to a flash drive or CD

If you have a number of clips it may not be practical to email the presentation and clips. In
that case, using a USB drive or burning the presentation and related *.wmv files to CD may
be a better option for you. This options also allows you to transfer a PowerPoint
presentation from your office computer to a laptop, if need be.

You can move saved *.wmv file clips by copying them onto portable storage media like a USB
flash/thumb drive or CD. If you saved the  files to the default location the clips will be in My
Media/My Videos.

When you move a PowerPoint presentation with clips make sure you take along the
exported video files (*.wmv) that are in the same folder with the presentation file. The video
files will have names like "Deposition of Wayne Varvaro Pg 5 Ln 13 - 18.wmv". Save the
presentation and associated videos in the same folder.

Your presentations and clips will play from a CD or USB drive.

Related Topics

About videos

Importing video files

Exporting videos

Changing search options for videos

TextMap checks your CD drive by default for video files. You can change the drive that is first
used to locate video files. TextMap  remembers the location of the video (the file path).

To change the search options for videos

1. On the File menu, click Options.

2. In the Options dialog box, click the Video tab.
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3. In the box, select the drive that you want TextMap to search first for video files,
beginning with the root folder.

4. Select or clear the Search entire disc on CDs and DVDs option, depending on your
needs. 

This option is enabled by default.

5. Click OK to save your changes.

Related Topics

About videos

Importing video files

Changing video file paths

Changing video file paths

The video path is where TextMap looks for video files. The Case Video Paths dialog box allows
you to add additional file paths to search other locations on your system or network where
videos might be stored.
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To add or change video paths

1. On the File menu, click Case Setup, and then click Case Properties.

2. In the Case Properties dialog box, click Video Paths.

3. On the Case Video Paths tab, click Add to add another location for TextMap to search. 

You can organize this list and edit it as needed.

4. On the Auto Search Drives tab, select or clear check boxes for drives you want to
search for video files.
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The DVD Drive and Search entire disc on CDs and DVDs check boxes are selected by
default.

5. Click OK to save any changes.

Related Topics

About videos

Changing search options for videos

Editing Data

About editing data

TextMap offers a variety of ways you can edit case data. Once data is edited, it is saved and
permanently changed in the case.

Editing field data involves:

Spell checking annotation notes

Finding words in transcripts
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Copying transcript text

Locating the page/line number in a transcript

Inserting and deleting data and transcripts

See Deleting transcripts and Deleting annotations.

Changing exhibit and linked file paths

See Changing exhibit file paths and Changing linked file paths.

Related Topics

Using spelling tools

Finding and replacing data

Copying data

Using the Go To feature

Changing exhibit file paths

Changing linked file paths

Using spelling tools

TextMap offers live spell checking when you type in annotation notes.

You can access Spelling options and settings in the Notes tab of the New Annotation or Edit
Annotation dialog box.

To use the spelling tool

1. In the New Annotation or Edit Annotation dialog box, right-click on a misspelled word.

Misspelled words display with a red underline.
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2. Right-click on the misspelled word and click the correct word from the list or choose one
of the following:

Click Ignore to ignore one instance of the word as you have it spelled.

Click Ignore All to ignore all instances of the word as you have it spelled.

Click Add to add the word to the case dictionary.

Click Change All or Auto Correct and then click the correct spelling to change all
instances of the word or automatically correct the word if misspelled in the future.

Click Spelling to access these options in the Spelling dialog box.

3. Click OK to save your changes.

To change spell check options

1. In the New Annotation or Edit Annotation dialog box, right-click on a misspelled word.

2. Right-click on the misspelled word and click Spelling.
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3. In the Spelling dialog box, click the Options button.

4. In the Spelling Options dialog box, select or clear the check boxes for the options you
want to include.

5. Click OK to save your changes.

6. Click the Reset Defaults button to reactivate spelling default settings.

To change or add a new dictionary

TextMap is automatically configured to use a dictionary. You can also add additional
dictionaries, like a medical dictionary, as needed.

1. In the New Annotation or Edit Annotation dialog box, right-click on a misspelled word.

2. Click Spelling.

3. In the Spelling dialog box, click the Options button.

4. In the Spelling Options dialog box under Dictionaries, select the check box for
dictionaries you want turned on.
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5. In the Custom Dictionary list, click on the dictionary you want to use as your default
dictionary.

6. Click the Dictionaries button to add, edit, or delete a dictionary.

7. In the New Custom Dictionary dialog box, type in the name of the custom dictionary
that is stored on your desktop or in a network folder, then click OK.

To add new or updated dictionaries, visit www.addictivesoftware.com.

8. Click OK to save the dictionary in TextMap.

http://www.addictivesoftware.com/
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9. In the Spelling Options dialog box, click OK.

10. In the Spelling dialog box, click Close.

To delete a word from the dictionary

1. In the New Annotation or Edit Annotation dialog box, right-click on a misspelled word.

2. Click Spelling.

3. In the Spelling dialog box, click the Options button.

4. In the Spelling Options dialog box under Dictionaries, select the check box for
dictionaries you want to edit.

5. In the dictionary dialog box, select the word you want to remove and click Delete.

6. Click OK to save your changes.

7. In the next four dialog boxes, click OK or Cancel until all dialog boxes close.

Related Topics

About editing data

Finding and replacing data

Copying data
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Finding words in transcripts

When you need to locate records containing a specific word or phrase, use the Find feature to
search case content. 

You also have the option to search for text that is case sensitive or is a particular groups of
words. Selecting case sensitive provides matches of the text when certain characters are
capitalized. Selecting the Match whole word only option allows you to search for a particular
word or phrase. For example, if you want to find every occurrence of the whole word "John" in
a field, TextMap locates all instances of both "John" and "Johnson".

When searching for data using the Find feature, you are limited to searching one transcript at a
time. TextMap retains the last search you used in the Find dialog box for one user session.
When you close TextMap and reopen it, the Find dialog box will be empty.

To find a word in a transcript

1. On the Home ribbon, click the Find button, and then on the submenu, click Find.

You can also click the Find button on the Create & Edit tab located on the Text & Video
Tools ribbon.

2. In the Find dialog box, type the word you want to locate in the Find What field.

3. Select the Match whole word only or Match case check boxes if you want to narrow the
search.

4. Click Find Next to locate the next instance of the word in the transcript.

You can also click the Find button on the Create & Edit tab, and then click Find Next.

5. In the message box to search the next transcript, click Yes.

6. Continue until you have searched all necessary transcripts, then click Cancel.

Related Topics

About editing data

Using the Go To feature 
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Copying data

You can copy text from a transcript to paste into a text file or another application, like Microsoft
Word. You have the option of copying just text or text with a page/line number included.

You also have the option to include the citation when copying transcript text into another text
file or another application, like Microsoft Word.

 

The text will be cited with the selected customized preferences and can be copied with the
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page/line numbers included.

To copy transcript text

1. Highlight the transcript text that you want to copy.

2. On the Create & Edit ribbon, click Copy or Copy w/ page:line.

You can also right-click the highlighted text, click Copy, and the select Copy or Copy w/
page:line.

3. Open the application for which you want to paste the text.

4. Right-click the document and click Paste.

To include source when copying transcript text

Once your case is created, you can standardize the appearance of the citation according to any
internal guidelines, case needs, or user preferences. The preferences are customized using the
Changing case options feature.

1. On the File menu, click Options, and then click the Clipboard tab.

2. Click Include source when copying transcript text.

      If customizing for the first time, this is selected by default. 

3. Select the format and position for copied transcript text, and then click OK. 

4. Highlight the transcript text that you want to copy.

5. On the Create & Edit ribbon, click Copy or Copy w/ page:line.

You can also right-click the highlighted text and click Copy, and the select Copy or Copy w/
page:line.

6. Open the application for which you want to paste the text.

7. Right-click the document and click Paste.

Related Topics

About editing data

Finding words in transcripts

Changing case options

Using the Go To feature

The Go To feature allows you to instantly locate to a page/line number in a transcript.



TextMap272

© 2017 LexisNexis. All rights reserved.

To locate a page/line number

1. On the Home ribbon, click the Find button, and on the submenu, click Go To: Page/Line.

2. In the Go To dialog box, type in the page and line number you want to locate.

Use the list arrows to incrementally increase or decrease numbers.

3. Click Go To.

Related Topics

About editing data

Finding words in transcripts

Redacting Transcripts

About redactions

TextMap allows you to redact confidential and sensitive information provided in the transcript
deposition testimony.

Setting up the redaction reasons during the initial case setup is a best practice that allows you
to have existing reasons ready for redaction in the case. 

Once a report on the transcript is printed, any text concealed by a redaction cannot be viewed,
copied, or searched. See Printing single transcripts and Printing multiple transcripts for more
information on printing reports with redactions. 

If you are working with SQL cases, you can set permissions for restricting modifications to
redactions, redaction reasons, as well as deleting redactions in the CaseMap Admin
Console.  For more information, see the following topic:  Creating roles in the CaseMap
Server Answer Center. 

Related Topics

http://help.lexisnexis.com/litigation/ac/cm/cmserver_2.1/ac_user_roles_create.htm
http://help.lexisnexis.com/litigation/ac/cm/cmserver_2.1/ac_user_roles_create.htm
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Managing redaction reasons

Redacting transcript text

Editing redactions

Overlapping existing redactions

Managing redaction reasons
Redaction reasons are managed on a per-case level.  

You can import and export redaction reasons using a text file, add and delete during the initial
case setup, or when applying a redaction to selected text. 

To add a new redaction reason

1. On the File menu, click Case Setup, and then click Redaction Reasons.

2. In the Redaction Reasons dialog box, click Add, and then type the redaction reason. 

3. Click OK to close the dialog box.

The new reason is displayed in the Redaction Reasons list. 

4. Optional: Click Add to enter additional redaction reasons.

5. Click Close to close the Redaction Reasons dialog box. 

To delete a new redaction reason

1. On the File menu, click Case Setup, and then click Redaction Reasons.

2. In the Redaction Reasons dialog box, select the reason you want to remove, and then
click Delete. 

The reason is removed from the list of redaction reasons. 

3. Click Close to close the Redaction Reasons dialog box. 

To remove a redaction reason using the Delete Redaction Reason Wizard

The Delete Redaction Reason Wizard will appear when you delete redaction reasons that
have been applied to transcript text.

You can move the links to another redaction reason or delete the links from the transcript
entirely. 

Once a redaction reason is deleted, it is permanently removed from the case. 

1. On the File menu, click Case Setup, and then click Redaction Reasons.

2. In the Redaction Reasons dialog box, select the reason you want to remove, and then
click Delete. 

The redaction reason and the number of applied redactions are listed in the Delete
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Redaction Reason Wizard.

Move links to another redaction reason

To move links to another redaction reason, do the following:

1. Select the option to Move links to another redaction reason and click Next. 

2. Select the new reason where the redaction(s) will be moved to, and then click Next. 

3. The Confirm Reason Delete dialog box lists a summary of the redaction reason that
will be deleted and where it will be moved.

4. Click Finish to close the wizard, and then click Close to close the Redaction Reasons
dialog box. 

Delete redaction links

To delete redaction links, do the following:

1. Select the option to Delete redaction links and click Next. 

2. The Confirm Reason Delete dialog box lists a summary of the redaction reason that
will be deleted.

3. Click Finish to close the wizard, and then click Close to close the Redaction Reasons
dialog box. 

To import redaction reasons from a text file

1. On the File menu, click Case Setup, and then click Redaction Reasons.

2. In the Redaction Reasons dialog box, click Import.
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3. Navigate to the folder of the existing text file, select the file you want to import, and
then click Open.

The imported reasons are added to the list of redaction reasons.

4. Click Close to close the Redaction Reasons dialog box. 

To export redaction reasons to a text file 

1. On the File menu, click Case Setup, and then click Redaction Reasons.

2. In the Redaction Reasons dialog box, click Export.

3. Navigate to the folder where you want to save the file and type the File name.

The default File name is RedactionReasons.txt.

4. Click Save.

The redaction reasons are exported to the text file.

5. Click Close to close the Redaction Reasons dialog box. 

Related Topics

About redactions

Redacting transcript text

Editing redactions

Overlapping existing redactions

Redacting transcript text

A redaction is applied when confidential information that appears within transcript text needs
to be removed.

The redaction tool allows you to select and highlight text within the transcript that contains
sensitive information. The redaction appears transparent until printed. Once the transcript has
been printed with redactions, the text will be concealed and cannot be viewed, copied, or
searched.

 

To add a redaction

1. Highlight the transcript text you want to redact.

2. Right-click the selected text and then click Redact in TextMap.

You can also click the New Redaction  button located in the Home Ribbon or the
Create & Edit Ribbon. 
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3. Select the redaction reason(s) or click the Redaction Option button  to select one of
the following:

Select All Reasons to place a check mark beside all redaction reasons

Unselect All Reasons to remove the check mark beside all selected redaction
reasons

Manage Redaction Reasons to open the Redaction Reasons dialog box

A preview of the selected reasons appear as Applied Reasons. 

If the redaction reasons were not added during the initial Case Setup, click the

Redaction Option button  and then click Manage Redaction Reasons to define
reasons for the case . See Managing redaction reasons for more information. 

4. Click OK to save your selections. 

To delete a single redaction

Once the redactions have been deleted, the action cannot be undone. 

1. Click the redaction you want to delete. 

2. On the Create & Edit ribbon, click Delete, and then click Delete Redaction.

The redaction is deleted. 

To delete all redactions

Once the redactions have been deleted, the action cannot be undone.

1. On the Create & Edit ribbon, click Delete, and then click Delete all Redactions.

2. Click Yes to confirm deletion.

All redactions are deleted. 

Related Topics

About redactions

Managing redaction reasons

Editing redactions

Overlapping existing redactions

Editing redactions

TextMap offers a variety of ways you can edit redactions. 
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Editing redactions involves moving the redactions or updating the reasons already applied to
transcript text. 

Once the redaction is edited, it is saved and permanently changed in the case.

To move a redaction

1. Click the redaction you want to move.

2. On the Create & Edit ribbon, click Move  .

3. In the Move Redaction dialog box, select the new text that you want to move the
redaction to in the transcript, and then click OK.

The redaction is moved to the newly selected text in the transcript.

To edit redactions applied to transcript text

1. Right-click the redaction you want to change and click Edit Redaction.

2. Select the redaction reason(s).

A preview of the updated selected reasons appear as Applied Reasons. 
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3. Click OK.

To view redaction update history

When a redacted area is selected, you can edit the redaction or view the update history.

1. In the transcript, right-click a redaction and then click Edit Redaction.

2. In the Edit Redaction dialog box, click the Update History tab.

The update history displays the name of the user, the original creation date and time as
well as the name of the user and the updated date and time of the redaction.

Related Topics

About redactions

Managing redaction reasons

Redacting transcript text

Overlapping existing redactions

Overlapping existing redactions

The redaction tool overlaps existing redactions by selecting a portion of transcript text and
applying a new redaction.  

Overlapping existing redactions merges the new redaction to create a continuous redacted
area. 

To overlap a single redaction 

1. Select the portion of text that overlaps a single existing redaction, right-click and then
click Redact in TextMap.

2. In the Edit Redaction dialog box, select the redaction reason(s) and then click OK.

The existing redaction is expanded to include the newly selected transcript text. 

To overlap multiple redactions
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1. Select the portion of text that overlaps multiple redactions, right-click and then click 
Redact in TextMap.

Once multiple redactions have been merged, they will not retain any creation or update
history.

2. In the Edit Redaction dialog box, select the redaction reason(s) and then click OK.

The existing redactions are expanded to include the newly selected transcript text. 

Related Topics

About redactions

Managing redaction reasons

Redacting transcript text

Editing redactions

Creating and Printing Reports

About reports

A report is a way to retrieve information that you imported or entered in your case. The
TextMap Reports ribbon offers many useful reporting options for printing Current and Multiple
Transcripts. Many of the reports have wizards to make creating useful work product quick and
easy. Transcripts with annotations and linked issues have options for including the selected
passages and filtering highlighted passages for desired issues. There are also options for
including redacted transcript information. TextMap automatically creates a word index for all
transcripts; you can include it with transcript reports or not.

You can print reports to PDF file or print directly onto paper. You can run reports of only the
transcripts, just the annotations, or of both the transcripts and the annotations. Redactions
can also be printed in reports which allows you to conceal sensitive information. 

The date and time appears in brackets [ ] in front of the transcript name, and is included in all
transcript reports (i.e., Multiple Transcript Report, Annotations Digest Report, etc.).
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TextMap includes the following reports:

Current Transcript Report — A simple report made from just one transcript. These reports
provide you with the contents of the transcript arranged the way you specify, with the
opportunity to select all annotations or annotations related to a specific issue. You can print
the contents with or without annotations and can also choose to burn in redacted text. You
also have the option of printing the word index for that transcript as part of your report.
Redacted words are removed from the word index in the transcript if the option to exclude
is selected. 

Multiple Transcript Report (a.k.a ReportBooks) — A report containing information from
more than one transcript is also called a ReportBook. You have the opportunity to choose
what transcripts to include in the ReportBook, as well as the option of including a Title Page,
Table of Contents, and Introduction. You will have the option to organize transcripts in the
order you want them. You also have the same options that you do with a single transcript
report.

Annotation Digests are also ReportBooks that can be printed to Microsoft Word. Annotation
Digests include the annotations and notes from a set of ReportBooks and can be filtered by
issue. See Printing Annotation Digests.

Search Report — The Search Reports is based upon terms you type into the Full Text
Search box. The report shows by transcript all locations that contain the search criteria.

Transcripts Listing — A Transcripts Listing provides a list of the transcripts in the case.

Single and multiple transcript reports can be printed as full-sized, condensed or note-
taking versions. Transcripts with Annotations reports allow you to print with Footnotes or
Endnotes (full-size or condensed).  See Understanding layout options.

The Transcripts with Annotations report and Annotation Digest reports allow you to print
to a PDF format that includes linked exhibits embedded in the transcript. See Selecting
print output options.

Create transcripts groups to organize transcripts that are often included in reports. See
Creating transcript groups.

Customize title pages for polished reports

TextMap reports all print with a default title page to produce a polished work product. You
can decide whether to include a title page for your reports. And you can customize the
content and look of title pages to suit the needs of your organization.

Title pages can be customized within report wizards. However you can customize title pages
and title page content in the Page Setup dialog box too. See Adding/editing title pages.

Include linked CaseMap facts in reports

By default TextMap includes three of CaseMap's Facts spreadsheet fields (Date & Time, Fact
Text, and Status) in Transcript with Annotations reports and Annotation Digests. To
customize CaseMap fields included in TextMap reports, see the Changing page setup options
topic, Steps 8-10.

Embed linked documents in reports
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Embedding linked documents in reports and ReportBooks printed to PDF files allows you to
share the report and supporting files with others who do not have access to TextMap or the
case. Once the report or ReportBook is printed to a PDF file, transcripts with linked exhibits
or files will display with the transcript text underlined in blue. Clicking the underlined text
opens the linked document. 

To view all linked documents embedded in the PDF file, click the Attachments button
(paperclip) in Adobe Acrobat or Reader to view the list. See also Selecting print options.

Learn how un-numbered pages print in reports

Un-numbered pages display in many reports simply as "-".  You will still see a colon and line
number after the dash.  In full-size transcript reports un-numbered page numbers display to
the left of the line numbers.

Condensed transcripts do not display page numbers on front and back un-numbered pages.
Page numbers in both transcript types display in the upper right corner of each page of
testimony.

Related Topics

Changing page setup options

Adding/editing title pages

Selecting print output options

Understanding report options

Modifying title pages

Changing page setup options

TextMap provides a variety of page setup options that include printing of overlapping and
partial annotations, inclusion of CaseMap Fact fields, redaction settings, and more. Changes to
these settings apply to all reports in the case.

To select or change page setup options

1. On the File menu, click Print, and then click the Page Setup link.

You can also click access Page Setup options from any Print Preview dialog box.

2. In the Page Setup dialog box, click on the General tab to adjust condensed reports and
case index options.
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3. In the Condensed Reports area, select the Print the first page full size check box if you
want this option.

4. In the Word Index area, click in the Font Size and Columns boxes to adjust these
settings incrementally.

5. Select or clear the Draw lines between columns check box. This option is selected by
default.

6. Click on the Annotations tab.
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7. In the Overlapping area, select or clear whether to print overlapping annotations in full-
sized or condensed reports.

8. In the Highlighting area, check the box to highlight the entire line when creating
annotation reports. 

9. In the CaseMap Fact Fields area, select what CaseMap fields display in reports.

10. Click the Customize button to add or remove fields from reports.

11. Clear the Skip blank CaseMap fields check the box to print blank fields in reports.

12. Click on the Redactions tab.
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13. In the Color area, select whether to print the redaction color in black or white. The
default option is set to black.

13. In the Reasons area, select or clear the check box to toggle printing the redaction
reasons in the report. 

14. Click OK to save changes. 

Related Topics

About reports

Adding/editing title pages

Selecting print output options

Adding/editing title pages

You can add a title page to any report you print or save as an Adobe® Acrobat PDF file. Rather
than creating a title page each time you generate a report, you can edit the default title page
format that works for all reports. You can also decide whether to include a title page or remove
it from the report. The title page feature is turned on by default when you create a new case.
Changes to the report title page affect all reports in the case. These settings are accessible in
the Page Setup dialog box on the File menu.

Title page settings include the following:
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Report titles and subtitles

Text orientation and alignment

Border styles and colors

Graphics

Date and time

Page Number

Organization and case name

Confidentiality statement

Multiple transcript reports and Annotation Digests include a title page, confidentiality
statement, table of contents, introduction, and transcript title page. Each of these can be
modified according to your organization's needs on the ReportBook Wizard's Option page.
For more information, see Modifying ReportBook title pages.

To add/edit report title pages

1. On the File menu, click Print, and then click the Page Setup link.

2. In the Page Setup dialog box, click the Title Page tab.

3. In the Vertical Alignment list, click on the alignment option you want: Top, Top Third,
Middle, Bottom Third, Bottom.

4. In the Border Style listing, click the point size for the border width.

5. In the Border Color listing, click the color scale you want to use.
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6. Select check boxes to include these options: Print Date and Time, Print Page Number,
and Include Graphics.

7. Click the Edit Content button to modify the content that prints on each page, including
typing or pasting text, modifying the font size and color, adjusting text alignment,
inserting symbols or specific fields.

8. Click the Edit Graphics button to preview current graphics, and modify the header and
footer graphic settings (like your organization's logo). You can also remove, load, and
save graphics for title pages. 

9. Click the Preview button to review your changes.

10. Click the Options button and then click Load Defaults, which changes all settings back to
the default setting.

11. Click on the Title Page Info tab to modify staff, case, and organization names for
reports.

12. In the Staff Name field, type in a staff member name that you want to print on all
reports.

13. In the Case Name field, edit the case name for how you want it to print on all reports.

14. In the Org. Name field, type or edit your organization's name for how you want it to
print on all reports.

15. Click OK to save the settings.

Related Topics
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About reports 

Changing page setup options

Selecting print output options

Understanding report options

Modifying ReportBook title pages

Selecting print output options

Printing transcript data or reports is as simple as selecting the printer destination or the export
file type/program you want to use. Print options are accessible from the File menu and on the
TextMap toolbar.

Printer output options include:

Printer destination

Print Preview mode

Print to PDF (save or email)

Print to Microsoft® Word

We recommend you select Preview first to verify your report before printing a hard copy or
saving the report as a PDF file. You can select your print options from the Print Preview
toolbar.

When you use TextMap’s built-in PDF writer (which doesn’t require an Adobe® Acrobat®
license) to generate these reports, TextMap adds extra functionality to the PDF. For
example, in the Endnotes report, TextMap creates links between each annotation and the
associated endnote. TextMap also creates links from the case index to the pages on which
each word in the index appears.

The Transcripts with Annotations and Annotation Digest reports allows you to print to a
PDF format that includes linked exhibits embedded in the transcript.

To print Annotation Digests to Microsoft Word

Each Annotation Digest report can be printed directly to Microsoft® Word. See Printing to
Microsoft Word.

To print to PDF

All the report styles available in TextMap are available as PDFs, including ReportBook
compilations of multiple transcripts.

When you use TextMap’s built-in PDF writer (which doesn’t require an Adobe® Acrobat®
license) to generate these reports, TextMap adds extra functionality to the PDF. For
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example, in the Endnotes report, TextMap creates links between each annotation and the
associated endnote. TextMap also creates links from the case index to the pages on which
each word in the index appears.

Additionally, PDF reports include bookmarks grouped by letter that make it easy to navigate
to index pages containing words of interest. TextMap PDF reports automatically include a
Title Page too.
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TextMap also embeds exhibits and documents hyperlinked to transcripts in PDF reports.
Exhibits and linked documents display as hyperlinks in the text. Click on the hyperlink to view
the embedded file. 

To view all linked documents embedded in the PDF file, click the Attachments button
(paperclip) in Adobe Acrobat or Reader to view the list.

To access PDF print options

Within TextMap, you can convert spreadsheet views, reports, and ReportBooks into PDF files
— even if you don't have a license for Adobe® Acrobat (Standard or Professional) on your
computer.

Access PDF print options from:

File menu > Print > [select transcript(s) print options] > Print menu

File menu > Print Preview > [select transcript print options] > Print menu

PDF toolbar button > a selected report > Print menu

Print to PDF toolbar button (save or email) > a selected report > Print menu

Reports ribbon > [select transcript(s)] > Print menu

If you are selecting print options within Acrobat, refer to the Adobe Acrobat
documentation for details.

To save or email a PDF report

1. On the Reports ribbon, click Transcript Listing, and then click the PDF icon.
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2. In the Print dialog box, click one of the following:

Save As PDF

1. In the Page Range area of the Print dialog box, select the applicable pages (All, Odd,
or Even).

2. Click OK to open the Save As PDF dialog box.

3. Select the the file to be saved.

4. In the File name box, enter/verify the name of the file, and click Save.

5. In the message box, click OK to continue.

Your selected transcript(s) will be printed in report form to an Adobe Acrobat PDF
file.

Email As PDF

1. In the Page Range area of the Print dialog box, select the applicable pages (All, Odd,
or Even).

2. Click OK to open the Save As PDF dialog box.

3. Select the the file to be saved.

4. In the File name box, enter/verify the name of the file, and click Save.

5. In the message box, click OK to open the default email application.

6. Complete the email form as appropriate, and click Send.

Your selected transcript(s) will be printed in report form as an attachment in a
Microsoft Outlook email.

Related Topics

About reports
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Changing page setup options

Adding/editing title pages

Printing Transcript Reports

Understanding layout options

TextMap offers a variety of layout options for printing reports and Annotation Digests.
Reference the following section to understand each layout option, how annotations and notes
print for each layout, how to embed linked exhibits in reports with annotations, and how
reports print overlapping annotations.

Select transcript report layout options

Each single or multiple transcript report includes the following transcript layout options.

You have three layout options for printing transcripts:

Full-size — A copy of the transcript with 25 lines per page (or the number of lines the
court reporter included in the ASCII file).

Condensed — The transcript prints "four-up", with four pages of text on each page. You
have the option to print the first page as full-size. See Selecting print output options.
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Note-taking — The Note-Taking Report prints two condensed transcript pages on the left
side of a printed page and adds lines for handwritten notes on the right.
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Use the Note-taking option, if you or another trial team member prefers to work with
paper to annotate depositions. This note-taking report option prints two condensed
transcript pages on the left side of a printed page and adds lines for handwritten notes
on the right. Once the the deposition is marked up, someone can use TextMap to
manually enter the annotations and related notes so everyone on the trial team can
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share the knowledge.

Learn how annotation and notes print in each layout

Reference the following report layouts to understand how annotations and notes print for
each.

Footnotes — The Footnote report places notes at the bottom of transcript pages. Two
condensed pages print at the top of each page to leave room for the footnotes at the
bottom of each page that has annotations. Each annotation is sequentially numbered.
If you have more notes than will fit on the page, TextMap starts a new page and
continues the notes so that all your work is included in logical sequence.
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Endnotes - Full-size Transcripts — The Full-size Transcripts report places notes at
the back of the transcript, before the case index. All annotations are numbered and
organized with notes. Including a case index is optional.
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Endnotes - Condensed Transcripts — The Condensed Transcript Report prints four
pages of the transcript on each output page of the report and places notes at the
back of the transcript (similar to the Full-size Transcripts report example).

If you are using both TextMap and CaseMap for your case and you want to make
annotations first, review the results from TextMap in a PDF and then send selected
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annotations to CaseMap later.

Embed linked exhibits in transcripts with annotations

The Transcripts With Annotations report wizard allows you to print to a PDF format that
includes linked exhibits embedded in the transcript.

TextMap report wizard options include:

Linked issues

Linked CaseMap facts

A case index

Options for including report and transcript title pages, a confidentiality statement, table
of contents, and introduction. (These options are not included in the Footnotes report;
only in Endnotes reports.) See Modifying title pages.

If you print the transcript with a case index to a PDF file, each word's page and line
reference in the index is a hyperlink to the page in the transcript where the word
appears. TextMap also creates bookmarks in the PDF for the contents of the report or
ReportBook and for the entire case index, if you choose to include one.

Learn about printing with overlapping annotations

Overlapping annotation bars print in both full-size and condensed reports, and single or
multiple transcripts. In full-size reports, colored annotation bars display to the left of the
transcript text up to 1/4 inch (up to approximately six bars deep). In condensed and note-
taking reports, overlaps display to the left of the highlighted text, over the line numbers.
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This feature is turned on by default, but can be turned off from the File menu by clicking Page
Setup and then clicking the Annotations tab. Clear the Overlapping check boxes to prevent
printing. See Selecting print output options.
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Related Topics

About reports

Changing print options

Adding/editing title pages

Printing single transcripts

Printing multiple transcripts

Printing Annotation Digests

Printing single transcripts

A Single Transcript Report is a simple report made from just one transcript. These reports
provide you with the contents of the transcript arranged the way you specify, with the
opportunity to select all annotations or annotations related to a specific issue. You can print the
contents with or without annotations and redactions. You also have the option of printing the
entire transcript word index as part of your report. If redactions are burned into the report, the
redacted words will be excluded. 
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All single transcript reports can be saved, printed, or emailed as PDFs. Transcript reports can
also be saved as Microsoft Word files.

To print a single transcript report
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1. In the Transcripts pane, click on the transcript you want to use in the report.

2. On the Reports ribbon, click Current Transcript.

You can also click Print on the File menu, and then click Current Transcript.

3. On the Current Transcript submenu, click Full-size, Condensed, or Note-taking.

See Understanding layout options for details.

4. On the Transcript Report Wizard's Welcome page, click Next.

5. On the Highlight Annotations page, choose one of the following:

No, do not highlight annotations.

Yes, highlight all annotations.

Yes, highlight annotations linked to selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

6. Click Next.

7. On the Include Redactions page, choose one of the following:

Yes, to burn in redacted text to the printed report.

No, to not include burned redactions into the printed report.

See Changing page setup options for details on applying the redaction color and
reasons. 

8. Click Next.

9. On the Include Word Index page, choose one of the following:

Yes, include a word index.

No, do not include a word index.

10. Click Next.

11. On the Completing the Transcript Report Wizard page, click Finish to generate the
report.

12. In the Print dialog box, under Destination, click the print output you want.

The print options will change depending on your selection. See Selecting print output
options.
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We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

13. Select additional print options, then click OK.

To print a single transcript with annotations

1. In the Transcripts pane, click on the transcript you want to use in the report.

2. On the Reports ribbon, click Transcript w/ Annotations.

You can also click Print on the File menu, and then click Current Transcript.

3. On the Transcript with Annotations submenu, click Footnotes, Endnotes - Full-size
Transcript, or Endnotes - Condensed Transcript.

See Understanding layout options for details.

4. On the Transcript Report Wizard's Welcome page, click Next.

5. On the Limit Annotations by Issue page, choose one of the following:

Yes, include all annotations.

No, only include annotations linked to the selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

6. Click Next.

7. On the Include Redactions page, choose one of the following:

Yes, to burn in redacted text to the printed report.

No, to not include burned redactions into the printed report.

See Changing page setup options for details on applying the redaction color and
reasons. 

8. Click Next.

9. On the Linked CaseMap Facts page, choose one of the following:

Yes, include linked facts.

No, do not include linked facts.

To include facts from CaseMap, you must first have the corresponding case open in
CaseMap.
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By default TextMap includes three of CaseMap's Facts spreadsheet fields in reports:
Date & Time, Fact Text, and Status. To customize CaseMap fields included in TextMap
reports, see the Changing page setup options topic, Steps 8-10.

10. Click Next.

11. On the Include Word Index page, choose one of the following:

Yes, include a word index.

No, do not include a word index.

12. Click Next.

13. On the Completing the Report Wizard page, click Finish to generate the report.

14. In the Print dialog box, under Destination, click the print output you want.

The print options will change depending on your selection. See Selecting print output
options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

15. Select additional print options, then click OK.

Related Topics

About reports

Selecting print output options

Understanding layout options

Printing multiple transcripts

Printing Annotation Digests

Printing multiple transcripts

Any time a report is created based on multiple transcripts, you are creating a ReportBook. A
ReportBook is a compilation of any number of TextMap reports packaged with optional elements
such as a title page, table of contents, confidentiality statement, introduction, and report-
specific title pages. Each of these is customizable.

You have the same options that you do with a single transcript report. Your report can include
the full transcript with or without annotations or just the annotations alone, and options to
print with redactions. See also Printing Annotation Digest Reports. 

All ReportBooks reports can be saved, printed, or emailed as PDFs. See Selecting print output
options.
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To view a complete listing of all possible TextMap report and ReportBooks examples, click
the link on the ReportBook wizard's Welcome page. Scan the report listing by topic and
then click the link for the report example you want to view.

To print a multiple transcript report

1. On the Reports ribbon, click Multiple Transcripts.

You can also click Print on the File menu, and then click Multiple Transcripts.

2. On the Multiple Transcripts submenu, click Full-size, Condensed, or Note-taking.

See Understanding layout options for details.

3. On the Transcripts ReportBook Wizard's Welcome page, click Next.

4. On the Select Transcripts page, review the transcripts and transcripts groups you want
to include in the report.

Click the Modify button to select or remove transcripts/groups from the report, or change
the order that selected transcripts/groups will print in the report.



TextMap306

© 2017 LexisNexis. All rights reserved.

In the Selected Transcripts dialog box, click Transcripts Groups or Individual Transcripts.

In the Available Groups box, select or clear the check boxes for the transcripts or groups
you want to include or remove.

In the Selected Transcripts box, click the Up/Down  buttons to organize transcripts
in the order you want. Click OK to save your changes, then click OK to save your
changes.

5. On the Select Transcript page, click Next.

6. On the Options page, select or clear the ReportBook options you want to include, or
highlight an option in the list and click the edit button to make applicable changes and
then click Next.

See Modifying ReportBook title pages.

7. On the Highlight Annotations page, choose one of the following:

No, do not highlight annotations.

Yes, highlight all annotations.

Yes, highlight annotations linked to selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

9. Click Next to continue.

10. On the Include Redactions page, choose one of the following: 

Yes, to burn in redacted text to the printed report.
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No, to not include burned redactions into the printed report.

See Changing page setup options for details on applying the redaction color and
reasons. 

11. On the Completing the Transcripts ReportBook Wizard page, click Finish to generate
the report.

12. In the Print dialog box, under Destination, click the print output you want.

The print options will change depending on your selection. See Selecting print output
options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

12. Select additional print options, then click OK.

To print multiple transcripts with annotations

1. On the Multiple Transcript Report tab of the Reports ribbon, click Transcripts w/
Annotations.

2. On the Transcripts w/ Annotations submenu, click Footnotes, Endnotes - Full-size
Transcript, or Endnotes - Condensed Transcript.

You can also click Print on the File menu, and then click Multiple Transcripts.

See Understanding layout options for details.

3. On the Transcripts ReportBook Wizard's Welcome page, click Next.

4. On the Select Transcripts page, review the transcripts and transcripts groups you want
to include in the report.

Optional: Click the Modify button to select or remove transcripts/groups from the report,
or change the order that selected transcripts/groups will print in the report.
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In the Selected Transcripts dialog box, click Transcripts Groups or Transcripts.

In the Available Groups box, select or clear the check boxes for the transcripts or groups
you want to include or remove.

In the Selected Transcripts box, click the Up/Down  buttons to organize transcripts
in the order you want. Click OK to save your changes, then click OK to save your
changes.

5. On the Select Transcript page, click Next.

6. On the Options page, select or clear the ReportBook options you want to include, then
click Next.

See Modifying ReportBook title pages.

7. On the Limit Annotations by Issue page, choose one of the following:

Yes, include all annotations.

No, only include annotations linked to the selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

9. Click Next.

10. On the Include Redactions page, choose one of the following:

Yes, to burn in redacted text to the printed report.

No, to not include burned redactions into the printed report.
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See Changing page setup options for details on applying the redaction color and
reasons.

11. On the Linked CaseMap Facts page, choose one of the following:

Yes, include linked facts.

No, do not include linked facts.

To include facts from CaseMap, you must first have the corresponding case open in
CaseMap.

By default TextMap includes three of CaseMap's Facts spreadsheet fields in reports:
Date & Time, Fact Text, and Status. To customize CaseMap fields included in TextMap
reports, see the Changing page setup options topic, Steps 8-10.

11. Click Next.

12. On the Completing the Report Wizard page, click Finish to generate the report.

13. In the Print dialog box, under Destination, click the print output you want.

The print options will change depending on your selection. See Selecting print output
options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

14. Select additional print options, then click OK.

Related Topics

About reports

Selecting print output options

Understanding layout options

Printing single transcripts

Printing Annotation Digests

Modifying ReportBook title pages

Printing Annotation Digests

Annotation Digests are ReportBooks that include various components: annotation transcript
text, annotation notes, linked issues, and linked files.

TextMap offers three Annotation Digest Reports:
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All Annotations — includes all annotations and notes from a set of ReportBooks and can be
filtered by issue.

Search Notes — includes search search hits located in transcripts included in the
ReportBook. The ReportBook can be filtered by issues linked to the annotations that have
notes matching your search.

What's New — includes annotations that have been created on or after a date that you
specify. There's an option to include annotations updated since the chosen date.
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Using the Annotation Digest ReportBook Wizard, you can select the transcripts or transcript
groups you want to include in the report and modify the order in which you want them to print.
You can also customize the order in which you want annotation sections to print, as well as
choose whether to include linked CaseMap facts in the report. The default is for all sections to
be included in the report. Clear the sections you do not want in your report. Default settings
will be restored the next time you want to print the report. Page and line numbers print for all
annotations in all reports.
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You can also choose to burn in redactions.  This allows you to print the Annotation Digest
Reports without disclosing sensitive, redacted, information. 

Annotation Digests automatically skip any transcripts that do not include annotations. No
title page or annotation page will printed for these transcripts. This functionality does not
apply to Microsoft Word report options.

Each digest report can be printed or saved as a PDF file using TextMap’s built-in PDF writer
(does not require a full Acrobat license). Or you have the option to print the reports directly to
Microsoft® Word. See Printing to Microsoft Word.

To view a complete listing of all possible TextMap report and ReportBooks examples, click
the link on the ReportBook wizard's Welcome page. Scan the report listing by topic and
then click the link for the report example you want to view.

If you are using both TextMap and CaseMap for your case and you want to make
annotations first, review the results from TextMap in a hard copy of the PDF and then send
selected annotations to CaseMap later.

To print an Annotation Digest Report with All Annotations

1. On the Reports ribbon, on the Current or Multiple Transcripts Report tab, click
Annotation Digest.

You can also click Print on the File menu, and then click Current Transcript.

2. On the Annotation Digest - All Annotations ReportBook Wizard's Welcome page, click
Next.

3. On the Select Transcripts page, review the transcripts and transcripts groups you want
to include in the report.

Click the Modify button to select or remove transcripts/groups from the report, or change
the order that selected transcripts/groups will print in the report.
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In the Select Transcripts dialog box, click Transcripts Groups or Transcripts.

In the Available Groups box, select or clear the check boxes for the transcripts or groups
you want to include or remove.

In the Selected Transcripts box, click the Up/Down  buttons to organize transcripts
in the order you want. Click OK to save your changes, then click OK to save your
changes.

4. On the Select Transcripts page, click Next.

5. On the Options page, select or clear the ReportBook options you want to include.

See Modifying ReportBook title pages.

6. Click Next.

7. On the Limit Annotations by Issue page, choose one of the following:

Yes, include all annotations.

No, only include annotations linked to the selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

8. Click Next.

9. On the Annotation Sections page, select or clear the check boxes for the annotation
sections you want to include.
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Click the Change Order button to modify the order that sections print in the report.

In the Change Order dialog box, click the Move Up and Move Down button to organize
the sections in the order you want them to print, then click OK. The Annotation page and
line number section cannot be re-organized and will always print as the first section.

10. On the Annotation Sections page, click Next.

11. On the Include Redactions page, choose one of the following:

Yes, to burn in redacted text to the printed report.

No, to not include burned redactions into the printed report.

See Changing page setup options for details on applying the redaction color and
reasons.

12. Click Next.

13. On the Linked CaseMap Facts page, choose one of the following:

Yes, include linked facts.

No, do not include linked facts.

To include facts from CaseMap, you must first have the corresponding case open in
CaseMap.

By default TextMap includes three of CaseMap's Facts spreadsheet fields in reports:
Date & Time, Fact Text, and Status. To customize CaseMap fields included in TextMap
reports, see the Changing page setup options topic, Steps 8-10.
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14. Click Next.

15. On the Completing the Annotation Digest - All Annotations ReportBook Wizard page,
click Finish to generate the report.

16. In the Print dialog box, under Destination, click the print output you want.

The print options will change depending on your selection. See Selecting print output
options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

17. Select additional print options, then click OK.

To print the Annotation Digest Report with Search Notes

1. On the Quick Access toolbar, click Print to PDF (File)  icon, and then click
Annotation Digests.

2. On the Annotations Digests submenu, click Search Notes.

3. On the Annotation Digest - Search Notes ReportBook Wizard's Welcome page, click
Next.

4. On the Select Transcripts page, review the transcripts and transcripts groups you want
to include in the report.

Click the Modify button to select or remove transcripts/groups from the report, or change
the order that selected transcripts/groups will print in the report.
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In the Selected Transcripts dialog box, click Transcripts Groups or Transcripts.

In the Available Groups box, select or clear the check boxes for the transcripts or groups
you want to include or remove.

In the Selected Transcripts box, click the Up/Down  buttons to organize transcripts
in the order you want. Click OK to save your changes, then click OK to save your
changes.

1. On the Select Transcripts page, click Next.

5. On the Options page, select or clear the ReportBook options you want to include.

See Modifying ReportBook title pages.

6. Click Next.

7. On the Search Annotation Notes page, type in your search query in the Search For
field.
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8. Select the type of search you want:

AND - All search terms must appear in the note.

OR - At least one of the search terms must appear in the note.

9. Click Next.

10. On the Annotation Sections page, select or clear the check boxes for the annotation
sections you want to include.
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Click the Change Order button to modify the order that sections print in the report. 

In the Change Order dialog box, click the Move Up and Move Down button to organize
the sections in the order you want them to print, then click OK. The Annotation page and
line number section cannot be re-organized and will always print as the first section.

11. On the Limit Annotations by Issue page, choose one of the following:

Yes, include all annotations.

No, only include annotations linked to the selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

12. Click Next.

13. On the Include Redactions page, choose one of the following:

Yes, to burn in redacted text to the printed report.

No, to not include burned redactions into the printed report.

See Changing page setup options for details on applying the redaction color and
reasons.

14. On the Linked CaseMap Facts page, choose one of the following:

Yes, include linked facts.

No, do not include linked facts.

To include facts from CaseMap, you must first have the corresponding case open in
CaseMap.
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15. Click Next.

16. On the Completing the Annotation Digest - Search Notes ReportBook Wizard page,
click Finish to generate the report.

17. In the Print dialog box, under Destination, click the print output you want.

The print options will change depending on your selection. See Selecting print output
options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

18. Select additional print options, then click OK.

To print the Annotation Digest Report with What's New

1. On the Quick Access toolbar, click Print to PDF (File)  icon, and then click
Annotation Digests.

2. On the Annotation Digests submenu, click What's New.

3. On the Annotation Digest - What's New ReportBook Wizard's Welcome page, click
Next.

4. On the Select Transcripts page, review the transcripts and transcripts groups you want
to include in the report.

Click the Modify button to select or remove transcripts/groups from the report, or change
the order that selected transcripts/groups will print in the report.
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In the Selected Transcripts dialog box, click Transcripts Groups or Transcripts.

In the Available Groups box, select or clear the check boxes for the transcripts or groups
you want to include or remove.

In the Selected Transcripts box, click the Up/Down  buttons to organize transcripts
in the order you want. Click OK to save your changes, then click OK to save your
changes.

5. On the Select Transcripts page, click Next.

6. On the Options page, select or clear the ReportBook options you want to include.

See Modifying ReportBook title pages.

7. Click Next.

8. On the What's New Since page, type on the calendar arrow for the Date field to select
the date you want.
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9. Select whether to include updated annotations:

Yes, include updated annotations.

No, do not include updated annotations.

10. Click Next.

9. On the Annotation Sections page, select or clear the check boxes for the annotation
sections you want to include.



Using TextMap 323

© 2017 LexisNexis. All rights reserved.

 

Click the Change Order button to modify the order that sections print in the report. 

In the Change Order dialog box, click the Move Up and Move Down button to organize
the sections in the order you want them to print, then click OK. The Annotation page and
line number section cannot be re-organized and will always print as the first section.

12. On the Limit Annotations by Issue page, choose one of the following:

Yes, include all annotations.

No, only include annotations linked to the selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

13. Click Next.

14. On the Include Redactions page, choose one of the following:

Yes, to burn in redacted text to the printed report.

No, to not include burned redactions into the printed report.

See Changing page setup options for details on applying the redaction color and
reasons.

15. On the Linked CaseMap Facts page, choose one of the following:

Yes, include linked facts.

No, do not include linked facts.

To include facts from CaseMap, you must first have the corresponding case open in
CaseMap.
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16. Click Next.

17. On the Completing the Annotation Digest - What's New ReportBook Wizard page,
click Finish to generate the report.

18. In the Print dialog box, under Destination, click the print output you want.

The print options will change depending on your selection. See Selecting print output
options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

19. Select additional print options, then click OK.

Related Topics

About reports

Selecting report options

Printing to Microsoft Word

Modifying ReportBook title pages

Multiple transcript reports and Annotation Digests include a title page, confidentiality
statement, table of  contents, introduction, and transcript title page. Each of these can be
modified according to your organization's needs on the ReportBook Wizard's Option page.
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To modify the title page

1. On the Reports ribbon, click Multiple Transcripts.

You can also click Print on the File menu, and then click Multiple Transcripts.

2. On the Multiple Transcripts submenu, click Full-size, Condensed, or Note-taking to
open the wizard.

3. Click Next to continue.

4. n the Select Transcripts dialog box, click Next to continue.

5. On the Options page, ensure Title Page is selected.

6. Click the Edit Title Page button.

7. In the Edit Title Page dialog box, under Settings:
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Select the Enabled check box to use TextMap's default title page layouts.

In the Vertical Alignment list, click on the alignment option you want: Top, Top Third,
Middle, Bottom Third, Bottom.

In the Border Style list, click the point size for the border width.

In the Border Color list, click the color scale you want to use.

Select check boxes to include Print Date and Time and Include Graphics.

8. Click the Edit Graphics button to preview current graphics, and modify the header and
footer graphic settings. You can also remove, load, and save graphics for title pages.

Changes to graphics affect all users and reports in the case.

9. Click the Preview button to review changes you make before saving and printing the
report, then click Close.

10. Click the Options button if you want to load TextMap's default settings.

11. Click OK to save the settings.

To modify the confidentiality statement

1. On the Options page, click Confidentiality Statement.

2. Click the Edit Confidentiality Statement button.

3. In the Edit Confidentiality Statement dialog box, under Settings:

Select the Enabled check box to use TextMap's default page layout.

In the Vertical Alignment list, click on the alignment option you want: Top, Top Third,
Middle, Bottom Third, Bottom.

In the Border Style list, click the point size for the border width.

In the Border Color list, click the color scale you want to use.

Select check boxes to include Print Date and Time and Include Graphics.
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Settings made here only affect the confidentiality statement and not changes made to
the same settings when you click the Title Page or Introduction buttons.

4. Click the Edit Content button to modify text as well as font size and style, symbols, and
fields using the toolbar buttons, then click OK.

5. Click the Edit Graphics button to preview current graphics, and modify the header and
footer graphic settings. You can also remove, load, and save graphics for title pages.

Changes to graphics affect all users and reports in the case.

6. Click the Preview button to review your changes, then click Close.

7. Click the Options button if you want to load TextMap's default settings.

8. Click OK to save the changes.

To modify the table of contents

1. On the Options page, click Table of Contents.

2. Click the Edit Table of Contents button.

3. In the Edit Table of Contents dialog box, under Settings:

Select the Enabled check box to use TextMap's default settings.

In the Border Style list, click the point size for the border width.

In the Border Color list, click the color scale you want to use.

Select check boxes to include Print Date and Time.

The Vertical Alignment and Include Graphics options are disabled for editing.

4. Click the Edit Content button to modify text as well as font size and style, symbols, and
fields using the toolbar buttons, then click OK.

1. Click the Preview button to review your changes, then click Close.

2. Click the Options button if you want to load TextMap's default settings.

3. Click OK to save the changes.

To modify the introduction

1. On the Options page, click Introduction.

2. Click the Edit Introduction button.

3. In the Edit Introduction dialog box, under Settings:

Select the Enabled check box to use TextMap's default page layout.

In the Vertical Alignment list, click on the alignment option you want: Top, Top Third,
Middle, Bottom Third, Bottom.
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In the Border Style list, click the point size for the border width.

In the Border Color list, click the color scale you want to use.

Select check boxes to include Print Date and Time and Include Graphics.

4. Click the Edit Content button to modify text as well as font size and style, symbols, and
fields using the toolbar buttons, then click OK.

6. Click the Edit Graphics button to preview current graphics, and modify the header and
footer graphic settings. You can also remove, load, and save graphics for title pages.

Changes to graphics affect all users and reports in the case.

7. Click the Preview button to review your changes, then click Close.

8. Click the Options button if you want to load TextMap's default settings.

9. Click OK to save the changes.

To modify the transcript title page

1. On the Options page, click Transcript Title Page.

2. Click the Edit Transcript Title Page button.

3. In the Edit Transcript Title Page dialog box, under Settings:

Select the Enabled check box to use TextMap's default page layout.

In the Vertical Alignment list, click on the alignment option you want: Top, Top Third,
Middle, Bottom Third, Bottom.

In the Border Style list, click the point size for the border width.

In the Border Color list, click the color scale you want to use.

Select check boxes to include Print Date and Time and Include Graphics.

4. Click the Edit Content button to modify text as well as font size and style, symbols, and
fields using the toolbar buttons, then click OK.

6. Click the Edit Graphics button to preview current graphics, and modify the header and
footer graphic settings. You can also remove, load, and save graphics for title pages.

Changes to graphics affect all users and reports in the case.

7. Click the Preview button to review your changes, then click Close.

8. Click the Options button if you want to load TextMap's default settings.

9. Click OK to save the changes.

Related Topics

About reports
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Adding/editing title pages

Printing multiple transcripts

Printing Annotation Digests

Printing to Microsoft Word

The Print to Microsoft Word feature prints any Annotation Digest report directly into a Word
document.

To print Annotation Digests - All Annotations to Word

1. In the Transcripts pane, click on the transcript you want to print to Word.

2. On the Reports menu:

For Current Transcript: Click Annotation Digest, and then click Print to Microsoft Word.

For Multiple Transcripts: Click Annotation Digest, and then click Print to Microsoft Word.

3. On the Microsoft Word ReportBook Wizard's Welcome page, click Next.

4. On the Select Report Type page, verify that All Annotations is selected, then click Next.
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5. On the Select Transcripts page, review the transcripts you want to include in the report.

Click Modify to change the order of the transcripts in the Select Transcripts dialog box or
add more transcripts to the report.

On the Select Transcripts page, click Next.

7. On the Limit Annotations by Issue page, choose one of the following:

Yes, include all annotations.

No, only include annotations linked to the selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

8. Click Next.

9. On the Group Annotations by Issue page, select whether to group annotations by issue
or to sort by page and line number, then click Next.

The Group Annotations by Issue is the default option and will group annotations on the
report by their linked issues. This may result in an annotation being on the report
multiple times. If you do not want to group annotations by issue select No, only sort by
page and line number.

10. On the Annotations Sections page, select or clear the sections you want in the report.

1. On the Include Redactions page, choose one of the following:
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Yes

No

See Changing page setup options for details on applying the redaction color and
reasons.

12. On the Linked CaseMap Facts page, choose one of the following:

Yes, include linked facts.

No, do not include linked facts.

To include facts from CaseMap, you must first have the corresponding case open in
CaseMap.

13. Click Next.

14. On the Completing the Microsoft Word ReportBook Wizard page, click Finish to
generate the report.

15. Preview the report in Word.

16. On the File menu, click Save As to name and save the report.

To print Annotation Digests - Search Notes to Word

1. In the Transcripts pane, click on the transcript you want to print to Word.

2. On the Reports menu:

For Current Transcript: Click Annotation Digest, and then click Print to Microsoft Word.

For Multiple Transcripts: Click Annotation Digest, and then click Print to Microsoft Word.

3. On the Microsoft Word ReportBook Wizard's Welcome page, click Next.

4. On the Select Report Type page, verify that Search Notes is selected, then click Next.
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5. On the Select Transcripts page, review the transcripts you want to include in the report.

Click Modify to change the order of the transcripts in the Select Transcripts dialog box or
add more transcripts to the report.

6. On the Search Annotation Notes page, type in your search criteria in the Search For
box.
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7. Under How do you want to handle multiple items?, select the search operator you
want to use:

AND - All search terms must appear in the note.

OR - At least one of the search terms must appear in the note.

8. Click Next.

9. On the Group Annotations by Issue page, select whether to group annotations by issue
or to sort by page and line number, then click Next.

The Group Annotations by Issue is the default option and will group annotations on the
report by their linked issues. This may result in an annotation being on the report
multiple times. If you do not want to group annotations by issue select No, only sort by
page and line number.

10. On the Annotations Sections page, select or clear the sections you want in the report,
then click Next.

13. On the Include Redactions page, choose one of the following:

Yes

No

See Changing page setup options for details on applying the redaction color and
reasons.

14. On the Limit Annotations by Issue page, choose one of the following:
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Yes, include all annotations.

No, only include annotations linked to the selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

15. Click Next.

16. On the Linked CaseMap Facts page, choose one of the following:

Yes, include linked facts.

No, do not include linked facts.

To include facts from CaseMap, you must first have the corresponding case open in
CaseMap.

17. Click Next.

18. On the Completing the Microsoft Word ReportBook Wizard page, click Finish to
generate the report.

19. Preview the report in Word.

20. On the File menu, click Save As to name and save the report.

To print Annotation Digests - What's New to Word

1. In the Transcripts pane, click on the transcript you want to print to Word.

2. On the Reports menu:

For Current Transcript: Click Annotation Digest, and then click Print to Microsoft Word.

For Multiple Transcripts: Click Annotation Digest, and then click Print to Microsoft Word.

3. On the Microsoft Word ReportBook Wizard's Welcome page, click Next.

4. On the Select Report Type page, verify that What's New is selected, then click Next.

5. On the Select Transcripts page, review the transcripts you want to include in the report.

Click Modify to change the order of the transcripts in the Select Transcripts dialog box or
add more transcripts to the report.

6. On the What's New Since page, type in a date for the report in the Date field.
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7. Under Do you also want to include annotations updated since the date above?, select
one of the following:

Yes, include updated annotations.

No, do not include updated annotations.

8. Click Next.

9. On the Group Annotations by Issue page, select whether to group annotations by issue
or to sort by page and line number, then click Next.

The Group Annotations by Issue is the default option and will group annotations on the
report by their linked issues. This may result in an annotation being on the report
multiple times. If you do not want to group annotations by issue select No, only sort by
page and line number.

1. On the Annotations Sections page, select or clear the sections you want in the report,
then click Next.

11. On the Include Redactions page, choose one of the following:

Yes

No

See Changing page setup options for details on applying the redaction color and
reasons.

12. On the Limit Annotations by Issue page, choose one of the following:
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Yes, include all annotations.

No, only include annotations linked to the selected issues.

In the Select issues to include box, select the check box next to each issue you want
to include.

13. Click Next.

14. On the Linked CaseMap Facts page, choose one of the following:

Yes, include linked facts.

No, do not include linked facts.

To include facts from CaseMap, you must first have the corresponding case open in
CaseMap.

15. Click Next.

16. On the Completing the Microsoft Word ReportBook Wizard page, click Finish to
generate the report.

17. Preview the report in Word.

18. On the File menu, click Save As to name and save the report.

Related Topics

About reports

Selecting print output options

Printing Annotation Digests

Printing a Search report

Search reports can be created after a full-text search is run. The Search report is organized by
transcript and contains search results from transcripts and/or linked exhibits that include search
terms in your query. The search query run before generating the report prints at the top left of
each report page in addition to the transcript name and date, and page/line number.

Search terms are highlighted in gray so you can easily locate them. You can adjust the number
of lines that print before and after each transcript text or exhibit hit included in the report.
Additionally, you can choose whether to include Q & A pairs in the report.

Search reports print in ReportBook format, which include a title page, statement of
confidentiality, and table of contents. You can customize the report's title page settings.
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To print a search report

1. In the Search pane, on the Full Text Search tab, run a search if you have not already
done so.
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See Running full-text searches.

2. On the Reports ribbon, click Search Report.

You can also click the Search Report on the Search ribbon.

3. On the Search Report Wizard's Welcome page, click Next.

4. On the Optional Features page, select or clear the ReportBook options you want to
include, or highlight an option in the list and click the edit button to make applicable
changes.

See Modifying ReportBook title pages.

5. On the Search Hit Context page, accept the default number of lines around the
transcript and exhibit text hits, or use the up/down arrows to adjust the number of lines.

The default number of lines around transcript text hits is 5.

The default number of words around exhibits hits is 10.

6. Under Always include entire Q & A pairs?, select Yes or No.

7. Click Next to continue.

8. On the Completing the Search Report Wizard page, click Finish.

9. In the Print dialog box, select your print options, then click OK.

The print options will change depending on your selection. See Selecting print output
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options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

Related Topics

About searching

Running full-text searches

About reports

Modifying ReportBook title pages

Printing the Transcript Listing

Any time you need a listing that shows all the transcripts within your case, you can use the
Transcripts Listing report. This report helps you to track your transcripts. The Transcripts Listing
includes the case name, the date that the report was produced, and the names of each
transcript currently in the TextMap case. You can print directly to a printer or to a PDF file.

Some organizations choose to add the date to the file name and run the report every
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week so that they have a historical accounting of the Transcripts Listing.

To print a Transcript Listing

1. On the Reports ribbon, click Transcripts Listing. 

2. In the Print dialog box, select your print options.

3. In the Destination area, select Printer, Preview, or PDF.

The print options will change depending on your selection. See Selecting print output
options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

4. In the Printer area, review and adjust your printer options, which depend on you print
destination.

5. In the Page Range area, select  the pages you want to print.

6. In the Copies area, type in the number of copies you want and whether to collate.

7. Click OK to print the report.

Related Topics

About reports 

Changing page setup options

Printing the case index

The transcript word index is a listing of all words in a transcript. Single transcript and multiple
transcript reports both offer case index reports. The Case Index report includes a cover sheet
for the transcript(s). You have the option to include a title page, statement of confidentiality,
and introduction. You also have the option to have TextMap exclude the redacted words in the
transcript when printing the case index reports. 

The font size and column settings can be customized in the Page Setup dialog box. See 
Changing page setup options.
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If you print the transcript with a case index to a PDF file, each word's page and line
reference in the index is a hyperlink to the page in the transcript where the word appears.
TextMap also creates bookmarks in the PDF for the contents of the report or ReportBook
and for the entire case index.

To print an index for a single transcript

1. In the Transcripts pane, click on the transcript for which you want to print an index.

2. On the Reports ribbon, under Current Transcript Report, click Word Index.

3. Click Yes or No to exclude or include redacted text in the current transcript.

4. In the Print dialog box, select your print options, then click OK.

The print options will change depending on your selection. See Selecting print output
options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

To print a word index ReportBook

1. On the Reports ribbon, in the Multiple Transcripts Report area, click Word Index.

2. On the Word Index ReportBook Wizard's Welcome page, click Next.

3. On the Select Transcripts page, review the transcripts you want to include in the report.

Click Modify to change the order of the transcripts in the Select Transcripts dialog box or
add more transcripts to the report.

4. On the Select Transcripts page, click Next.

5. On the Options page, select or clear the ReportBook options you want to include.
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See Modifying ReportBook title pages.

7. On the Options page, click Next.

11. On the Include Redactions page, choose one of the following:

Yes, to exclude redacted words.

No, to include redacted words.

8. On the Completing the Word Index ReportBook Wizard page, click Finish to generate
the report.

9. In the Print dialog box, under Destination, click the print output you want.

The print options will change depending on your selection. See Selecting print output
options.

We recommend you select Preview first to verify your report before printing a hard copy
or saving the report as a PDF file. You can select your print options from the Print
Preview toolbar.

8. Select additional print options, then click OK.

Related Topics
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About reports

Selecting print output options

Understanding layout options

Printing single transcripts

Printing multiple transcripts

Printing Annotation Digests

Exporting Data

About exporting

TextMap allows you to extract case data to save in a variety of file formats, export directly to
another application like AccessData® Summation®, or into a companion product like TextMap
App for iPad®, CaseMap®, or Sanction®. In order to view the exported data, you must have a
license of the native application installed on your computer.

Export data to the following programs and formats:

TextMap portable case format

TextMap portable transcript format

TextMap App for Apple® iPad®

LexisNexis CaseMap and Sanction

Amicus® Attorney

AccessData® Summation®

Text file (including comma or tab delimited)

Review file format options

Reference the following table to understand the file format options that you can export
TextMap data into.

Export File Format Options

File Format Description

TextMap Portable Transcript Format (*.ptf) is a file format for a single
transcripts.

Portable Case Format (*.pcf) is a file format for a single transcript or
multiple transcripts. 

TextMap Portable Transcript Format (*.xmptf) a file format for a single
transcript or multiple transcripts.
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Export File Format Options

File Format Description

TextMap export files contain the transcript text and all annotations.
TextMap also creates a *.vid file with associated video
synchronization information to go along with these files. See 
Exporting videos.

TextMap App for
iPad

*.xmme is a file format for transcripts and annotations that can be
imported into the TextMap App for iPad.

CaseMap Using the Send to CaseMap tool, transcript text can be imported into
a CaseMap case as a new fact record in the Facts spreadsheet.

Sanction *mdb is a file format for a single transcript that can be imported into
LexisNexis Sanction®.

Amicus,
Summation and
Page Image
Format

Text files are formatted for single transcript that contains all text.

Amicus *txt is a format that can be imported into Amicus® Attorney.

Summation *.txt is a format that can be imported into Summation®.

Related Topics

Exporting transcripts

Exporting annotations

Exporting data to an iPad

Exporting videos

Sending facts to CaseMap

Exporting a Sanction clip list

Exporting transcripts

TextMap offers several options for exporting transcripts, depending on how needs. If you want
to export one or more case transcripts at a time, you need to export using the portable case
format (*.pcf) option. When you export transcripts to a portable case format, you can choose
whether to export all transcripts in the case or select individual transcripts.

You can also export a transcript to several other file formats. When choosing from these
formats, you can only export one transcript at a time.
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Transcripts can also be exported to the following other file formats:

Portable Transcript Format (.ptf)

Amicus Format (.txt)

Page Image Format (.txt)

Summation Format (.txt)

Sanction Format (.mdb)

TextMap Portable Transcript Format (.xmptf)

For information on all export options, see About exporting.

To export a transcript to a select file format

1. In the Transcripts pane, select the transcript you want to export.

2. Click More Export on the Home ribbon, and then click Export Transcript.

You can also click on the File menu and the click Export and Export Transcripts.

3. In the Select Name, Location, and Type for Exported Transcript dialog box, select the
folder where you want to save the file.

4. In the Save as type field, select the file format you want, then click Save.

5. In the message box to confirm the export, click OK.

The exported transcript is now saved to the selected folder location.

You can import this transcript into another case, if needed.

To export transcripts to a portable case format

1. On the File menu, click Export and then click Export to Portable Case Format.

2. In the Select Name, Location, and Type for Exported Transcript dialog box, select the
folder where you want to save the file, then click Save.

3. In the Export Case dialog box, select transcripts in the Selected box that you do not
want to include in the export and click the Item > button to move them into the
Available box.
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Press the CTRL key and hold it while selecting individual, multiple transcripts.

Press SHIFT and hold the keys while selecting a consecutive set of transcripts.

4. Click OK to continue.

5. In the message box to confirm the export process, click OK.

The exported case with selected transcripts is now saved to the selected folder location.

This file can be imported into a TextMap case, if needed.

Related Topics

About exporting

Exporting annotations

Exporting data to an iPad

Exporting annotations

Using the Export Annotations Wizard, you can export annotations from one or more transcripts
to a .csv file that can be viewed in Microsoft® Excel. Using the wizard, you can:

Select the transcripts from which you want to export annotations

Limit the annotations included by issue

Choose the storage location/output file
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To export annotations to a .CSV file

1. In the Transcripts pane, select a transcript, and then select the annotation you want to
export.

2. Click More Export on the Home ribbon, and then click Export Annotations.

On the File menu, you can also click Export, and then click Export Annotations.

3. In the Export Annotations Wizard, click Next.

4. On the Select Transcripts page, select the transcripts that have annotations you want
to export.

The transcript now displays in the Transcript pane now displays in the export wizard.

The default transcript is the current, active transcript.

4. Optional: To modify the transcript list:

a) Click the Modify button to add more transcripts to the export.

The Select Transcripts dialog box opens.

b) In the Available Transcripts box, select the check box beside the transcript you
want to add.

When an item is selected, it is added to the Selected Transcripts area of the Select
Transcripts dialog box.
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c) Optional: Click the Select All check box to add all transcripts in the Available box.

d) Click OK to close the dialog box.

5. Click Next to display the Limit Annotation by Issue dialog box.

6. On the Limit Annotations by Issue page, select one of the following:

To include all annotations

a. Select  the Yes, include all annotations check box to export all annotations.

b. Click Next.

To include only annotations linked to issues

a. Select the No, only include annotations linked to the selected issues check box
to include only the  annotations that are linked to the issues that are selected
here.

b. In the Select issues to include area, select the check box(es) for all annotations
to be included in the export.

c. Click Next.

7. In the Optional Annotations Fields dialog box, select the field(s) to be included with the
exported annotations:
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Notes -- Include a field to list the note(s) associated with each annotation.

Issues -- Include a field to list the issue(s) associated with each annotation.

Video Duration --  Include a field to list the length of the video clip.

8. Click Next to continue.

The Output File dialog box opens.

9. Click the Browse button to choose a file name and storage location.

10. In the Export Annotations dialog box, navigate to the folder where you want to save
the .CSV file.

This folder defaults to the export folder selected in the File Locations tab in the Tools >
Options dialog box.

12. In the File Name field, type in a name for the .CSV file, and then click Save.

13. On the Output File page, click Next to
initiate the export.

The Completing the Export Annotations Wizard displays the number of annotations
exported.

14. Optional: Click the hyperlink to view the output file.

The exported annotations can be viewed in Microsoft Excel. Transcripts display in
alphabetical order.
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15. Optional: To calculate video clip duration, perform the following:

Calculating the total video duration is very beneficial when it comes to determining if you
are within the allotted time when making presentations.

a. In the Completing the Export Annotations Wizard dialog box,  click the Click here to
open the output file hyperlink.

      The output file opens in Microsoft® Excel®.

b. In the Excel spreadsheet, place the cursor below the last entry in the Video
Duration column and click the Auto Sum button.

      The total duration time is displayed.

c. Save and close the Excel spreadsheet.

16. Click the Finish button to close the wizard.

Related Topics

About exporting

Exporting transcripts

Exporting data to an iPad

Exporting data to an iPad

The Export to iPad Wizard allows you to export case issues, one or more selected transcripts,
annotations, and linked exhibits to the iPad. You have the option to email case data to an iPad
or save it to a file so you can send it later. Refer to the iPad Export Considerations table for
details about exporting transcripts, case issues, linked files, and exhibits.

To view data export considerations

Reference the following table for considerations when exporting case data to your iPad.

iPad Export Considerations

General You can export the same transcripts to your iPad more than once.
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iPad Export Considerations

Case Issues The entire case issues outline is sent to the iPad during the
export.

Annotation Linked
Files

Files linked to annotations are not exported to the iPad.

Exhibits TextMap will not export exhibits that it cannot make a copy of,
including links to a document management database.

Only exhibits linked to selected transcripts are included in the
export.

To export case data to an iPad

1. Open the case that contains the case data you want to export.

2. On the Home Ribbon, click the Export to iPad button.

On the File menu, you can also click Export, and then click Export to iPad .

3. On the Export to iPad wizard's Welcome page, click Next.

4. On the Select Transcripts page, select the transcript(s) you want to include in the
export.
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The Include exhibits check box is selected by default to export all exhibits linked to these
transcripts. If you want to exclude all exhibits from the export, clear the check box.

5. Click the Modify button to add additional transcripts to the export.

6. In the Select Transcripts dialog box, in the Available box, select the transcripts or files
you want to include and then click the < Item button.
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To include all files, click the << All button.

To include all of the transcripts from a group, select the transcript group and then click
the << Group button.

The transcripts now display in the Selected box.

7. Click OK to close the dialog box.

8. On the Select Transcripts page, click Next.

9. On the Ready to Send page, select whether to email the file now or to save it to a folder
to send later.

Yes, I want to email the exported file to the iPad now

A Microsoft Outlook email displays on-screen with the exported file automatically
attached.

You can now type in one or more email addresses to send the case to the
appropriate staff members.
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Notice that the email includes pre-written content identifying that the attachment is
for the TextMap iPad app. The message includes directions for how to import the file
using the Mail app on your iPad. You must have the TextMap iPad app installed in
order to import the case.

No, I want to save the exported file to a folder to send later

1. Once this option is selected, click the Browse button.

2. In the Select the name and location dialog box, navigate to the network folder
where you want to store the exported file.
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3. In the File name box, type in a name for the file.

The default export file name is the case file name. You can modify the name as
needed.

4. Click Save to continue.

5. On the Ready to Send page, click Next.

The export file is now saved until you are ready to send it to the iPad.

10. On the Completing the Export to iPad Wizard page, click Finish.

Related Topics

About exporting

About the TextMap iPad app

Importing data from an iPad
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Exporting videos

Export video files just as you would export a transcript or other file from your TextMap case.

To learn about files you can export

Reference the following table for a list of the standard formats for exporting transcripts with
synchronized video that are supported by TextMap.

Import Video Files Types

File Types File
Extensio
ns

Description

LiveNote *.pcf and
*.ptf

Portable Transcript Format (*.ptf) is a file format for a single
transcript that can be imported into LiveNote® Stream.

Portable Case Format (*.pcf) is a file format for a single 
transcript or multiple transcripts that can be imported into
LiveNote®.

Both *.ptf and *.pcf files contain the text and all
annotations. TextMap creates a *.vid file with associated
video synchronization information to go along with the *.ptf
and *.pcf files.

Sanction *.mdb *mdb is a file format for a single transcript that can be
imported into Sanction®. 

Amicus,
Summation,
and Page
Image Format

text or
*txt

Text files are formatted for single transcript that contains all
text.

Amicus *txt is a format that can be imported into Amicus®
Attorney.

Summation *.txt is a format that can be imported into
Summation®.

To export a video

1. In the Transcripts pane, right-click the video transcript you want to export and then
click Export Transcript.

You can also click More Export on the Home Ribbon, and then click Export to Portable
Case Format.

2. In the Select Name, Location, and Type for Exported Transcript dialog box, navigate to
the folder where you want to save the export file.

3. In the File name field, type or edit the name of the export file.

4. In the Save as type list, click the file type you want for the export (e.g., Portable Case
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Format (*pcf)).

5. Click Save.

6. In the Export Case dialog box, if groups have been created, then select an applicable
location/group, and then click OK.

7. In the message box, click OK to acknowledge the location of the saved file.

Related Topics

About videos

Importing video files

Exporting video clips

Sending facts to CaseMap

We encourage you to use CaseMap from the first day you begin working on a new matter.
When you use CaseMap in conjunction with TextMap, you can enter new facts well in advance
of having court-appropriate sources for these fact records. And you can always update the
existing fact records while working in TextMap. Later, when you find a source for a given fact as
you review a transcript, you can update the pre-existing fact.

TextMap is designed so you can optionally perform all basic data entry about a fact in the midst
of sending a transcript passage to CaseMap. These options are available in the dialog boxes
that display when you send a new fact to CaseMap or update an existing one. For each
transcript passage sent to CaseMap, TextMap automatically creates a source that references
the transcript and the page and line numbers of the selection. You must have the related
CaseMap case already open in order to send transcript annotations from TextMap to CaseMap.

You can tell which annotations have already been sent to CaseMap by checking the
Annotations pane at the top of the page. The Linked Fact column has a Yes/No status indicator
for each annotation. Annotations with a Yes have been sent to CaseMap. The CaseMap fact
automatically links back to the selected passage in the transcript. If the fact has already been
sent a message displays asking if you want to re-send the annotation (it replaces the link to
the existing fact).

If you intend to send multiple annotations to CaseMap, consider switching to the Auto Send to
CaseMap annotation mode. Click the arrow next to the Annotate in TextMap button or click the
Annotations menu, and then click Auto Send to CaseMap. Each time you annotate transcript
text the Send to CaseMap dialog box automatically launches, skipping the New Annotation
dialog box.
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If your organization uses CaseMap, follow those established guidelines for creating short
names in CaseMap. If you do not understand the concept of short names, please refer to
the CaseMap Answer Center.

Once you have sent annotations to CaseMap, you can use options on the Annotations
menu to instantly jump to a selected annotation's associated fact in CaseMap or display a
Fact Detail window with information about the associated fact. Right-clicking an annotation
in the Annotations pane opens a shortcut menu with the same CaseMap-related options.

Some organizations install program files on servers, along with the case files. If your
organization installs CaseMap and TextMap on a server, these programs must be installed
on the same server in order for the links to hold. Additionally, if you move a TextMap case
file that contains links to a CaseMap case, you could break the link to the CaseMap record.
See Moving cases and Managing/changing file locations topic to plan the case file move
beforehand.

To send annotations to CaseMap

1. In CaseMap, open the corresponding case.

2. In TextMap, select the transcript text you want to send as a new fact to CaseMap.

3. Select/highlight the annotations to be sent to CaseMap, and on the Text & Video ribbon,
click the Options tab.

4. On the Options tab, click Send to CaseMap.

You can also right-click on the selected text and click Send To, and then click CaseMap -
New Fact.

The Send to CaseMap - New Fact dialog box displays.

5. In the Step 1. Link this Proceeding to CaseMap dialog box, review the information that
is automatically filled in for you, and then click OK.
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Notice that the transcript content displays in the Text Selection box. Do not delete these
brackets as they help link it to the source file. Fact Text is also selected in the Append
Text Selection to list and the deposition is listed in the Source(s) field. Any annotation
notes display in the Fact Text field.

If you have already sent an annotation from this transcript to CaseMap, the Step 1. Link
this Proceeding to CaseMap dialog box does not display.

You can also send note text to CaseMap after an annotation is already sent. Notes are
added to the Fact Text field as mentioned above. If you add more than one note to an
annotation, the annotation and its new note are added to the Facts spreadsheet as a
new fact record.

5. Click the Advanced link if you also want to add the transcript as an object in CaseMap's
All Objects and Proceedings spreadsheets.
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Click the Save & Edit button to open the Edit Proceeding dialog box and enter additional
information about the new object record, such as the type and status of the document,
and any attendees present.

6. In the Step 2 Edit the CaseMap Fact dialog box, review the information that is
automatically filled in for you.
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Notice that the transcript content displays in the Text Selection box. Do not delete these
brackets as they help link it to the source file.

Also notice that the Append Text Select to box automatically lists the Fact Text field. You
can select other columns on the spreadsheet to receive the text or click "Do Not Append"
if you're entering a summary of the fact and simply want to refer back to the actual text
when necessary.

Annotation notes display in the Fact Text box and will display in the Fact Text field in the
Facts spreadsheet directly under the annotated text in brackets. You can turn this option
off from the Tools menu by clicking Options and then clicking the Annotation tab. Next
clear the Use Annotation Note for new Fact Text check box.

The deposition is listed in the Source(s) field.

7. Enter additional information about the new fact record, such as the date and time,
whether the information is a key fact, and its current status.

8. Click the Issue Linker bar to link to case issues in the CaseMap case.
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9. Click OK to continue.

10. In the message box, click Yes to view the new fact record in CaseMap.

11. In CaseMap, locate the new, highlighted fact record in the Facts spreadsheet.

12. In the Facts spreadsheet, click the Paperclip icon for the new fact record to view the
linked path to the transcript in TextMap.

13. Click the file path to review the TextMap transcript.

In TextMap, the transcript opens to the page/line number of the annotation.

14. In the Annotations pane, notice that the Linked Fact column now contains Yes,
indicating that the excerpt is a linked fact in CaseMap.

To remove an annotation's fact link

You can remove annotation links to fact records in CaseMap. Annotations in the transcript
will remain. Deleting the links in TextMap does not delete the fact records in the CaseMap
case.

1. Select the annotation(s) in the transcript or in the Annotations pane.

2. Click Options on the Text & Video Tools Options ribbon, and then click Advanced.

3. On the submenu, click Remove Fact Link.

4. In the message to remove the CaseMap link, click Yes.
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Related Topics

About annotations

Creating annotations

Updating existing facts in CaseMap

Exporting a Sanction clip list

The Export Sanction Clip List Wizard allows you to export a transcript's annotations by select
issues to a Sanction clip list. TextMap skips any annotations that are not linked to a selected
issue. Once the text file is exported, you can then import the clip list into Sanction. Annotations
display in the text file in page/line order.

To export a Sanction clip list

1. In the Transcript pane, select the transcript for which you want to export annotations.

2. Click More Export on the Home Ribbon, and then click Export Sanction Clip List.

On the File menu, you can click Export, and the Export Sanction Clip List to open the
wizard.

3. In the Export Sanction Clip List Wizard, click Next.

4. On the Limit Annotations by Issue page, you can choose to only export annotations to
the linked issues you select.
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5. Click Next to continue.

6. On the Output File page, click the Browse button.

7. In the Export Sanction Clip List dialog box, navigate to the folder where you want to
save the file.

The default file type is a text file.

This folder defaults to the export folder selected in the File Locations tab in the Tools >
Options dialog box.

8. In the File Name field, type in a name for the text file, then click Save.

9. On the Output File page, click Next to initiate the export.

10. Click the hyperlink to view the output file.

The clip list now displays in a text file.

11. Click the Finish button to close the wizard.

You can now import the text file into Sanction.

Related Topics

About exporting
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Exporting annotations

Exporting videos

Sending transcripts to Sanction

To assist in organizing presentations of key evidence for trial, you can connect to a case in Sanction®

3.5 and send information from TextMap to Sanction. Please refer to the Sanction Answer Center for
additional information.

To send a transcript to Sanction

1. Open a case in Sanction 3.5 or later.

It is necessary to have a case open in Sanction for the Send Transcript to Sanction
option to be successful.

2. In the Transcript pane, select/highlight the transcript you want to send to Sanction.

3. On the Transcript menu, click the Send To Sanction button. 

You can also right-click on a transcript in the list, click Send To, and then click Send to
Sanction. 

The Send Transcript to Sanction dialog box opens.

http://help.lexisnexis.com/litigation/ac/sanction/index.html?welcome.htm
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To select multiple transcripts

a. In the Send Transcript to Sanction dialog box, click Select transcripts.

b. In the Select Transcripts dialog box, click Transcripts Groups to list transcripts by
groups, or click Individual Transcripts to list transcripts individually.

For this example, Individual Transcripts has been selected.

c. In the Available Transcripts column, place a check mark beside transcript(s) to be
sent to Sanction.

Optional: Place a check mark in the Select all check box to simultaneously select all
transcripts.
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d. Click OK to display the Send Transcript to Sanction dialog box.

To include media clips when sending transcripts to Sanction, see Sending annotations as
Sanction media clips. 

4. In the Send Transcript to Sanction dialog box, click OK.

Related Topics

About transcripts

About annotations

Sending annotations as Sanction media clips

Editing videos

Sending annotations as Sanction media clips

TextMap® allows you to send a single annotation, or bulk send all annotations that contains

video to the LexisNexis® Sanction® application as media clips.

To send an annotation to Sanction as a media clip

1. Open a case in Sanction® 3.5 or later.

2. In the Transcripts pane, select a transcript from the list that has both annotations and
video.
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The video icon  indicates a transcript with video.

3. Click on the annotation to be sent to Sanction.

4. On the Create & Edit tab of the Text & Video Tools ribbon, click More, and then click
Send Media Clip to Sanction.

You can also right-click on the annotation to be sent, select Send To, and then click
Sanction - New Media Clip. 

 If adjustments have been made to the start and stop times of a video, those adjustments will be
retained when the media clip(s) are sent to Sanction. See Editing videos for additional
information.

To bulk send annotations as Sanction media clips

1. Open a case in Sanction® 3.5 or later.

2. In the Transcripts pane, select a transcript from the list that has both annotations and
video.

The video icon  indicates a transcript with video.

3. Select the annotations to be sent to Sanction to display the Text & Video Tools ribbon.
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4. On the Options tab, click Send Multiple Media Clips.

You can also right-click on the annotations to be sent, click Send To, and then click
Sanction - Multiple Media Clips. 

5.  In the Send Multiple Media Clips to Sanction dialog box, perform all applicable steps:

To select multiple transcripts

a. In the Select Transcripts dialog box, click Transcripts Groups to list transcripts by
groups, or click Individual Transcripts to list transcripts individually.

For this example, Individual Transcripts is selected.

b. In the Available Transcripts column, place a check mark beside the transcript(s)
to be sent to Sanction.

Optional: Place a check mark in the Select all check box to simultaneously select all
transcripts.

c. Click OK to display the Send Multiple Media Clips to Sanction dialog box.
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To send media clips by issue

a. In the Send Multiple Media Clips to Sanction dialog box, click Select issues to
open the Select Issues dialog box.

b. In the Select Issues dialog box, select (place a check mark) beside the issue(s)
associated with media clip(s) to be sent to Sanction.

c. Click OK to display the information being sent to Sanction.
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The issues selected here are recalled the next time the Send Multiple Media Clips
to Sanction dialog box is opened, unless otherwise changed.

d. Optional: Click Include all annotations to deselect the issues selected in the step
above and to return to sending all annotations to Sanction.

e. Click OK to continue.

Related Topics

About transcripts

About annotations

Sending transcripts to Sanction

Editing videos

Keyboard Shortcuts

Using keyboard shortcuts

TextMap offers numerous keyboard shortcuts for the application, transcripts, annotations,
dialog boxes, and lists, and for searching and editing transcripts. You can also create your own
keyboard shortcut and edit existing shortcuts.

You can print a hard copy of the keyboard shortcuts for reference by printing the TextMap Quick
Reference Card.

Available Keyboard Shortcuts:

http://help.lexisnexis.com/litigation/ac/xm_docs/xm7.0/TextMap_Quick_Reference_Card.pdf
http://help.lexisnexis.com/litigation/ac/xm_docs/xm7.0/TextMap_Quick_Reference_Card.pdf
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General

The following list includes the default keyboard shortcuts you can use in TextMap for the
software application.

Keyboard Shortcuts: General

Shortcut Keys Use

F1 Opens online help.

F2 Opens Transcript Properties dialog box.

Alt + F1 View or hide the Navigation pane when transcript is open.

Ctrl + 2 Opens the Exhibits and Video pane in the Navigation pane.

Ctrl + 3 Opens Annotation Detail in the Navigation pane.

Ctrl + 6 Opens and closes the Annotations pane.

Shift + F10 Displays the shortcut (right-click) menu that includes the Send
Transcript to CaseMap, Hyperlink, Send To, and Annotation Mode
functions.

Ctrl + N Creates a new case. Closes your current case.

Ctrl + O Opens a message box to register a CaseMap Server.

Dialog Box

The following list includes the default keyboard shortcuts you can use in TextMap for dialog
boxes.

Keyboard Shortcuts: Dialog Boxes

Shortcut Keys Use

Spacebar Toggles the state of check boxes or option boxes.

Esc Cancels out of dialog boxes.

End Moves cursor to the last item in a list.

Tab Moves cursor left to right and top to bottom.
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Keyboard Shortcuts: Dialog Boxes

Shortcut Keys Use

Shift + Tab Moves cursor right to left and bottom to top.

Ctrl + Left or Right
Arrow

Moves cursor one word at time left or right.

Ctrl + Shift + Left 

or Right Arrow

Selects one word at a time to the left or right of cursor.

Delete Deletes the characters or contents of a text box.

List

The following list includes the default keyboard shortcuts you can use in TextMap for lists. 

Keyboard Shortcuts: Lists

Shortcut Keys Use

Home Moves cursor to the first item in a list.

End Moves cursor to the last item in a list.

Tab Moves cursor to the left or right of an item in a list.

Annotations and Redactions

The following list includes the default keyboard shortcuts you can use in TextMap for
annotations and redactions.

Keyboard Shortcuts: Annotations and Redactions

Shortcut Keys Use

Ctrl + F7 Displays first annotation in the Annotations pane.

F7 Displays previous annotation in the Annotations pane.
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Keyboard Shortcuts: Annotations and Redactions

Shortcut Keys Use

Ctrl + F8 Displays last annotation in the Annotations pane.

F8 Displays next annotation in the Annotations pane.

Alt + H Toggles the state of check boxes or option boxes for the
Highlighting section in the Annotations pane. 

Ctrl + R Opens the New Redaction dialog box. 

Transcript

The following list includes the default keyboard shortcuts you can use in TextMap for
transcripts. You can also customize keyboard shortcuts.

Keyboard Shortcuts: Transcripts

Shortcut Keys Use

Home Moves cursor to the beginning of a line.

End Moves cursor to the end of a line.

Ctrl + Home Moves cursor to the beginning of the transcript.

Ctrl + End Moves cursor to the end of the transcript.

Insert Open the New Annotation dialog box when text is selected.

Ctrl + F Opens the Find dialog box.

Ctrl + G Opens the Go To dialog box.

Ctrl + I Sends information to CaseMap when text is selected.

Ctrl + K Opens new hyperlink wizard when text is selected.

Shift + F10 Displays the right-click menu when text is selected.

Left or Right Arrow Moves cursor to left or right.

Up or Down Arrow Moves cursor up or down.
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Keyboard Shortcuts: Transcripts

Shortcut Keys Use

Ctrl + Shift + Left or
Right Arrow

Selects letters to left or right of cursor.

Ctrl + Shift + Up 

or Down Arrow

Selects lines to the left or right of the cursor to the beginning or
the end of the line.

Ctrl + Left or Right
Arrow

Moves cursor one word at time left or right.

Transcripts pane

The following list includes the default keyboard shortcuts you can use in TextMap for
navigating transcripts in the Transcripts pane. You can also customize keyboard shortcuts.

Keyboard Shortcuts: Transcripts pane

Shortcut Keys Use

Left Arrow Collapses a selected transcript group when the group name is
selected.

Right Arrow Expands a selected transcript group when the group name is
selected.

Up or Down Arrow +
Enter

Navigates transcripts within the Transcript pane. Press Enter to
display the selected transcript in the Transcripts window.

Search

The following list includes the default keyboard shortcuts you can use in TextMap for
searching. You can also customize keyboard shortcuts.

Keyboard Shortcuts: Search

Shortcut Keys Use

Ctrl + 2 Cancels out of message boxes.
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Keyboard Shortcuts: Search

Shortcut Keys Use

Ctrl + S Moves cursor to the last item in a list.

Search Results

The following list includes the default keyboard shortcuts you can use in TextMap for search
results. You can also customize keyboard shortcuts.

Keyboard Shortcuts: Search Results

Shortcut Keys Use

Ctrl + F4 Moves cursor to first result.

F4 Moves cursor to previous search result.

Ctrl + F5 Moves cursor to last result.

F5 Moves cursor to next search result.

Editing

The following list includes the default keyboard shortcuts you can use in TextMap for editing.
You can also customize keyboard shortcuts.

Keyboard Shortcuts: Editing

Shortcut Keys Use

Ctrl + A Selects all the text in a transcript.

Ctrl + C Copies selected text in a transcript to the clipboard.

Ctrl + Alt + C Copies selected text in a transcript, including page line to the
clipboard.

Ctrl + V Pastes text from the clipboard.
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Related Topics

Creating or editing keyboard shortcuts

Creating or editing keyboard shortcuts

TextMap offers numerous keyboard shortcuts to address most all of your needs. You can add or
edit a shortcut key, if the need arises.

To customize ribbons

1. In TextMap, right-click on the Quick Access toolbar or on any ribbon to display the set of
menu options.

2. Click Customize the Ribbon.

3. In the Ribbon Customization dialog box, in the Choose commands from box, select an
applicable option from the list.
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4. Under the Customize the Ribbon heading, place a check mark next to the tab(s) to be
displayed.

5. Use the applicable up  or down  arrow to place appropriately.

6. Optional: To add a new tab

a. Under the Customize the Ribbon heading, select the tab/area where the new tab is to

be added.

b. Click the Add button and then click Add New Tab.

A new tab is added.

c. Click the Rename button.

d. In the Display name box, enter a new name for the tab.

e. Click OK.

The new name is displayed.

f. Click OK to close the Ribbon Customization dialog box.
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7. Optional: To reset customized ribbon settings

a. Click the Reset button in the bottom left-hand corner and select:

Reset on selected tab to reset only settings for the selected tab.

Reset all customizations to reset all customized settings back to the default system
settings.

b. Click OK.

8. Click OK to close the Ribbon Customization dialog box.

An updated toolbar displays.

To create or edit keyboard shortcuts

1. Right-click on the Quick Access toolbar or any ribbon, and on the menu list, select
Customize Keyboard Shortcuts.

You can also right-click on any ribbon.

2. In the Categories list of the Customize Keyboard dialog box, select the menu for which
you want to assign a command.

4. In the Commands list, select the command (or action) you want to use.
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If there is already a keyboard shortcut for this category or command, it will display in the
Current keys box with a description below indicating its current use.

5. In the Press new shortcut key box, type in the shortcut key you want to use (ex: Ctrl +
D).

6. Click the Assign button to save the custom shortcut key.

7. Click Close twice to return to TextMap.

To unassign an existing keyboard shortcut

1. Right-click on the Quick Access Toolbar, and then select Customize Keyboard
Shortcuts.

2. In the Categories list of the Customize Keyboard dialog box, select the menu for which
you want to unassign a command.

3. In the Commands list of the Customize Keyboard dialog box, locate the associated
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command for the keyboard shortcut.

4. In the Current keys box, highlight the keyboard combination and click the Remove
button.

5. Click Close to return to TextMap.

If you click the Reset All button, all key commands return to their original default
settings.

Related Topics

Using keyboard shortcuts
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